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Welcome to VisualCAD!

VisualCAD 2025
Prefer Printed Documentation? Click Here!

What's New  |  Quick Start Play List

VisualCAD is a CAD platform that can be used to design a part file. A detailed description of the
product features, User Interface, File Translators, CAD Features, Selection and Transformation
tools is described in the sections below.

On-line help compiled on: Saturday, February 15, 2025

Related Topics

The VisualCAD Screen Layout

VisualCAD Features Overview

Default Shortcut Keys

Customize VisualCAD Display

1.1 Features Overview

Here is an overview of the features you will find in VisualCAD:

General Features

· Ribbon-based menu interface

· Multiple viewport layouts.

· Create, Split, Save, Load and Delete Viewports

· Large display icons for context sensitive toolbars

· Rearrange and dock multiple toolbars inside each other

· (lockable Toolbars - Command Bar, Layer Manager, Property Page, Plug-in
browsers - MOPS Browser, Machining Objects Browser)

· Auto Hide control for all lockable toolbars

· Print Preview and File > Print  

https://www.mecsoft.com/ResourceGuides/2024/VisualCADCAM/VisualCADCAM2024-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2025.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QKmM1LY2ydDA_vro-WPOo4E
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· File > Open ... (Browse for VisualCAD part files)

· Translators include:

VisualCAD Part Files (*.vcp)
VisualMILL Part Files (*.vmp)
VisualTurn Part Files (*.vct)
3D Studio Files (*.3ds)
Adobe Illustrator Files (*.ai)
AMF Files (*.amf)
AutoCAD (*.dxf;*.dwg)
IGES Files (*.igs;*.iges)
LightWave Files (*.lwo)
MecSoft Region Files (*.mrg)
OBJ Files (*.obj)
Parasolid Files (*.x_t;*.x_b)
Point Cloud Files (*.cvs;*.txt;*.asc)
RAW Triangle Files (*.raw)
RHINO 3DM Files (*.3dm)
SAT Files (*.sat)
SketchUP Files (*.skp)
SLC Files (*.slc)
STEP Files (*.stp;*.step)
Stereo-lithography files (*.sla;*.stl)
Universal 3D Files (*.u3d)
VRML Files (*.wrl)

· Save and load C-planes

· Construction Plane (C-Plane) tools - C-Plane to a 3D Face, C-Plane by X-axis, WCS
and more.

· Supports 3D mouse devices from 3Dconnexion

· Auto file save with an option to set the time interval for auto save

· Recovery of file in the event of application crash

· Dynamic view rotates with animation

· Save Viewport layout in the part file

· Assign hot keys for CAD tools on ribbon bar

· Crash Recovery support

Selection Tools

· Selections made easy. Users can select by dragging a window across the
geometry in any of the viewports

· Select by Layer, Color, Type and Name  
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· Invert Selection  

· Select Last Created and Previous  

· Select by geometry types (Points, Lines/Polylines, Arcs/Circles, Polycurves,
Dimensions, Surfaces)

· Rectangular Select

· Selection Mask – To select only certain types of geometries from the viewport

· Selection command to select duplicate objects

Transformation Tools

· Dynamic Move, Rotate  

· Array Geometry - Rectangular and Polar  

· Scaling part geometry on units change

· Graphical transformation of objects using Graphical Manipulator  

· Allow graphical scaling of geometry.

· Scaling using fit to rectangle

CAD Tools

· Coordinate input for geometry creation in World and Construction planes

· Create Points, Lines, Arcs, Curves and curve editing tools

· Point cloud objects

· Create NURBS curves

· Create Text and Text on a Curve  

· Curve creation visual aids

· Curve editing tools

· Surface creation tools.

· Surface Edit Tools (Trim, Project curves to surface, Wrap, Reverse Normal, Unify
Normals, Explode)

· Mesh creation Tools (box, sphere, cylinder, cone, tubes, extrude, revolve)

· Mesh Boolean Tools (Unite, Subtract and Intersect)

· Solid creation tools (box, sphere, cylinder cone, torus, extrude, revolve,
rectangular/circular tube)

· Solid editing tools (Unify Normals, Explode, Stitch)
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· Curve extraction tools – Flat area regions, Create Surface Boundary and section
curves.

· Dimensioning tools (Horizontal, Vertical, Oblique, Radius, Diameter, Angular,
Leader and Annotation text)

· Delete holes/cap holes

· Tool to detect open loops in curve

· Multiple line text input in create Text dialog

· Spell check in text edit box

· Project to C-plane

· Auto Fillet

· Creation of boundary curve when a topologically connected set of surfaces are
selected

· Extend Curve using a distance

· Arc fits on a poly-line

· Corner rounding of a poly-line

· Create silhouette curve around a part or selected geometries parallel to the c-
plane

· Lock layers in layer manager

· Copy one layer to another including all geometry

· Reorder layers

· Hide and un hide objects using Ctrl H and Ctrl Alt H  

· Lock and unlock objects using Ctrl L and Ctrl Alt L  

Related Topics

Welcome to VisualCAD

The VisualCAD Screen Layout

Default Shortcut Keys

Customize VisualCAD Display

1.2 Screen Layout

The VisualCAD screen layout is shown below.  For high resolution displays (4K) the icons are
automatically scaled to match the screen resolution.
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VisualCAD Screen Layout

Related Topics

Welcome to VisualCAD

VisualCAD Features Overview

Default Shortcut Keys

Customize VisualCAD Display

1.3 Quick Access Toolbar

The Quick Access Toolbar is located at the top of the VisualCAD display.  It contains commands
that you use on a regular basis.  You can add and remove commands to the toolbar to suite your
drawing needs.

The Quick Access Toolbar

Quick Access Toolbar's Default Commands
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 File New / Ctrl+N

 File Open / Ctrl+O

 File Save / Ctrl+S

 Print... / Ctrl+P

Print Preview

Print Setup

 Cut / Ctrl+X

 Copy / Ctrl+C

 Paste / Ctrl+V

 Undo / Ctrl+Z

Undo Multiple

 Redo / Ctrl+Y

Redo Multiple

 Command Recall

 Toggle Continuous Command Recall

 Customize the Quick Access Toolbar

Related Topics

Customize Quick Access Toolbar

VisualCAD Features Overview

Default Shortcut Keys

Preset <Alt> Accelerator Keys

Customize VisualCAD Display

1.4 Default Shortcut Keys

VisualCAD installs with the following keyboard shortcuts preset. You can customize your keyboard
to quickly execute many other VisualCAD commands using the Customize Quick Access
Toolbar and Customize Keyboard dialogs.

Default Keyboard Shortcuts
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 Point / Ctrl+Alt+P

 New / Ctrl+N

 Open / Ctrl+O

 Save / Ctrl+S

 Print... / Ctrl+P

 Undo / Ctrl+Z

 Redo / Ctrl+Y

 Cut / Ctrl+X

 Copy / Ctrl+C

 Paste / Ctrl+V

 Lock / Ctrl+L

 Unlock / Ctrl+Alt+L

 Hide

Hide Non-Selected / Ctrl+Shift+H

 Show / Ctrl+Alt+H

 Select All / Ctrl+A

 Select None / Ctrl+D

Chain Select / Shift + 

Related Topics

Customize Quick Access Toolbar

Customize Keyboard

Customize the Display

Preset <Alt> Accelerator Keys
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The VisualCAD Screen Layout

1.5 Options

The Home Ribbon Bar contains the Options pane.  Selecting the icon will display
the Options dialog shown below.  This dialog allows you to set global parameters

which include System, Display, Color, Grid, Lighting, Dimension, Tolerance and Units
preferences. This dialog can also be accessed from the Status Toolbar.

Dialog Box: Options
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Dialog Box: Options

Related Topics

System

Display

Color

Grid

Lighting

Dimension

Tolerance and Units
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Home Ribbon Bar

1.5.1 System

Allows user to set preferences for modeling aids, mouse settings, auto save and
command recall.

Dialog Box: Options > System

Dialog Box: Options > System

Lock Selected Object(s) Drag

If the box is not checked, you can select a geometry object and drag it around the C-
Plane.  When the box is checked, the objects cannot be dragged.
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Mouse Settings

The following Mouse options are supported:

Reverse Mouse Wheel Direction

Reverses the direction of view zooming when using the mouse wheel.

Right Button Action

When Show pop-up menu is selected, performing a right mouse button click in
the view port displays the commands in the pop-up menu.

RMB menu - geometries are not selected

RMB menu - geometries are selected

When Repeat last action is selected, this recalls the previous command.

Pressing and Holding Right Button Action
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This option tells VisualCAD what to do when the right mouse button is pressed
and held.

· Rotate  
When selected, pressing and holding down the right mouse button from
all views performs a Rotate on the display.

· Depending on Orient View  
When depending on orient view is selected, pressing & holding down
the right mouse button from Top, Front, Right, Left, Back, Bottom views
does a Dynamic Pan of the geometries instead of rotate. For Iso views
(Iso1,2,3 & 4) it performs a Rotate when pressing and holding down right
mouse button down.

AutoSave

The AutoSave function can be used to automatically save your active part file at user-
specified time intervals. AutoSave always saves to the current file name.  This saved file
is removed when you successfully close your model.  

NOTE: Once you activate AutoSave, you will need to
Exit VisualCAD and then launch VisualCAD again before

AutoSave will begin saving your part files!

Under the AutoSave function, check the box next to 'Save every xx minutes' to activate
the AutoSave function.  The time interval can be entered in minutes.

AutoSave saves the file under:
<APPDATA>\MecSoft\VisualCAD 2018\AutoSave where

APPDATA is a logical pointing to a folder set up by your
system administrator.  By default it points to:
C:\Users\<username>\AppData\Roaming\.

Opening an Older Version *.vcp File

Opening an older version vcp file, displays the following dialog allowing you
the opportunity to save the file to the current version.

AutoSave Message

When does AutoSave Prompt me to Save a File?



Welcome to VisualCAD! 23

© 2025 Mecsoft Corporation

Under the following conditions VisualCAD will prompt you to save your file:

1. When you have opened a non-native VisualCAD file.

2. When you have imported a file.

3. When you have created a new part and has not saved the file yet.

When is the AutoSave File Deleted?

Auto save file is deleted under the following scenarios:

1. When the application closes normally.

2. When you close the file either explicitly or by opening another file.

3. When you select not to recover an AutoSave file that was detected on
startup

File Recovery

In the event of a computer crash or if VisualCAD is terminated abruptly by
ending the process from task manager, VisualCAD will recover your file if
AutoSave was active and your part file was automatically saved at least once.

If an AutoSave file has been created prior to the crash or termination,
VisualCAD will detect the file located in the AutoSave folder the next time it is
loaded.  You are then prompted with the following dialog:

AutoSave Message

Selecting Yes, displays the following dialog, prompting you to save your file:

AutoSave Message

This is the only opportunity to recover the part file. If you choose not to
recover it, the AutoSave file will be removed.
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Use Auto Backup

Use this option to back up your VisualCAD files automatically. You can change the Auto
Backup Path destination directory by selecting the 'browse' button.

If you have the check box checked, then the file is saved ONCE (as soon as the file is
loaded) to the Auto Backup path with the same name as the original path file.  This file is
not deleted on exit so it can be recovered later if necessary.  By default the check box to
Auto Backup is unchecked.

Use Auto Command Recall

When this option is selected, VisualCAD automatically repeats the last command without
having to go back & reselect the command from the toolbar or use the right mouse
button click or enter option to repeat the previous command.

Use Preselection Highlight

When this option is selected, VisualCAD automatically highlights selections as the cursor
moves over them.  See Pre-Selection Highlight for more information.

Object Snap Settings

You can control the pixel radius of the object snaps located on the Status Toolbar.  Enter
the Snap Radius desired.

Related Topics

Options

1.5.2 Display

Controls how geometry is displayed.  Select from the following:

Dialog Box: Options > Display
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Dialog Box: Options > Display

General Settings

Turn on Anti-aliasing
A method of smoothing the jagged edges along the lines and curves of text or
graphics. Aliasing is caused by limited display resolution. Selecting this option turns
on Anti-aliasing.

Shading Style
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This controls how smooth surfaces are shaded.

Smooth Shading
Flat Shading

The pictures demonstrate the difference between smooth and flat shading.  The left
picture smoothly changes the amount of shading as the surface curves.  The right
picture just displays the shading for a flat facet on the surface.  Since all surfaces
(including smooth ones) are internally represented as flat facets, flat shading can
affect any surface.  The default is smooth shading.

Mesh Edges Display Style

This changes how smooth surfaces are displayed.  Since all surfaces are internally
represented as flat facets, these facets join up along edges.  On smooth surfaces,
these edges are not sharp and are not normally displayed.  An example of a sharp
edge is the edge of a cube.

The pictures demonstrate the difference between silhouette & cusp edges only and
all edge display.  The left picture displays only sharp edges (there are none on a
sphere); meanwhile, the right picture displays all the edges.  The default is
Silhouette & Cusp Edges Only. When selected, this allows you to select Silhouette
Edges, Cusp Edges or All Edges to display.

Curve Display Style

 This provides an option to turn on or off display of curve start point and direction
arrow.
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Start Point display OFF
Start Point display ON

Curve Direction arrow OFF Curve Direction arrow ON

Selecting Start Point and Curve Direction arrow display under options displays both
start point and curve direction arrow.

Construction Visual Aids Style

This provides an option to choose the display style between Stipple line and Solid
line for visual aids when the Visual Aids is set to active under the status bar.

Stipple line display
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Solid line display

Rendering Options

This can be set to Use Display Lists or Vertex Arrays.  The Vertex Arrays option also
provides the option to Use Video Memory from the video card that is installed on the
computer. The speed and performance varies depending on the operating system
type and video card installed.

View Change Animation

Whenever the view orientation is changed within the active viewport, VisualCAD can
make that orientation change instantly or through smooth animation. If animation is
used, the speed of the animation can be set.

Under the View Change Animation function, check the box next to Speed to activate
the animation.  The animation speed can be controlled using the slider bar.

Ghosted Display Transparency

Whenever the view mode is set to Ghosted Display, you can use this slider to control
the transparency level of the hidden (ghosted) geometry.

Depth Testing

These options allow you to fully display certain objects regardless of the view mode.
 For example, checking the box to Disable Depth Testing for curves, will display all
curves even if the view is set to shaded model.  You can also Disable Depth testing
for grid.  If enabled, the grid lines will always display.

Thickness

Use this parameter to set the display line thickness for all wireframe geometry. Set
this to 1 for the default line thickness. Higher for thicker lines.

Related Topics
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Options

1.5.3 Color

The default colors are set using this dialog.

Dialog Box: Options > Color

Dialog Box: Options > Color

· Screen Background Color  
This allows user to set the viewport background color. This is the color displayed
when no objects are at that position.

· Screen Gradient  
This is a smooth change of lighting.  The direction specified is the lighter side.  It
starts slightly darker on the opposite side of the screen and gradually gets lighter
until it reaches the specified side.

· C-Plane Color  
This changes the color of the construction plane grid.

· C-Plane Grid X Axis Color  
This changes the horizontal axis line of the construction plane.

· C-Plane Grid Y Axis Color  
This changes the vertical axis line of the construction plane.

· Selection Color  
This is the highlight color of objects that have been selected.

· New Layer Color  
This is the default color of objects created on new (not Default) layers.
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· Constr. Visual Aids Color  
This is the default color of construction aids when Visual Aids is set to active in
the status bar.

Related Topics

Options

1.5.4 Grid

This controls how the construction plane grid is displayed.

Dialog Box: Options > Grid

Dialog Box: Options > Grid

Position of Grid Origin

These options will control where the grid is positioned relative to the World
Coordinate System (WCS). 

The grid orientation also carries over to whichever view is active, making
construction easier.
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Center
Move the center of the grid to the WCS.

Move the center of the grid to the WCS.

Lower Left
Move the lower left corner of the grid to the WCS.

Move the lower left corner of the grid to the WCS.

Lower Right
Move the lower right corner of the grid to the WCS.

Move the lower right corner of the grid to the WCS.

Upper Left
Move the upper left corner of the grid to the WCS.
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Move the upper left corner of the grid to the WCS.

Upper Right
Move the upper right corner of the grid to the WCS.

Move the upper right corner of the grid to the WCS.

Pick
Use the button to pick a point on the screen and the origin of the grid will move
to this location.

Notes:

· The point you pick is always on the default XY plane.

· If you use the Upper/Lower options above after using this Pick option,
the offset distance between the WCS and the new origin of the grid
remains in effect.

Move the the origin of the grid to this location.

Other Grid Options
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Grid Extents in X Direction
This controls how many major divisions are displayed along the X axis
direction.  

Grid Extents in Y Direction
This controls how many major divisions are displayed along the Y axis
direction.  

Distance between each Minor Grid Line
This controls the distance between each minor grid line.

Major/Minor Grid Lines

# of Divisions between Each Major Line
This controls the distance between each major grid line. the number of minor
rid line multiplied by the number of major grid lines will determine the overall
extent of the grid.

Major/Minor Grid Lines

Related Topics

Options

1.5.5 Lighting

This controls the characteristics of lighting for the model.  

Dialog Box: Options > Lighting
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Dialog Box: Options > Lighting

There are three types of lighting:  ambient, diffuse, and specular.

Position Light on Top

The scene has a single light source and there are controls for setting its position.  Not
all lighting in the model comes directly from that one source; there is some ambient
light coming in from all over.  The Position Light on Top checkbox must be unchecked
to be able to move the light source.

Ambient

Ambient light comes in from all different directions equally.  Light sources have no
effect on ambient light.  Shadows don’t appear with only ambient light.
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Diffuse

Diffuse light comes from a single source but is scattered in all directions.  Shadows
appear, but there are no “shiny” spots.

Specular

Specular light comes from a single source and is scattered in a single direction.  It is
reflective light.  Shiny metal objects demonstrate good specular reflection.  Shading
is not a significant consideration with specular light.

The three pictures above demonstrate ambient light as the light source moves from
left to right.  There is no effect since ambient light comes from all sides equally.

The pictures above show the effects of the motion of the light source using only
diffuse lighting.  There are no “shiny” spots but yet there is a direction from the light.
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The last set of pictures uses only specular lighting.  As the light source moves from
left to right, the “shiny” spot follows it.  However, there is nothing else lit up, so the
effect is not just reflective metal.

Related Topics

Options

1.5.6 Dimension

This controls the appearance of dimensioning labels, arrows, and leader lines.

Dialog Box: Options > Dimension

Dialog Box: Options > Dimension

Related Topics

Options
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1.5.7 Tolerance and Units

This controls the accuracy of the model and part units.

Dialog Box: Options > Tolerance and Units

Dialog Box: Options > Tolerance and Units

Tolerances

This controls the accuracy of the models.  Smaller tolerance numbers often result in
significantly big files and slower processing time but are more accurate.

The tolerances are set in a dialog.

Part Faceting Tolerance

Chordal Deviation/Chord Height Tolerance  
The chord height tolerance is used in commands that require approximation
of smooth curves and surfaces.

Curve Hookup Tolerance
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This specifies maximum separation between the endpoints of different
curves when joining them into a single curve.

Units

This converts units from inches to millimeters or from millimeters to inches.  If there
are existing objects, a dialog will appear confirming if you really want to convert the
units.

The objects remain the original size but the coordinate values change.

You can check the box to always prompt you to change the units when files are
opened if they appear not to be in the correct units.  For example, if the system sees
a coordinate value that is quite large such as 500.5, then this dialog will display giving
you the opportunity to change the units to Millimeters.

Related Topics

Options

1.6 View Toolbar

The View Toolbar contains easily accessible commands that control the appearance of the
currently active view.  This includes motion of the camera as well as how objects are displayed.
When a view change is invoked from the View Toolbar toolbar, the existing view magnification
factor is maintained. The View Toolbar is displayed in the currently active Viewport.

The View Toolbar

The View Toolbar

The View Toolbar Displayed in the Active Viewport
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View Toolbar Displays in the Active Viewport by Default

The View Toolbar Commands

Icon Command/Menu Command

Zoom Out

-

Zoom In

Zoom Box

Fit View

Dynamic Pan

Dynamic Rotate

Top View

Iso View
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View Menu

Top View

Front View

Back View

Left View

Right View

Bottom View

Isometric-1,2,3,4

Display Menu

Shaded Display

Toggle Shaded+Edges

Wireframe Display

Toggle Hidden Lines

Ghosted Display

Toggle Parallel/Perspective
Projection

Previous View
These are Undo/Redo View

commands.

Next View

Show/Hide Menu

Hide/Show Grid

Hide/Show WCS

Related Topics
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Zoom Out

Zoom In

Zoom Box

Fit View

Dynamic Pan View

Dynamic Rotate View

Top View

Iso View

Front View

Back View

Left View

Right View

Bottom View

Shaded Display

Toggle Shading + Edges

Wireframe Display

Hidden Line Display

Ghosted Display

Toggle Parallel/Perspective Projection

Hide/Show Grid

Hide/Show WCS

1.6.1 3D Mouse

VisualCAD supports 3D devices from 3Dconnexion®. It can be customized in the
3Dconnexion® Properties dialog by selecting the Button Configuration tab. Button
configurations can be set for either the Left mouse button, the Right mouse button,
or both and other buttons depending on the type of 3D device you are using.

Related Topics

View Tool Bar
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1.7 Customize VisualCAD

The VisualCAD display can be easily customized to suit your drawing needs.

Customize VisualCAD®

Related Topics

Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard

Styles Menu

1.7.1 Customize Quick Access Toolbar

You can add/remove commands to the Quick Access Toolbar and perform other User Interface
customization from the Customize Quick Access Toolbar menu.
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Menu: Customize Quick Access Toolbar

Select the indicator  to the right of the Quick Access Toolbar to display the menu:

Displaying the Quick Access Toolbar Manu

Quickly Turn Commands On/Off

Select a command from the menu to "uncheck" it and remove it from the Quick Access
Toolbar.  Selecting it again will add it back to the toolbar.
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Quickly Turn Commands On/Off from the Quick Access Toolbar

More Commands...

You can add more commands to the toolbar by selecting More Commands ... from the
Quick Access Toolbar Menu.  This will display the Customize dialog.  From this dialog you
can also Customize the Keyboard.

Show below the Ribbon

You can move the Quick Access Toolbar to reside below the Ribbon bar by selecting Show
Below Ribbon from the Customize Quick Access Toolbar menu.  You can also do this by
selecting appropriate check box in the Customize dialog.
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Show the Quick Access Toolbat below the Ribbon Bar

Minimize the Ribbon Bar

You can minimize the Ribbon Bar by selecting Minimize the Ribbon from the Customize
Quick Access Toolbar menu.  You can then select one of the tabs to show the Ribbon Bar
as needed.

The Ribbon Bar is shown Minimized

Related Topics

Customize VisualCAD

Customize Quick Access Toolbar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard

Styles Menu
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1.7.2 Minimize Ribbon Bar

You can minimize the Ribbon Bar by selecting Minimize the Ribbon from the Customize Quick
Access Toolbar menu.  You can then select one of the tabs to show the Ribbon Bar as needed.

The Ribbon Bar is shown Minimized

Related Topics

Customize VisualCAD

Customize Quick Access Toolbar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard

Styles Menu

1.7.3 Preset <Alt> Accelerator Keys

VisualCAD installs with Preset <Alt> Key combinations that you can use to quickly execute the
various commands located on each Ribbon Bar.  Refer to topic below for more information.

Using the Preset <Alt> Keys

1. Press the <Alt> key on your keyboard and VisualCAD will display (and activate)
<Alt> key assignments for the VisualCAD Menu, Quick Access Toolbar and each
Ribbon Bar.

2. With the <Alt> key pressed, you can then press one of the assigned keys to
execute the command or display the menu or Ribbon Bar.

3. To display (and activate) the <Alt> keys assigned to commands on one of the
Ribbon Bars, first press the <Alt> key combination for the desired Ribbon Bar and
then with the <Alt> key still pressed, press the key assigned to the desired
command.
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4. For example, to execute the Single Line command, press <Alt+C> to display the
Curve Modeling Ribbon Bar and then press <LS> with the <Alt> key still pressed.

The preset <Alt> key assignments for each menu and command are shown below.

Preset <Alt> Keys: Menus

The following preset <Alt> Accelerator key combinations are assigned to commands on
the VisualCAD Menu, Quick Access Toolbar and Ribbon Bars as shown below.  These can
be displayed in VisualCAD by pressing the <Alt> key.  

For example, pressing <Alt+A> will automatically display the Modeling Aids Ribbon Bar.

Preset <Alt> Keys: Menus

Preset <Alt> Keys: Home Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Home Ribbon Bar.  

Preset <Alt> Keys: Home Ribbon Bar

Preset <Alt> Keys: Display Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Display Ribbon Bar.  

Preset <Alt> Keys: Display Ribbon Bar

Preset <Alt> Keys: Modeling Aids Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Modeling Aids Ribbon Bar.  
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Preset <Alt> Keys: Modeling Aids Ribbon Bar

Preset <Alt> Keys: Curve Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Curve Modeling Ribbon Bar.  

Preset <Alt> Keys: Curve Modeling Ribbon Bar

Preset <Alt> Keys: Surface Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Surface Modeling Ribbon Bar.  

Preset <Alt> Keys: Surface Modeling Ribbon Bar

Preset <Alt> Keys: Solid Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Solid Modeling Ribbon Bar.  

Preset <Alt> Keys: Solid Modeling Ribbon Bar

Preset <Alt> Keys: Mesh Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Mesh Modeling Ribbon Bar.  
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Preset <Alt> Keys: Mesh Modeling Ribbon Bar

Preset <Alt> Keys: Dimensions Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Dimensions Ribbon Bar.  

Preset <Alt> Keys: Dimensions Modeling Ribbon Bar

Preset <Alt> Keys: Analyze Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Analyze Ribbon Bar.  

Preset <Alt> Keys: Analyze Ribbon Bar

Preset <Alt> Keys: Transform Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Transform Ribbon Bar.  

Preset <Alt> Keys: Transform Ribbon Bar

Related Topics

Customize VisualCAD

Customize Quick Access Toolbar

Minimize Ribbon Bar
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Customize Dialog

Customize the Keyboard

Styles Menu

1.7.4 Customize Dialog

The Customize dialog shown below allows you to add new command icons to the Quick Access
Toolbar.  From this dialog you can also Customize the Keyboard to execute VisualCAD commands
quickly.  Refer to the following topics for information.

Dialog Box: Customize

In the dialog shown below, the command icons currently assigned to the Quick Access
Toolbar are listed on the right.  The command icons from the VisualCAD Menu and each
Ribbon bar are shown on the left.

Dialog Box: Customize

Choose commands from:

Select a Ribbon bar from the drop-down list.  The commands on the selected Ribbon
will be listed in the Commands: window.
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Commands:

This window lists all of the commands on the Ribbon bar selected from the Choose
commands from: list.  Select a command from the list and then pick the Add >>
button to add it to the list on the right.

Add >> / Remove

The Add >> button adds a selected command from the Commands: list on the left to
the list on the right.  The Remove button removes a selected command from the list
on the right. 

Selected Commands List

The list on the right shows all of the commands that are currently being displayed on
the Quick Access Toolbar.  The order of the commands in the list determines the
order of the command icons in on the Quick Access Toolbar.

The icon  to the left of a command in the list indicates that this command has a sub
menu that will also be included on the Quick Access Toolbar.
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Submenu Indicator

  Pick the Up or Down buttons to move a selected command higher (to the
left) or lower (to the right) on the Quick Access Toolbar.  

Reset

Select the Reset button to return the list on the right to the Quick Access Toolbar's
default list of commands. 

Show Quick Access Toolbar below Ribbon

Checking this box will force the Quick Access Toolbar to display below the Ribbon
bar.  You can also do this by selecting Show Below the Ribbon from the Customize
Quick Access Toolbar menu.

Show the Quick Access Toolbat below the Ribbon Bar

Keyboard Shortcuts / Customize

Select the Customize... button to display the Customize Keyboard dialog.  From this
dialog you can then reassign shortcut keys to any command on the various Ribbon
bars.

Related Topics

Customize VisualCAD



Welcome to VisualCAD! 53

© 2025 Mecsoft Corporation

Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Styles Menu

1.7.5 Customize the Keyboard

Invoked by the Customize dialog, the Customize Keyboard dialog shown below allows you to
redefine the Default Shortcut Keys assigned to your keyboard.  Keyboard shortcuts are
combinations of keys that can be pressed to execute a VisualCAD command.  Pressing the shortcut
keys does the same thing as moving the cursor to the toolbar / menu item and selecting the
command, thus saving time and promotes the continuous flow of your work.

Keyboard shortcuts are also called hot-keys.

Dialog Box: Customize Keyboard

In the dialog shown below, the C-Plane by 3 Points command located on the Modeling
Aids Ribbon bar is being assigned to the keyboard short keys Ctrl+Shift+3.  The dialog also
informs you that those keyboard shortcut keys have not previously been assigned.  Each
section of the dialog is described in detail below.

Dialog Box: Customize Keyboard

Categories:
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This section lists all of the individual panes on each ribbon bars as well as each
ribbon bar.  Select a category and the commands located on that ribbon bar/pane will
be listed on the right within the Commands list. 

Commands:

This section lists all of the commands located on the Ribbon bar or Pane selected
from the Categories section on the left.  Select a command from the list to assign a
new shortcut keys or to reassign its current shortcut keys.

Current Keys:

If the command selected from the Commands list has a shortcut key assigned to it, it
will be displayed in the Current Keys: windows.  This window is for information
purposes and cannot be edited.

Press new shortcut key:

After selecting a command from the Commands:, place the mouse cursor in this field
to activate it.  Then from the keyboard, press the shortcut keys that you want to
assign to the command.  

If the keyboard shortcut keys are currently assigned to another
command, that command is listed under the Assigned to:

section directly below this field.  * If you pick the Assign button, the
shortcut keys will be reassigned!

Assigned to:

If the keyboard shortcut keys you entered in the Press new shortcut key: fields are
currently assigned to another command, that command is listed under the Assigned
to: section.

Set Accelerator for:

This sets the keyboard accelerator.  Currently only Default is available on the list
which sets the accelerator for VisualCAD.

Description:

After you select a command from the Commands: list a description of the command
is shown under this section.  Refer to the example dialog shown above as a
reference.

Assign / Remove / Reset All

Once you are certain about the selected command and the new shortcut keys, pick
the Assign button to associate them.  VisualCAD will then execute the command
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when those shortcut keys are pressed.

Related Topics

Customize VisualCAD

Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Styles Menu

1.7.6 Styles Menu

You can select different themes to change how the windows appear.  The borders, colors,
highlighting, and shadowing of standard buttons, dialogs, and windows are controlled by which
theme is selected.

The Styles Menu

Office 2007 Blue

Office 2007 (Blue Style)
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Office 2007 (Blue Style)

Office 2007 (Black Style)

Office 2007 (Black Style)
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Office 2007 (Silver Style)

Office 2007 (Silver Style)

Office 2007 (Aqua Style)
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Office 2007 (Aqua Style)

Windows 7

Windows 7
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Related Topics

Customize VisualCAD

Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard
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Quick Start

VisualCAD 2025
Prefer Printed Documentation? Click Here!

What's New  |  Quick Start Play List

Quick Start Guides for each VisualCAD module are available in both PDF and Video format.  Refer
to the following information to access these resources:

Training Guides (Click on Image to Download)

Related Topics

Find More Resources

https://www.mecsoft.com/ResourceGuides/2024/VisualCADCAM/VisualCADCAM2024-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2025.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QKmM1LY2ydDA_vro-WPOo4E
https://mecsoft.sharefile.com/d-s181d8eedfe79489f9aeeaf8dd5701f8f
https://www.mecsoft.com/ResourceGuides/2024/VisualCADCAM/VisualCAD-2024-Companion.pdf
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Resource Guide

Download this PDF Guide for a list of the available VisualCAD Resources.

2025 VisualCAD Resource Guide

The 2025 VisualCAD Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Click Here!

What's New  |  Quick Start Play List

https://www.mecsoft.com/ResourceGuides/2024/VisualCADCAM/VisualCADCAM2024-Resource-Guide.pdf
https://www.mecsoft.com/ResourceGuides/2024/VisualCADCAM/VisualCADCAM2024-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2025.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QKmM1LY2ydDA_vro-WPOo4E
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VisualCAD Menu

The VisualCAD Menu controls for manipulating files, printing, and exiting the program.  The most
recently opened VCP file names are listed for easy access.  If one of those names is selected, that
file will be loaded.  All current work will be overwritten by the loaded file.

Show me the File Menu

File Menu

Related Topics

New

Open ...

Browse ...

Import ...

Save

Save As ...

Export ...

Print ...

Print Preview

Print Setup ...

Options ...

Help & Info

Help Topics

Check for Updates
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Go To Website

About VisualCAD

Exit

4.1 New

Create a new VCP (VisualCAD Part) file.  The file holds the geometry, layers, orientation,
and preferences.  If there are unsaved objects, a dialog will ask you if they want to save
them before creating the new VCP file.  All current work will be overwritten by the new
file.

Related Topics

File

4.2 Open ...

Open an existing VCP (VisualCAD Part) file or one of the supported file types.  The file
holds the geometry, layers, orientation, and preferences.  If there are existing unsaved
objects, a dialog will ask you if you want to save them before opening the VCP file.  All
current work will be overwritten by the loaded file.

Dialog Box: Open

Dialog Box: Open

Standard Windows® File Browser supports preview of VisualCAD *.vcp drawings and
models.
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Files of Type Supported

The following file types are supported by VisualCAD.  See File Open and File Import for
more information

· VisualCAD Part Files (*.vcp)

· VisualMILL Part Files (*.vmp)

· VisualTurn Part Files (*.vct)

· 3D Studio Files (*.3ds)

· Adobe Illustrator Files (*.ai)

· AMF Files (*.amf)

· AutoCAD (*.dxf;*.dwg)

· IGES Files (*.igs;*.iges)

· LightWave Files (*.lwo)

· MecSoft Region Files (*.mrg)

· OBJ Files (*.obj)

· Parasolid Files (*.x_t;*.x_b)

· Point Cloud Files (*.cvs;*.txt;*.asc)

· RAW Triangle Files (*.raw)

· RHINO 3DM Files (*.3dm)

· SAT Files (*.sat)

· SketchUP Files (*.skp)

· SLC Files (*.slc)

· STEP Files (*.stp;*.step)

· Stereo-lithography files (*.sla;*.stl)

· Universal 3D Files (*.u3d)

· VRML Files (*.wrl)

File Types Supported

Related Topics

File

Import ...

Save

Save As ...

Browse...



VisualCAD Menu 65

© 2025 Mecsoft Corporation

4.3 Browse ...

Visually browse files on the computer.  VCP files can be opened.  A preview window
will show the last view displayed when the original file was saved.

Dialog Box: VisualCAD® File Browser

Dialog Box: VisualCAD® File Browser

Related Topics

File Menu

Import ...

Save

Save As ...

4.4 Import ...

Open existing files made by other programs.  This is used to transfer information,
normally geometric models.  Currently, VisualCAD can import the following formats:  

Dialog Box: Import
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Dialog Box: Import

Standard Windows® File Browser supports preview of VisualCAD *.vcp drawings and
models.

Import Multiple Files

You can Import multiple files at the same time. To do so, first press and hold the <Ctrl>
key while selecting the files from the Import dialog. Each file will highlight and also be
listed together in the File name field at the bottom of the dialog. When done selecting
files, pick the Open button.

Dialog Box: Import (When importing multiple files at once)

Standard Windows® File Browser supports preview of VisualCAD *.vcp drawings and
models.

Files of Type Supported
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The following file types are supported by VisualCAD.  See File Open and File Import for
more information

· VisualCAD Part Files (*.vcp)

· VisualMILL Part Files (*.vmp)

· VisualTurn Part Files (*.vct)

· 3D Studio Files (*.3ds)

· Adobe Illustrator Files (*.ai)

· AMF Files (*.amf)

· AutoCAD (*.dxf;*.dwg)

· IGES Files (*.igs;*.iges)

· LightWave Files (*.lwo)

· MecSoft Region Files (*.mrg)

· OBJ Files (*.obj)

· Parasolid Files (*.x_t;*.x_b)

· Point Cloud Files (*.cvs;*.txt;*.asc)

· RAW Triangle Files (*.raw)

· RHINO 3DM Files (*.3dm)

· SAT Files (*.sat)

· SketchUP Files (*.skp)

· SLC Files (*.slc)

· STEP Files (*.stp;*.step)

· Stereo-lithography files (*.sla;*.stl)

· Universal 3D Files (*.u3d)

· VRML Files (*.wrl)

File Types Supported

Related Topics

File

Export

Save

Save As

Browse...
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4.5 Save

Save geometry, layers, orientation, and preferences in a VCP file.  If saving for the first
time, you can name the file and select where on the computer to save the file.  If the file
had been saved previously, the current information overwrites the original information.

Related Topics

File

4.6 Save As ...

Save geometry, layers, orientation, and preferences in a VCP file.  Name the file and
select where on the computer to save it.  If selecting an existing file, the current
information will overwrite the original information.  See Export ... to save as different file
types.

File Save As dialog box

File Save As dialog box

Save as Files Types Supported

· VisualCAD Part Files (*.vcp)

Related Topics

File
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4.7 Save As Template

Use this to save VisualCAD® preferences (System, Display, Color, Grid,
Lighting, Dimension, Tolerance and Units) in the *.vcp file.  This template file

can then be used to begin new VisualCAD drawings.

4.8 Export ...

Save geometry in a neutral file format (can be read by many different programs).  The
following export translators are available.  Binary formats are usually much smaller in

size, but ASCII formats are more easily read.  Ordinary text programs can read the ASCII files.

Dialog Box: Export To

Dialog Box: Export To

Export File Types Supported

The following file types are supported by VisualCAD during Export:

File Types Supported during Export
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· Stereo-Lithography Binary (*.stl)

· Stereo-Lithography ASCII (*.sla)

· Region Files (*.mrg)

· Rhino (*.3dm)

· IGES (*.igs)

· STEP Files (*.stp; *.step)

· SAT Files (*.sat)

· OBJ Files (*.obj)

· AMF Files (*.amf)

· DWG Files (*.dxf; *.dwg)

Exporting to Dwg/Dxf formats

When you select the Dwg/Dxf export File Type, the file is exported to *.dwg format
by default.  If you would like to export the file in *.dxf format, you will need to
enter the file extension to the end of the file name (i.e., Example.dxf).

Exporting to the *.dxf File Type

Related Topics

File

Import ...
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Save

Save As ...

Browse...

4.9 Print Menu

Moving the mouse cursor over the Print ... button from the VisualCAD
Menu will display additional print options.  You can also select (left-
click) on this button to execute the Print command.

VisualCAD Menu > Print ...
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VisualCAD® Menu > Print ...

Related Topics

VisualCAD Menu

Print ...

Print Preview ...

Print Setup ...
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4.9.1 Print

Prints the objects displayed.  If multiple views are displayed, the currently selected view
will be printed.  The standard Windows® Print dialog box is displayed.

The standard Windows® Print dialog

The standard Windows® Print dialog

Related Topics

VisualCAD Menu

Print Menu

Print Setup ...

Print Preview ...

4.9.2 Print Preview ...

This shows a picture of what will be printed.  The picture can be printed from here along
with the additional controls listed below.

Print Preview Display
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File > Print Preview Display

Print Preview Controls

The following controls are available from the Print Preview ribbon bar:

Print Preview Ribbon Bar

· Print 

· Zoom In/Out 

· Two Page 

· Next Page 
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· Prev Page 

· Close 

Related Topics

File

4.9.3 Print Setup ...

From the VisualCAD Menu moving the mouse cursor over the Print ... option will display the Print
Menu with this Print Setup ... option available.  Use this to select the printer used to print.  The
orientation (landscape or portrait), paper size and additional printer properties can be specified. 
The standard Windows® Print Setup dialog box is displayed.

The standard Windows® Print Setup dialog

The standard Windows® Print Setup dialog

Related Topics

VisualCAD Menu

Print Menu

Print ...

Print Preview ...
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4.10 Options

The Home Ribbon Bar contains the Options pane.  Selecting the icon will display
the Options dialog shown below.  This dialog allows you to set global parameters

which include System, Display, Color, Grid, Lighting, Dimension, Tolerance and Units
preferences. This dialog can also be accessed from the Status Toolbar.

Dialog Box: Options

Dialog Box: Options
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Related Topics

System

Display

Color

Grid

Lighting

Dimension

Tolerance and Units

Home Ribbon Bar

4.10.1 System

Allows user to set preferences for modeling aids, mouse settings, auto save and
command recall.

Dialog Box: Options > System
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Dialog Box: Options > System

Lock Selected Object(s) Drag

If the box is not checked, you can select a geometry object and drag it around the C-
Plane.  When the box is checked, the objects cannot be dragged.

Mouse Settings

The following Mouse options are supported:

Reverse Mouse Wheel Direction

Reverses the direction of view zooming when using the mouse wheel.

Right Button Action
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When Show pop-up menu is selected, performing a right mouse button click in
the view port displays the commands in the pop-up menu.

RMB menu - geometries are not selected

RMB menu - geometries are selected

When Repeat last action is selected, this recalls the previous command.

Pressing and Holding Right Button Action

This option tells VisualCAD what to do when the right mouse button is pressed
and held.

· Rotate  
When selected, pressing and holding down the right mouse button from
all views performs a Rotate on the display.
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· Depending on Orient View  
When depending on orient view is selected, pressing & holding down
the right mouse button from Top, Front, Right, Left, Back, Bottom views
does a Dynamic Pan of the geometries instead of rotate. For Iso views
(Iso1,2,3 & 4) it performs a Rotate when pressing and holding down right
mouse button down.

AutoSave

The AutoSave function can be used to automatically save your active part file at user-
specified time intervals. AutoSave always saves to the current file name.  This saved file
is removed when you successfully close your model.  

NOTE: Once you activate AutoSave, you will need to
Exit VisualCAD and then launch VisualCAD again before

AutoSave will begin saving your part files!

Under the AutoSave function, check the box next to 'Save every xx minutes' to activate
the AutoSave function.  The time interval can be entered in minutes.

AutoSave saves the file under:
<APPDATA>\MecSoft\VisualCAD 2018\AutoSave where

APPDATA is a logical pointing to a folder set up by your
system administrator.  By default it points to:
C:\Users\<username>\AppData\Roaming\.

Opening an Older Version *.vcp File

Opening an older version vcp file, displays the following dialog allowing you
the opportunity to save the file to the current version.

AutoSave Message

When does AutoSave Prompt me to Save a File?

Under the following conditions VisualCAD will prompt you to save your file:

1. When you have opened a non-native VisualCAD file.

2. When you have imported a file.
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3. When you have created a new part and has not saved the file yet.

When is the AutoSave File Deleted?

Auto save file is deleted under the following scenarios:

1. When the application closes normally.

2. When you close the file either explicitly or by opening another file.

3. When you select not to recover an AutoSave file that was detected on
startup

File Recovery

In the event of a computer crash or if VisualCAD is terminated abruptly by
ending the process from task manager, VisualCAD will recover your file if
AutoSave was active and your part file was automatically saved at least once.

If an AutoSave file has been created prior to the crash or termination,
VisualCAD will detect the file located in the AutoSave folder the next time it is
loaded.  You are then prompted with the following dialog:

AutoSave Message

Selecting Yes, displays the following dialog, prompting you to save your file:

AutoSave Message

This is the only opportunity to recover the part file. If you choose not to
recover it, the AutoSave file will be removed.

Use Auto Backup

Use this option to back up your VisualCAD files automatically. You can change the Auto
Backup Path destination directory by selecting the 'browse' button.
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If you have the check box checked, then the file is saved ONCE (as soon as the file is
loaded) to the Auto Backup path with the same name as the original path file.  This file is
not deleted on exit so it can be recovered later if necessary.  By default the check box to
Auto Backup is unchecked.

Use Auto Command Recall

When this option is selected, VisualCAD automatically repeats the last command without
having to go back & reselect the command from the toolbar or use the right mouse
button click or enter option to repeat the previous command.

Use Preselection Highlight

When this option is selected, VisualCAD automatically highlights selections as the cursor
moves over them.  See Pre-Selection Highlight for more information.

Object Snap Settings

You can control the pixel radius of the object snaps located on the Status Toolbar.  Enter
the Snap Radius desired.

Related Topics

Options

4.10.2 Display

Controls how geometry is displayed.  Select from the following:

Dialog Box: Options > Display
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Dialog Box: Options > Display

General Settings

Turn on Anti-aliasing
A method of smoothing the jagged edges along the lines and curves of text or
graphics. Aliasing is caused by limited display resolution. Selecting this option turns
on Anti-aliasing.

Shading Style
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This controls how smooth surfaces are shaded.

Smooth Shading
Flat Shading

The pictures demonstrate the difference between smooth and flat shading.  The left
picture smoothly changes the amount of shading as the surface curves.  The right
picture just displays the shading for a flat facet on the surface.  Since all surfaces
(including smooth ones) are internally represented as flat facets, flat shading can
affect any surface.  The default is smooth shading.

Mesh Edges Display Style

This changes how smooth surfaces are displayed.  Since all surfaces are internally
represented as flat facets, these facets join up along edges.  On smooth surfaces,
these edges are not sharp and are not normally displayed.  An example of a sharp
edge is the edge of a cube.

The pictures demonstrate the difference between silhouette & cusp edges only and
all edge display.  The left picture displays only sharp edges (there are none on a
sphere); meanwhile, the right picture displays all the edges.  The default is
Silhouette & Cusp Edges Only. When selected, this allows you to select Silhouette
Edges, Cusp Edges or All Edges to display.

Curve Display Style

 This provides an option to turn on or off display of curve start point and direction
arrow.
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Start Point display OFF
Start Point display ON

Curve Direction arrow OFF Curve Direction arrow ON

Selecting Start Point and Curve Direction arrow display under options displays both
start point and curve direction arrow.

Construction Visual Aids Style

This provides an option to choose the display style between Stipple line and Solid
line for visual aids when the Visual Aids is set to active under the status bar.

Stipple line display
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Solid line display

Rendering Options

This can be set to Use Display Lists or Vertex Arrays.  The Vertex Arrays option also
provides the option to Use Video Memory from the video card that is installed on the
computer. The speed and performance varies depending on the operating system
type and video card installed.

View Change Animation

Whenever the view orientation is changed within the active viewport, VisualCAD can
make that orientation change instantly or through smooth animation. If animation is
used, the speed of the animation can be set.

Under the View Change Animation function, check the box next to Speed to activate
the animation.  The animation speed can be controlled using the slider bar.

Ghosted Display Transparency

Whenever the view mode is set to Ghosted Display, you can use this slider to control
the transparency level of the hidden (ghosted) geometry.

Depth Testing

These options allow you to fully display certain objects regardless of the view mode.
 For example, checking the box to Disable Depth Testing for curves, will display all
curves even if the view is set to shaded model.  You can also Disable Depth testing
for grid.  If enabled, the grid lines will always display.

Thickness

Use this parameter to set the display line thickness for all wireframe geometry. Set
this to 1 for the default line thickness. Higher for thicker lines.

Related Topics
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Options

4.10.3 Color

The default colors are set using this dialog.

Dialog Box: Options > Color

Dialog Box: Options > Color

· Screen Background Color  
This allows user to set the viewport background color. This is the color displayed
when no objects are at that position.

· Screen Gradient  
This is a smooth change of lighting.  The direction specified is the lighter side.  It
starts slightly darker on the opposite side of the screen and gradually gets lighter
until it reaches the specified side.

· C-Plane Color  
This changes the color of the construction plane grid.

· C-Plane Grid X Axis Color  
This changes the horizontal axis line of the construction plane.

· C-Plane Grid Y Axis Color  
This changes the vertical axis line of the construction plane.

· Selection Color  
This is the highlight color of objects that have been selected.

· New Layer Color  
This is the default color of objects created on new (not Default) layers.
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· Constr. Visual Aids Color  
This is the default color of construction aids when Visual Aids is set to active in
the status bar.

Related Topics

Options

4.10.4 Grid

This controls how the construction plane grid is displayed.

Dialog Box: Options > Grid

Dialog Box: Options > Grid

Position of Grid Origin

These options will control where the grid is positioned relative to the World
Coordinate System (WCS). 

The grid orientation also carries over to whichever view is active, making
construction easier.
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Center
Move the center of the grid to the WCS.

Move the center of the grid to the WCS.

Lower Left
Move the lower left corner of the grid to the WCS.

Move the lower left corner of the grid to the WCS.

Lower Right
Move the lower right corner of the grid to the WCS.

Move the lower right corner of the grid to the WCS.

Upper Left
Move the upper left corner of the grid to the WCS.
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Move the upper left corner of the grid to the WCS.

Upper Right
Move the upper right corner of the grid to the WCS.

Move the upper right corner of the grid to the WCS.

Pick
Use the button to pick a point on the screen and the origin of the grid will move
to this location.

Notes:

· The point you pick is always on the default XY plane.

· If you use the Upper/Lower options above after using this Pick option,
the offset distance between the WCS and the new origin of the grid
remains in effect.

Move the the origin of the grid to this location.

Other Grid Options



VisualCAD Menu 91

© 2025 Mecsoft Corporation

Grid Extents in X Direction
This controls how many major divisions are displayed along the X axis
direction.  

Grid Extents in Y Direction
This controls how many major divisions are displayed along the Y axis
direction.  

Distance between each Minor Grid Line
This controls the distance between each minor grid line.

Major/Minor Grid Lines

# of Divisions between Each Major Line
This controls the distance between each major grid line. the number of minor
rid line multiplied by the number of major grid lines will determine the overall
extent of the grid.

Major/Minor Grid Lines

Related Topics

Options

4.10.5 Lighting

This controls the characteristics of lighting for the model.  

Dialog Box: Options > Lighting
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Dialog Box: Options > Lighting

There are three types of lighting:  ambient, diffuse, and specular.

Position Light on Top

The scene has a single light source and there are controls for setting its position.  Not
all lighting in the model comes directly from that one source; there is some ambient
light coming in from all over.  The Position Light on Top checkbox must be unchecked
to be able to move the light source.

Ambient

Ambient light comes in from all different directions equally.  Light sources have no
effect on ambient light.  Shadows don’t appear with only ambient light.
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Diffuse

Diffuse light comes from a single source but is scattered in all directions.  Shadows
appear, but there are no “shiny” spots.

Specular

Specular light comes from a single source and is scattered in a single direction.  It is
reflective light.  Shiny metal objects demonstrate good specular reflection.  Shading
is not a significant consideration with specular light.

The three pictures above demonstrate ambient light as the light source moves from
left to right.  There is no effect since ambient light comes from all sides equally.

The pictures above show the effects of the motion of the light source using only
diffuse lighting.  There are no “shiny” spots but yet there is a direction from the light.
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The last set of pictures uses only specular lighting.  As the light source moves from
left to right, the “shiny” spot follows it.  However, there is nothing else lit up, so the
effect is not just reflective metal.

Related Topics

Options

4.10.6 Dimension

This controls the appearance of dimensioning labels, arrows, and leader lines.

Dialog Box: Options > Dimension

Dialog Box: Options > Dimension

Related Topics

Options
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4.10.7 Tol. & Units

This controls the accuracy of the model and part units.

Dialog Box: Options > Tolerance and Units

Dialog Box: Options > Tolerance and Units

Tolerances

This controls the accuracy of the models.  Smaller tolerance numbers often result in
significantly big files and slower processing time but are more accurate.

The tolerances are set in a dialog.

Part Faceting Tolerance

Chordal Deviation/Chord Height Tolerance  
The chord height tolerance is used in commands that require approximation
of smooth curves and surfaces.

Curve Hookup Tolerance
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This specifies maximum separation between the endpoints of different
curves when joining them into a single curve.

Units

This converts units from inches to millimeters or from millimeters to inches.  If there
are existing objects, a dialog will appear confirming if you really want to convert the
units.

The objects remain the original size but the coordinate values change.

You can check the box to always prompt you to change the units when files are
opened if they appear not to be in the correct units.  For example, if the system sees
a coordinate value that is quite large such as 500.5, then this dialog will display giving
you the opportunity to change the units to Millimeters.

Related Topics

Options

4.11 Help & Info Menu

Select Help & Info from the VisualCAD Menu to access information
about VisualCAD and how to use it.  You can also select (left-click) on
this button to display the VisualCAD Online Help.

The Help & Info Menu
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VisualCAD® Menu > Help & Info

Related Topics

Online Help

Check for Updates

Go To Website

About
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4.11.1 Help Topics ...

VisualCAD is accompanied with a comprehensive online help system.  When a command is
active you can press the <F1> key to display context-sensitive help for that command. 

Many dialogs also have a Help button that you can click to display help for that dialog.  Whenever
you see the Help "?" icon, select it to display the Online Help system. 

VisualCAD Online Help Browser Controls

Related Topics

Help

4.11.2 Check for Updates ...

This checks for product updates. Internet connection is required to perform this task.

Dialog Box: Check for Updates

Dialog Box: Check for Updates

· Turn off automatic check for product updates at startup  
Check this box if do not want VisualCAD to check for updates automatically. 

Related Topics

Help
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4.11.3 Go To Website

Selecting this option displays the MecSoft.com website in your default web browser.  Note
that and Internet connection is required.  From the website you can access free downloads,

videos, tutorials and keep up to date on the latest innovations from MecSoft Corporation.

Go to the MecSoft.com Website

4.11.4 About VisualCAD

This brings up a dialog, which shows the product version number.

http://mecsoft.com/
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Dialog Box: About VisualCAD

Related Topics

Help

Help Topics ...

Check for Updates ...

4.12 Exit

Quits VisualCAD.  If there is unsaved work, you will be asked if you want to save it before
quitting.  If the unsaved work is not saved, it will be lost.

Related Topics

File
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The Ribbon Bar

The Ribbon Bar displays all of the features available in VisualCAD.  It conforms to the standard for
Ribbon Bars set by Microsoft® Corp.

VisualCAD® Ribbon Bar

Tabs along the top of the Ribbon Bar allow selection of major categories of functionality, such as
creation, modification, analysis, dimensioning, etc.  Within each tab are subordinate panes of
related functionality that are labeled along the bottom of the group.  The Home Ribbon bar shown
above has three sub panes of commands labeled File, Plugins and Options.

Ribbon Bars

Home

Display

Modeling Aids

Curve Modeling

Surface Modeling

Solid Modeling

Mesh Modeling

Dimensions

Analyze

Transform

Print Preview

5.1 Home

The Home Ribbon Bar contains File, Plugins, and Options panes and associated functions.

The Home Ribbon Bar

Related Topics
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File Pane, Home Ribbon Bar

Plugins Pane, Home Ribbon Bar

Options Pane, Home Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.1.1 File

The Home Ribbon Bar contains the following File pane with associated functions.

Home Ribbon Bar
File Pane

Related Topics

New

Open ...

Browse ...

Import ...

Save

Save As ...

Save As Template

Export ...

Print Preview ...

Print ...

Home Ribbon Bar

5.1.1.1 New

Create a new VCP (VisualCAD Part) file.  The file holds the geometry, layers, orientation,
and preferences.  If there are unsaved objects, a dialog will ask you if they want to save
them before creating the new VCP file.  All current work will be overwritten by the new
file.
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Related Topics

File

5.1.1.2 Open ...

Open an existing VCP (VisualCAD Part) file or one of the supported file types.  The file
holds the geometry, layers, orientation, and preferences.  If there are existing unsaved
objects, a dialog will ask you if you want to save them before opening the VCP file.  All
current work will be overwritten by the loaded file.

Dialog Box: Open

Dialog Box: Open

Standard Windows® File Browser supports preview of VisualCAD *.vcp drawings and
models.

Files of Type Supported

The following file types are supported by VisualCAD.  See File Open and File Import for
more information
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· VisualCAD Part Files (*.vcp)

· VisualMILL Part Files (*.vmp)

· VisualTurn Part Files (*.vct)

· 3D Studio Files (*.3ds)

· Adobe Illustrator Files (*.ai)

· AMF Files (*.amf)

· AutoCAD (*.dxf;*.dwg)

· IGES Files (*.igs;*.iges)

· LightWave Files (*.lwo)

· MecSoft Region Files (*.mrg)

· OBJ Files (*.obj)

· Parasolid Files (*.x_t;*.x_b)

· Point Cloud Files (*.cvs;*.txt;*.asc)

· RAW Triangle Files (*.raw)

· RHINO 3DM Files (*.3dm)

· SAT Files (*.sat)

· SketchUP Files (*.skp)

· SLC Files (*.slc)

· STEP Files (*.stp;*.step)

· Stereo-lithography files (*.sla;*.stl)

· Universal 3D Files (*.u3d)

· VRML Files (*.wrl)

File Types Supported

Related Topics

File

Import ...

Save

Save As ...

Browse...
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5.1.1.3 Browse ...

Visually browse files on the computer.  VCP files can be opened.  A preview window
will show the last view displayed when the original file was saved.

Dialog Box: VisualCAD® File Browser

Dialog Box: VisualCAD® File Browser

Related Topics

File Menu

Import ...

Save

Save As ...

5.1.1.4 Import ...

Open existing files made by other programs.  This is used to transfer information,
normally geometric models.  Currently, VisualCAD can import the following formats:  

Dialog Box: Import
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Dialog Box: Import

Standard Windows® File Browser supports preview of VisualCAD *.vcp drawings and
models.

Import Multiple Files

You can Import multiple files at the same time. To do so, first press and hold the <Ctrl>
key while selecting the files from the Import dialog. Each file will highlight and also be
listed together in the File name field at the bottom of the dialog. When done selecting
files, pick the Open button.

Dialog Box: Import (When importing multiple files at once)

Standard Windows® File Browser supports preview of VisualCAD *.vcp drawings and
models.

Files of Type Supported



The Ribbon Bar 107

© 2025 Mecsoft Corporation

The following file types are supported by VisualCAD.  See File Open and File Import for
more information

· VisualCAD Part Files (*.vcp)

· VisualMILL Part Files (*.vmp)

· VisualTurn Part Files (*.vct)

· 3D Studio Files (*.3ds)

· Adobe Illustrator Files (*.ai)

· AMF Files (*.amf)

· AutoCAD (*.dxf;*.dwg)

· IGES Files (*.igs;*.iges)

· LightWave Files (*.lwo)

· MecSoft Region Files (*.mrg)

· OBJ Files (*.obj)

· Parasolid Files (*.x_t;*.x_b)

· Point Cloud Files (*.cvs;*.txt;*.asc)

· RAW Triangle Files (*.raw)

· RHINO 3DM Files (*.3dm)

· SAT Files (*.sat)

· SketchUP Files (*.skp)

· SLC Files (*.slc)

· STEP Files (*.stp;*.step)

· Stereo-lithography files (*.sla;*.stl)

· Universal 3D Files (*.u3d)

· VRML Files (*.wrl)

File Types Supported

Related Topics

File

Export

Save

Save As

Browse...
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5.1.1.5 Save

Save geometry, layers, orientation, and preferences in a VCP file.  If saving for the first
time, you can name the file and select where on the computer to save the file.  If the file
had been saved previously, the current information overwrites the original information.

Related Topics

File

5.1.1.6 Save As ...

Save geometry, layers, orientation, and preferences in a VCP file.  Name the file and
select where on the computer to save it.  If selecting an existing file, the current
information will overwrite the original information.  See Export ... to save as different file
types.

File Save As dialog box

File Save As dialog box

Save as Files Types Supported

· VisualCAD Part Files (*.vcp)

Related Topics

File
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5.1.1.7 Save As Template

Use this to save VisualCAD® preferences (System, Display, Color, Grid,
Lighting, Dimension, Tolerance and Units) in the *.vcp file.  This template file

can then be used to begin new VisualCAD drawings.

5.1.1.8 Export ...

Save geometry in a neutral file format (can be read by many different programs).  The
following export translators are available.  Binary formats are usually much smaller in

size, but ASCII formats are more easily read.  Ordinary text programs can read the ASCII files.

Dialog Box: Export To

Dialog Box: Export To

Export File Types Supported

The following file types are supported by VisualCAD during Export:

File Types Supported during Export

· Stereo-Lithography Binary (*.stl)
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· Stereo-Lithography ASCII (*.sla)

· Region Files (*.mrg)

· Rhino (*.3dm)

· IGES (*.igs)

· STEP Files (*.stp; *.step)

· SAT Files (*.sat)

· OBJ Files (*.obj)

· AMF Files (*.amf)

· DWG Files (*.dxf; *.dwg)

Exporting to Dwg/Dxf formats

When you select the Dwg/Dxf export File Type, the file is exported to *.dwg format
by default.  If you would like to export the file in *.dxf format, you will need to
enter the file extension to the end of the file name (i.e., Example.dxf).

Exporting to the *.dxf File Type

Related Topics

File

Import ...

Save
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Save As ...

Browse...

5.1.1.9 Export Selected

This command is similar to the File Export command but only exports the
currently selected entities.  The entities MUST be pre-selected before

executing this command.  All of the file types supported by the File Export command are also
supported by this command.

Basic Procedure

Screen Entry Command Input

Step 1 Select the entities that you wish to export.

Step 2 Pick the Export Selected icon
from the Home Ribbon Bar.

Use the Export To dialog to create the exported file
type required.  See  File Export ... for more
information about using the Export To dialog.

Related Topics

File Export ...

File

Import ...

Save

Save As ...

Browse...

5.1.1.10 Print Preview

This shows a picture of what will be printed.  The picture can be printed from here along
with the additional controls listed below.

Print Preview Display
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File > Print Preview Display

Print Preview Controls

The following controls are available from the Print Preview ribbon bar:

Print Preview Ribbon Bar

· Print 

· Zoom In/Out 

· Two Page 

· Next Page 
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· Prev Page 

· Close 

Related Topics

File

5.1.1.11 Print ...

Prints the objects displayed.  If multiple views are displayed, the currently selected view
will be printed.  The standard Windows® Print dialog box is displayed.

The standard Windows® Print dialog

The standard Windows® Print dialog

Related Topics

VisualCAD Menu

Print Menu

Print Setup ...

Print Preview ...



VisualCAD 2025 Companion114

© 2025 Mecsoft Corporation

5.1.2 Plugins

The Home Ribbon Bar contains the following Plugins pane with associated
functions.

Related Topics

Application Plug-ins ...

Translator Plug-ins ...

Home Ribbon Bar

5.1.2.1 Application Plug-ins ...

This allows additional functionality to be added to VisualCAD after installation.   

Select from the following for more information:

Dialog Box: Application Plug-ins Manager

Dialog Box: Application Plug-ins Manager

Enable/Disable Application Plug-ins

Active application plug-ins are listed at the top of the manager.  The Plug-in Name
and Plug-in Path are listed.

Check the box to the left of the application plug-in to enable or disable the plug-in.
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Install New Application Plug-ins

1. Select the Install button to display the File Browser.

2.  Separate files, normally with an extension *.vca, are stored in the Plug-ins
folder under the installation directory for VisualCAD®.

3. Select a Plug-in file and then pick Open.

4. The plug-in is added to the Application Plug-in Manager along with Author,
Website and  a Description.

Related Topics

Options

Export

Import

Save

Save As

Browse...

5.1.2.2 Translator Plug-ins ...

This allows different file types to be read, imported, and exported.  VisualCAD can read
and write its own file types (*.vcp) with no additional plug-ins.  There are some
translators that come already pre-installed such as things to read Dxf, Dwg, STEP, IGES,
SAT, Parasolids and STL file formats.

Dialog Box: Loaded Translator Plug-ins

Dialog Box: Loaded Translator Plug-ins
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As more translators become available, they can be plugged in and used.

Related Topics

Options

Export ...

Import ...

Save

Save As ...

Browse...

5.1.3 Options

The Home Ribbon Bar contains the Options pane.  Selecting the icon will display
the Options dialog shown below.  This dialog allows you to set global parameters

which include System, Display, Color, Grid, Lighting, Dimension, Tolerance and Units
preferences. This dialog can also be accessed from the Status Toolbar.

Dialog Box: Options
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Dialog Box: Options

Related Topics

System

Display

Color

Grid

Lighting

Dimension

Tolerance and Units
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Home Ribbon Bar

5.1.3.1 System

Allows user to set preferences for modeling aids, mouse settings, auto save and
command recall.

Dialog Box: Options > System

Dialog Box: Options > System

Lock Selected Object(s) Drag

If the box is not checked, you can select a geometry object and drag it around the C-
Plane.  When the box is checked, the objects cannot be dragged.

Mouse Settings
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The following Mouse options are supported:

Reverse Mouse Wheel Direction

Reverses the direction of view zooming when using the mouse wheel.

Right Button Action

When Show pop-up menu is selected, performing a right mouse button click in
the view port displays the commands in the pop-up menu.

RMB menu - geometries are not selected

RMB menu - geometries are selected

When Repeat last action is selected, this recalls the previous command.

Pressing and Holding Right Button Action
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This option tells VisualCAD what to do when the right mouse button is pressed
and held.

· Rotate  
When selected, pressing and holding down the right mouse button from
all views performs a Rotate on the display.

· Depending on Orient View  
When depending on orient view is selected, pressing & holding down
the right mouse button from Top, Front, Right, Left, Back, Bottom views
does a Dynamic Pan of the geometries instead of rotate. For Iso views
(Iso1,2,3 & 4) it performs a Rotate when pressing and holding down right
mouse button down.

AutoSave

The AutoSave function can be used to automatically save your active part file at user-
specified time intervals. AutoSave always saves to the current file name.  This saved file
is removed when you successfully close your model.  

NOTE: Once you activate AutoSave, you will need to
Exit VisualCAD and then launch VisualCAD again before

AutoSave will begin saving your part files!

Under the AutoSave function, check the box next to 'Save every xx minutes' to activate
the AutoSave function.  The time interval can be entered in minutes.

AutoSave saves the file under:
<APPDATA>\MecSoft\VisualCAD 2018\AutoSave where

APPDATA is a logical pointing to a folder set up by your
system administrator.  By default it points to:
C:\Users\<username>\AppData\Roaming\.

Opening an Older Version *.vcp File

Opening an older version vcp file, displays the following dialog allowing you
the opportunity to save the file to the current version.

AutoSave Message

When does AutoSave Prompt me to Save a File?
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Under the following conditions VisualCAD will prompt you to save your file:

1. When you have opened a non-native VisualCAD file.

2. When you have imported a file.

3. When you have created a new part and has not saved the file yet.

When is the AutoSave File Deleted?

Auto save file is deleted under the following scenarios:

1. When the application closes normally.

2. When you close the file either explicitly or by opening another file.

3. When you select not to recover an AutoSave file that was detected on
startup

File Recovery

In the event of a computer crash or if VisualCAD is terminated abruptly by
ending the process from task manager, VisualCAD will recover your file if
AutoSave was active and your part file was automatically saved at least once.

If an AutoSave file has been created prior to the crash or termination,
VisualCAD will detect the file located in the AutoSave folder the next time it is
loaded.  You are then prompted with the following dialog:

AutoSave Message

Selecting Yes, displays the following dialog, prompting you to save your file:

AutoSave Message

This is the only opportunity to recover the part file. If you choose not to
recover it, the AutoSave file will be removed.
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Use Auto Backup

Use this option to back up your VisualCAD files automatically. You can change the Auto
Backup Path destination directory by selecting the 'browse' button.

If you have the check box checked, then the file is saved ONCE (as soon as the file is
loaded) to the Auto Backup path with the same name as the original path file.  This file is
not deleted on exit so it can be recovered later if necessary.  By default the check box to
Auto Backup is unchecked.

Use Auto Command Recall

When this option is selected, VisualCAD automatically repeats the last command without
having to go back & reselect the command from the toolbar or use the right mouse
button click or enter option to repeat the previous command.

Use Preselection Highlight

When this option is selected, VisualCAD automatically highlights selections as the cursor
moves over them.  See Pre-Selection Highlight for more information.

Object Snap Settings

You can control the pixel radius of the object snaps located on the Status Toolbar.  Enter
the Snap Radius desired.

Related Topics

Options

5.1.3.2 Display

Controls how geometry is displayed.  Select from the following:

Dialog Box: Options > Display
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Dialog Box: Options > Display

General Settings

Turn on Anti-aliasing
A method of smoothing the jagged edges along the lines and curves of text or
graphics. Aliasing is caused by limited display resolution. Selecting this option turns
on Anti-aliasing.

Shading Style
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This controls how smooth surfaces are shaded.

Smooth Shading
Flat Shading

The pictures demonstrate the difference between smooth and flat shading.  The left
picture smoothly changes the amount of shading as the surface curves.  The right
picture just displays the shading for a flat facet on the surface.  Since all surfaces
(including smooth ones) are internally represented as flat facets, flat shading can
affect any surface.  The default is smooth shading.

Mesh Edges Display Style

This changes how smooth surfaces are displayed.  Since all surfaces are internally
represented as flat facets, these facets join up along edges.  On smooth surfaces,
these edges are not sharp and are not normally displayed.  An example of a sharp
edge is the edge of a cube.

The pictures demonstrate the difference between silhouette & cusp edges only and
all edge display.  The left picture displays only sharp edges (there are none on a
sphere); meanwhile, the right picture displays all the edges.  The default is
Silhouette & Cusp Edges Only. When selected, this allows you to select Silhouette
Edges, Cusp Edges or All Edges to display.

Curve Display Style

 This provides an option to turn on or off display of curve start point and direction
arrow.
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Start Point display OFF
Start Point display ON

Curve Direction arrow OFF Curve Direction arrow ON

Selecting Start Point and Curve Direction arrow display under options displays both
start point and curve direction arrow.

Construction Visual Aids Style

This provides an option to choose the display style between Stipple line and Solid
line for visual aids when the Visual Aids is set to active under the status bar.

Stipple line display



VisualCAD 2025 Companion126

© 2025 Mecsoft Corporation

Solid line display

Rendering Options

This can be set to Use Display Lists or Vertex Arrays.  The Vertex Arrays option also
provides the option to Use Video Memory from the video card that is installed on the
computer. The speed and performance varies depending on the operating system
type and video card installed.

View Change Animation

Whenever the view orientation is changed within the active viewport, VisualCAD can
make that orientation change instantly or through smooth animation. If animation is
used, the speed of the animation can be set.

Under the View Change Animation function, check the box next to Speed to activate
the animation.  The animation speed can be controlled using the slider bar.

Ghosted Display Transparency

Whenever the view mode is set to Ghosted Display, you can use this slider to control
the transparency level of the hidden (ghosted) geometry.

Depth Testing

These options allow you to fully display certain objects regardless of the view mode.
 For example, checking the box to Disable Depth Testing for curves, will display all
curves even if the view is set to shaded model.  You can also Disable Depth testing
for grid.  If enabled, the grid lines will always display.

Thickness

Use this parameter to set the display line thickness for all wireframe geometry. Set
this to 1 for the default line thickness. Higher for thicker lines.

Related Topics
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Options

5.1.3.3 Color

The default colors are set using this dialog.

Dialog Box: Options > Color

Dialog Box: Options > Color

· Screen Background Color  
This allows user to set the viewport background color. This is the color displayed
when no objects are at that position.

· Screen Gradient  
This is a smooth change of lighting.  The direction specified is the lighter side.  It
starts slightly darker on the opposite side of the screen and gradually gets lighter
until it reaches the specified side.

· C-Plane Color  
This changes the color of the construction plane grid.

· C-Plane Grid X Axis Color  
This changes the horizontal axis line of the construction plane.

· C-Plane Grid Y Axis Color  
This changes the vertical axis line of the construction plane.

· Selection Color  
This is the highlight color of objects that have been selected.

· New Layer Color  
This is the default color of objects created on new (not Default) layers.
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· Constr. Visual Aids Color  
This is the default color of construction aids when Visual Aids is set to active in
the status bar.

Related Topics

Options

5.1.3.4 Grid

This controls how the construction plane grid is displayed.

Dialog Box: Options > Grid

Dialog Box: Options > Grid

Position of Grid Origin

These options will control where the grid is positioned relative to the World
Coordinate System (WCS). 

The grid orientation also carries over to whichever view is active, making
construction easier.
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Center
Move the center of the grid to the WCS.

Move the center of the grid to the WCS.

Lower Left
Move the lower left corner of the grid to the WCS.

Move the lower left corner of the grid to the WCS.

Lower Right
Move the lower right corner of the grid to the WCS.

Move the lower right corner of the grid to the WCS.

Upper Left
Move the upper left corner of the grid to the WCS.
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Move the upper left corner of the grid to the WCS.

Upper Right
Move the upper right corner of the grid to the WCS.

Move the upper right corner of the grid to the WCS.

Pick
Use the button to pick a point on the screen and the origin of the grid will move
to this location.

Notes:

· The point you pick is always on the default XY plane.

· If you use the Upper/Lower options above after using this Pick option,
the offset distance between the WCS and the new origin of the grid
remains in effect.

Move the the origin of the grid to this location.

Other Grid Options
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Grid Extents in X Direction
This controls how many major divisions are displayed along the X axis
direction.  

Grid Extents in Y Direction
This controls how many major divisions are displayed along the Y axis
direction.  

Distance between each Minor Grid Line
This controls the distance between each minor grid line.

Major/Minor Grid Lines

# of Divisions between Each Major Line
This controls the distance between each major grid line. the number of minor
rid line multiplied by the number of major grid lines will determine the overall
extent of the grid.

Major/Minor Grid Lines

Related Topics

Options

5.1.3.5 Lighting

This controls the characteristics of lighting for the model.  

Dialog Box: Options > Lighting
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Dialog Box: Options > Lighting

There are three types of lighting:  ambient, diffuse, and specular.

Position Light on Top

The scene has a single light source and there are controls for setting its position.  Not
all lighting in the model comes directly from that one source; there is some ambient
light coming in from all over.  The Position Light on Top checkbox must be unchecked
to be able to move the light source.

Ambient

Ambient light comes in from all different directions equally.  Light sources have no
effect on ambient light.  Shadows don’t appear with only ambient light.
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Diffuse

Diffuse light comes from a single source but is scattered in all directions.  Shadows
appear, but there are no “shiny” spots.

Specular

Specular light comes from a single source and is scattered in a single direction.  It is
reflective light.  Shiny metal objects demonstrate good specular reflection.  Shading
is not a significant consideration with specular light.

The three pictures above demonstrate ambient light as the light source moves from
left to right.  There is no effect since ambient light comes from all sides equally.

The pictures above show the effects of the motion of the light source using only
diffuse lighting.  There are no “shiny” spots but yet there is a direction from the light.
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The last set of pictures uses only specular lighting.  As the light source moves from
left to right, the “shiny” spot follows it.  However, there is nothing else lit up, so the
effect is not just reflective metal.

Related Topics

Options

5.1.3.6 Dimension

This controls the appearance of dimensioning labels, arrows, and leader lines.

Dialog Box: Options > Dimension

Dialog Box: Options > Dimension

Related Topics

Options
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5.1.3.7 Tol. & Units

This controls the accuracy of the model and part units.

Dialog Box: Options > Tolerance and Units

Dialog Box: Options > Tolerance and Units

Tolerances

This controls the accuracy of the models.  Smaller tolerance numbers often result in
significantly big files and slower processing time but are more accurate.

The tolerances are set in a dialog.

Part Faceting Tolerance

Chordal Deviation/Chord Height Tolerance  
The chord height tolerance is used in commands that require approximation
of smooth curves and surfaces.

Curve Hookup Tolerance

This specifies maximum separation between the endpoints of different
curves when joining them into a single curve.
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Units

This converts units from inches to millimeters or from millimeters to inches.  If there
are existing objects, a dialog will appear confirming if you really want to convert the
units.

The objects remain the original size but the coordinate values change.

You can check the box to always prompt you to change the units when files are
opened if they appear not to be in the correct units.  For example, if the system sees
a coordinate value that is quite large such as 500.5, then this dialog will display giving
you the opportunity to change the units to Millimeters.

Related Topics

Options

5.2 Display

The Display Ribbon Bar contains View Modify, Orient, Modes, Visibility and Viewport panes and
associated functions.

The Display Ribbon Bar

Display Ribbon Bar

Related Topics

View Modify Pane, Display Ribbon Bar

Orient Pane, Display Ribbon Bar

Modes Pane, Display Ribbon Bar

Visibility Pane, Display Ribbon Bar

Viewport Pane, Display Ribbon Bar



The Ribbon Bar 137

© 2025 Mecsoft Corporation

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.2.1 View Modify

The Display Ribbon Bar contains the following View Modify pane with associated functions.

Display Ribbon Bar
View Modify Pane

Related Topics

Dynamic Pan View

Dynamic Rotate View

Dynamic Zoom

Fit View

Zoom Out

Zoom In

Zoom Box

Display Ribbon Bar

5.2.1.1 Dynamic Pan View

The mouse moves the camera left, right, up, or down.  It does not change the orientation
or rotate.

You can perform dynamic pan by holding down the shift key on your keyboard and using
right mouse button click.

Related Topics

View Bar Options
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5.2.1.2 Dynamic Rotate View

The mouse moves the camera around the model.  The center of the view is the center of
rotation.  You can perform dynamic rotate using right mouse button click.

Related Topics

View Bar Options

5.2.1.3 Dynamic Zoom

This moves the camera towards or away from the center of view with the mouse.  Hold
down the left mouse-button while moving the mouse forward (zooms in – makes things
appear larger) and backward (zooms out – makes things appear smaller).

You can perform dynamic zoom by holding down the control key on your keyboard and
using right mouse button click.

Related Topics

View Bar Options

5.2.1.4 Fit View

This changes the position of the camera to so that all objects are in view.  It does not
change the orientation or rotation.  If a 3D object (surface, solid or mesh) is selected, the
Fit View command will fit the view to the selected objects.  

Note: With the VisualMILL plug-in module loaded, Fit View will also account for the Stock
model if Stock display is toggled on. 

Related Topics

View Bar Options

5.2.1.5 Zoom Out

The camera backs up to make the objects appear twice as small.  The dimensions of
the objects don’t change, only the position of the camera.

Related Topics

View Bar Options
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5.2.1.6 Zoom In

The camera moves forward to make the objects appear twice as large.  The
dimensions of the objects don’t change, only the position of the camera.

Related Topics

View Bar Options

5.2.1.7 Zoom Box

This creates a rubber-banded rectangle surrounding an area.  The camera is moved so
that the selected area fills the view.  If the area’s aspect ratio doesn’t match the view’s

ratio, the area is expanded so that the entire selected area is in view.  The dimensions of the
objects don’t change, only the position of the camera.

Related Topics

View Bar Options

5.2.2 Orient

The Display Ribbon Bar contains the following Orient pane with associated
functions.

Related Topics

Top View

Bottom View

Front View

Back View

Left View

Right View

Iso View 1-4

Display Ribbon Bar

5.2.2.1 Top View

Changes the currently selected view to look down to the origin.  The camera is positioned
at a positive z-height on the z-axis.  The x-axis points to the right, the y-axis points up, and

the z-axis points out of the screen towards you.  If geometry is not at the origin, it might be out of
view after top view is selected.
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Related Topics

View Bar Options

5.2.2.2 Bottom View

Changes the currently selected view to look up to the origin.  The camera is
positioned at a negative z-height on the z-axis.  The x-axis points to the right, the

y-axis points down, and the z-axis points into the screen away from you.  If geometry is not at the
origin, it might be out of view after bottom view is selected.

Related Topics

View Bar Options

5.2.2.3 Front View

Changes the currently selected view to look at the origin from the front.  The camera is
position at a negative y-coordinate on the y-axis.  The x-axis points to the right, the y-axis

points away from you, and the z-axis points up.  If geometry is not at the origin, it might be out of
view after front view is selected.

Related Topics

View Bar Options

5.2.2.4 Back View

Changes the currently selected view to look at the origin from the back.  The camera is
position at a positive y-coordinate on the y-axis.  The x-axis points to the left, the y-axis

points towards you, and the z-axis points up.  If geometry is not at the origin, it might be out of
view after back view is selected.

Related Topics

View Bar Options

5.2.2.5 Left View

Changes the currently selected view to look at the origin from the left.  The camera is
position at a negative x-coordinate on the x-axis.  The x-axis points away from you, the y-

axis points to the left, and the z-axis points up.  If geometry is not at the origin, it might be out of
view after left view is selected.
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Related Topics

View Bar Options

5.2.2.6 Right View

Changes the currently selected view to look at the origin from the right.  The camera is
position at a positive x-coordinate on the x-axis.  The x-axis points towards you, the y-axis

points to the right, and the z-axis points up.  If geometry is not at the origin, it might be out of
view after right view is selected.

Related Topics

View Bar Options

5.2.2.7 Iso View 1-4

There are 4 preset Iso Views to choose from.  Selecting one of the 4 icons
changes the currently active viewport to the assigned Iso View direction.  Note

that if geometry is not at the origin, it might be out of view after an Iso View is selected.

Iso View Examples
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Iso View 1

Iso View 2
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Iso View 3

Iso View 4

Related Topics

View Bar Options

5.2.3 Modes

The Display Ribbon Bar contains the following Modes pane with associated functions.

Display Ribbon Bar
Modes Pane
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Related Topics

Perspective / Parallel

Toggle Shading + Edges

Shaded Display

Wireframe Display

Toggle Hidden Lines

Toggle Ghosted Display

Display Ribbon Bar

5.2.3.1 Perspective / Parallel

Switch the currently selected view between a perspective view and a parallel view.  The
default is parallel view.  A perspective view shows nearer objects as bigger than normal
while objects that are farther away are shown smaller than normal.  Even nearer faces of
volumes will be bigger than normal while the farther away faces are smaller.  This is a

standard are technique to convey distance but distorts the appearance of objects.

A parallel view maintains the size of all objects, regardless of apparent distance.

Perspective Enabled

Perspective Enabled

Parallel Enabled
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Parallel Enabled

Related Topics

View Bar Options

5.2.3.2 Toggle Shading + Edges

All surfaces and volumes in the currently selected view are filled in with colors.  The
edges of surfaces and volumes are outlined in black. The surface color is modified to
display shading and lighting effects.  There is a light source that can cause shadows and
glossy appearances depending on the position of the geometry and how it is viewed.

Shading + Edges Enabled

Shading + Edges Enabled

Related Topics

View Bar Options

5.2.3.3 Shaded Display

All surfaces and volumes in the currently selected view are filled in with colors.  The color
is modified to display shading and lighting effects.  There is a light source that can cause
shadows and glossy appearances depending on the position of the geometry and how it
is viewed.
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Shading Display Enabled

Shading Display Enabled

Related Topics

View Bar Options

5.2.3.4 Wireframe Display

All surfaces and volumes in the currently selected view are transparent.  Only the
edges are displayed.  Even the edges that would normally be on the backside of a

volume and not normally be displayed show up. If one object is behind another, the farther away
object is visible through the nearer object.

Wireframe Display Enabled

Wireframe Display Enabled

Related Topics

View Bar Options
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5.2.3.5 Hidden Line Display

All surfaces and volumes in the currently selected view are filled in with a neutral
gray.  The edges of surfaces and volumes are displayed in the normal color for that

layer. No lighting or shading effects are displayed.

Hidden Line Display Enabled

Hidden Line Display Enabled

Related Topics

View Bar Options

5.2.3.6 Ghosted Display

This display mode is a combination of Shaded and Hidden Line where the
hidden areas of the part are displayed in a sub-tone color of the part's primary

layer color.  This display mode give you an understanding the hidden areas of the part.  You can
control the transparency level (low to high) from the Display Options dialog.

Ghosted Display Enabled

Ghosted Display Enabled
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Related Topics

View Bar Options

Display Options

5.2.4 Visibility

The Display Ribbon Bar contains the following Visibility pane with associated
functions.

Related Topics

Hide/Show Grid

Hide/Show WCS

Display Ribbon Bar

5.2.4.1 Hide/Show Grid

Switches on and off the display of the construction plane in the currently selected
view.  The default is to show the construction plane (grid).

Related Topics

View Bar Options

5.2.4.2 Hide/Show WCS

Switches on and off the display of the World Coordinate System in the currently
selected view.  The World Coordinate System is the three vectors at the origin,

which show the positive x, y, and z axes.  The default is to show the WCS.

Related Topics

View Bar Options
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5.2.5 Viewport

The Display Ribbon Bar contains the following Viewport pane with associated functions.

Display Ribbon Bar
Viewport Pane

Related Topics

Viewport Layouts

Viewport Menu

Split Viewport

Delete Viewport

Rename Viewport

Save Viewport

Load Viewport

Display Ribbon Bar

5.2.5.1 Viewport Layouts

The next eight options control the viewport layout on the screen according to the following table.
 These are various useful arrangements of the views.

Single
Viewport

Top View

Top View

Iso View

Top View Iso View

Iso View Top View

Right View
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Top View Iso View

Front View

Iso View

Top View Right View

Top View Right View

Iso View

Top View Iso View

Front View Right View

Related Topics

Viewport

5.2.5.1.1  View port Menu

Use this menu to change the configuration of viewport layouts.  A viewport is the section of the
screen that displays what a camera would see if it were positioned at a particular location and
orientation.  The camera will see all the geometry and other objects currently in view with correct
lighting and color.  The view can be changed by panning or rotating. 

Show me the Viewport Menu

Viewport Menu

Right-click Menu from Viewport Title
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More about Viewports

Viewports have titles like Top, Right, Left, and Iso (Isometric).  The way that the
construction plane is aligned is also associated with each different title.  For example,
both Top and Iso have the construction plane in the z-plane; meanwhile, Left and Right
have the construction plane in the y-plane, and Front and Back have the construction
plane in the x-plane.

Each of the named views has a starting position and orientation.  These positions
correspond to the name (i.e. Top is on top of the model, at a large z position (0, 0, big +z).
 Both the icons and the names suggest looking at a model (a house) from the top, left,
right, front, and back.  To distinguish between left and right, notice the little chimney on
top of the house.  It is visible from one side but not the other.  The viewport will always
start in the same location.

It is possible that objects may be visible in one view but out of view in another.  When
you change views, some objects won’t appear, but they are still there.

Multiple viewports can be displayed at the same time.  Commonly used configurations
can be selected with the toolbar button. 

Selecting one of these buttons immediately changes the view port configuration.  While
some objects might suddenly become out-of-view, they are still there.  Panning or
rotating any view should allow them to be seen.

Viewport menu can also be invoked when you right mouse button click on any viewport
title.

Related Topics

Split Viewport

Delete Viewport

Viewport Layouts

Rename Viewport

Align to C-Plane

5.2.5.2 Split Viewport

The first two options under Viewport are used to split the currently active view into two views,
either vertically or horizontally.  Any other view that exists in the Viewport layout will remain
unchanged.

Top View

Iso View
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Top View Iso View

Related Topics

Viewport

5.2.5.3 Delete Viewport

The third option will delete the currently active view from the viewport layout. 
Instantly, one of the adjacent views will fill in the vacated space in the viewport

layout.  The Delete Viewport option will cause no action if the current viewport layout is a single
view.

Related Topics

Viewport

5.2.5.4 Rename Viewport

This option allows the currently active view to be renamed.  The name change is
temporary and neither the name nor the viewport are saved for later reference.

Related Topics

Viewport

5.2.5.5 Save Viewport

This option allows the currently active Viewport to be Saved for later recall.  Complete
the Viewport Name dialog and then pick OK to save it.  Then at any time you can use the

Load Viewport command to reload it as needed.

Viewport Name Dialog

Related Topics

Load Viewport
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5.2.5.6 Load Viewport

This option allows you to Load a Viewport that was previously saved using the Save
Viewport command.  When you select the Load Viewport icon the following Saved

Viewports dialog is displayed.  Select a saved viewport from the list and it will be displayed in the
currently active viewport.  To rename a saved viewport, select it and then pick the Rename ...
button. 

Saved Viewport Dialog

Related Topics

Viewport

Save Viewport

5.3 Modeling Aids

The Modeling Aids Ribbon Bar contains Clipboard, Selections, Commands, Objects and C-Plane
panes and associated functions.

The Modeling Aids Ribbon Bar

Modeling Aids Ribbon Bar

Related Topics

Clipboard Pane, Modeling Aids Ribbon Bar

Selections Pane, Modeling Aids Ribbon Bar

Commands Pane, Modeling Aids Ribbon Bar

Objects Pane, Modeling Aids Ribbon Bar

C-Plane Pane, Modeling Aids Ribbon Bar
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Background Image Pane, Modeling Aids Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.3.1 Clipboard

The Modeling Aids Ribbon Bar contains the following Clipboard pane with
associated functions.

Related Topics

Cut Selection

Copy Selection

Paste Selection

Modeling Aids Ribbon Bar

5.3.1.1 Cut Selection

Objects will be deleted, but will remain on the clipboard until replaced by the next items
moved/copied to the clipboard.  If no objects are selected when the command is

executed, objects can be picked.

Related Topics

Copy Selection

Paste Selection

5.3.1.2 Copy Selection

Objects will be copied onto the clipboard.  If no objects are selected when the
command is executed, objects can be picked.

Related Topics

Cut Selection

Paste Selection
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5.3.1.3 Paste Selection

All objects on the clipboard will be put at the cursor’s position when the command
was executed.

Related Topics

Cut Selection

Copy Selection

5.3.2 Selections

The Modeling Aids Ribbon Bar contains the following Selections pane with associated functions.

Modeling Aids Ribbon Bar
Selections Pane

These commands allow you to select certain geometry to apply commands to as a group. 
Commands such as Delete or Scale will apply to all of the currently selected geometry in the same
way and at the same time.  Selected geometry will be highlighted with the highlight color.  The
default highlight color is yellow.  Selected items can also be on multiple layers.

Multiple items can be selected by holding down the control key (on the keyboard) and left-
clicking on the item with the mouse.

Selections do not apply to geometries that area hidden, locked
and on layers that are not visible and or locked.

Related Topics

Select Menu

Select Points

Select Lines/Polylines

Select Arcs/Circles

Select Arcs/Circles ...

Select Nurbs Curves

Select Polycurves
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Select Point Clouds

Select Shells

Select Meshes

Select Dimensions

Select Open Curves

Select All

Select None

Invert Selections

Select Previous

Select Last

Select Duplicated

Select by Name

Select by Color

Select by Type ...

Select by Layer ...

Selection Mask ...

Modeling Aids Ribbon Bar
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5.3.2.1 Select Menu

Pick the  indicator to drop down the Select Menu.

Select Menu

5.3.2.1.1  Select Points

All points will be selected.  All other geometry will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.2  Select Lines/Polylines

All lines and polylines will be selected.  All other geometry will be
deselected.
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Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.3  Select Arcs/Circles

All arcs and circles will be selected.  All other geometry will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.4  Select Arcs/Circles ...

This function selects arcs and circles only, but gives the option to be
selective to a range of diameter values and orientation.

Select Arcs/Circles dialog box

Select Arcs/Circles dialog box

· Diameter Range  
If the diameter range is used, the diameters may be entered directly or existing
arcs may be picked on the screen to set these values.
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· Location  
Another option restricts the selection to only arcs and circles that are Parallel (co-
planar) to the C-Plane.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.5  Select Nurbs Curves

All NURBS will be selected.  All other geometry will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.6  Select Polycurves

All curves made of sub curves (e.g. chained curves) will be selected.  All
other geometry will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.7  Select Point Clouds

Use this command to select Point Cloud objects.  Currently, the Point Cloud
object can only be created  from corresponding data during Import.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.8  Select Shells

All surfaces & poly-surface objects (not meshes) will be selected.  All other
geometry will be deselected.
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Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.9  Select Meshes

All meshes will be selected.  All other geometry will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.10  Select Dimensions

All Dimension labels and leader lines will be selected.  All other geometry
will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.1.11  Select Open Curves

All curves including polylines, poly-curves, NURBS curves that are open will
be selected. All other geometry will be deselected.

The Open Curves selection function is found under Select on the Menu Bar.

This function will automatically identify all curves on the screen that have an 'open' end that is not
connected to another curve.  These curves will be selected and highlighted. 

Select Open Curves example
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Select Open Curves - Before

Select Open Curves - Before

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.2 Select All

All geometry on all layers is selected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar
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5.3.2.3 Select None

Everything is deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.4 Invert Selections

All geometry currently selected will be deselected; meanwhile, currently unselected
items will be selected and highlighted.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.5 Select Previous

Geometries that were previously selected will be re-selected.  All currently selected
items will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.6 Select Last

The geometry created last will be selected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.7 Select Duplicated

Selects objects that are geometrically identical with another object and visible,
regardless of other object properties.
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Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.8 Select by Name

Geometry will be selected whose name matches a name that you enter.  All other
geometry will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.9 Select By Color

Select an entity and then all geometry with the same color is also selected
automatically.  All other geometry will be deselected.

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.10 Select By Type ...

Geometry of the desired type will be selected.  All other geometry will be
deselected.

Object Selection Filters dialog box
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Object Selection Filters dialog box

· Selectable Types  
Check the box next to the object types that you wish to select.

· Select All / Clear All  
Selects or Clears all types selected. 

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.11 Select By Layer ...

All geometry on the desired layer will be selected.  All other geometry will be
deselected.

Object Selection Filters dialog box (by layer)



The Ribbon Bar 165

© 2025 Mecsoft Corporation

Object Selection Filters dialog box (by layer)

· Selectable Types  
Check the box next to the object types that you wish to select.

· Select All / Clear All  
Selects or Clears all types selected. 

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.12 Selection Mask ...

Use this to set masks based on object types for subsequent selection operations. All
other geometry will be deselected. This can be selected from the Menu bar by clicking

on Select, then choosing Selection Mask from the list. Geometries can be selected either by
clicking on Select from Menu bar and selecting All or dragging a window with mouse to select the
geometry in the viewport.

Selection Mask dialog box
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Selection Masks
Check the box next to the mask types that you wish to select.

Select All / Clear All
Selects or Clears all types selected. 

Selection Mask dialog box example

Example shown displays the Selection Mask for Polyline only and the only geometry
selected in the viewport are the polylines. 

Geometry can be selected either by clicking on Select from Menu bar and selecting All or
dragging a window by holding left mouse to select the geometry. 
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Selection Mask for Polyline results

Related Topics

Select Menu

Selections Pane, Modeling Aids Ribbon Bar

5.3.2.13 Other Selection Techniques

5.3.2.13.1  Select Chain

You can automatically select a chain of curves or edges by pressing the <Shift> key
while performing a left-click selection.  This works with any curves or edges that
are connected end-to-end.  If you want to create a Curve Chain entity see Create a

Curve Chain.  Note that this is not a command and is not located on a menu.

Chain Select (<Shift> + Left-click)

Related Topics

Select Menu

Create a Curve Chain

5.3.2.13.2  Highlights

Objects that are available for selection are highlighted when the cursor moves over them.  This
functionality is not a command and is not located on a menu.  This functionality is
enabled/disabled from the System Options dialog.
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Pre-Selection Highlight

Related Topics

Select Menu

System Options

5.3.2.13.3  Multi-Selections

When you make a selection and there are multiple objects available, the Multi-Selection Dialog
will display listing the available objects.  You can select an object from the list.  If you select None
or pick outside of the list, the dialog will close automatically.

Multi-Selection Dialog

Related Topics

Select Menu
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5.3.2.13.4  from Solid

If your part is a solid model (also referred to as a poly-surface), you can highlight and select one or
more surfaces.  To select one surface just move the cursor over it and then left-click to select it. 
To select multiple surface, press and hold the <Ctrl> key when selecting.

Select Surface from Solid

Related Topics

Select Menu

5.3.3 Commands

The Modeling Aids Ribbon Bar contains the following Commands pane with
associated functions.

Related Topics

Undo

Undo Multiple

Redo

Redo Multiple

Command Recall

Continuous Command Recall

Modeling Aids Ribbon Bar



VisualCAD 2025 Companion170

© 2025 Mecsoft Corporation

5.3.3.1 Undo

Undoes the previous construction or edit command.  Everything goes back to how it
was before the last command was executed.  Geometry objects that were previously
selected (highlighted) will remain selected when Undo is used.

Related Topics

Undo

Undo Multiple

Redo

Redo Multiple

Commands Pane, Modeling Aids Ribbon Bar

5.3.3.2 Redo

Redoes a previously undone construction or edit command.  Everything returns to
the state after the command was executed.

Related Topics

Undo

Undo Multiple

Redo Multiple

Commands Pane, Modeling Aids Ribbon Bar

5.3.3.3 Undo Multiple

This command will Undo multiple commands at the same time.  A list of
recent commands is displayed.  A command is selected, and all commands

after that one including it are undone.  Everything returns to the state before the selected
command was executed. 

The commands are listed in reverse order with the most recent at the top.  The last command
executed is number one, and the second to last command executed is number two.  Only one
command needs to be picked, and all commands higher (more recent or occurred after that one)
will automatically be selected.

Dialog Box: Undo Multiple
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Dialog Box: Undo Multiple

Related Topics

Undo

Redo

Redo Multiple

Commands Pane, Modeling Aids Ribbon Bar

5.3.3.4 Redo Multiple

Redo Multiple commands that were previously undone.  A list of undone
commands is displayed.  A command is selected, and all commands after

that one including it are redone.  Everything returns to the state after the selected command was
executed.

The commands are listed in the order that they were originally executed. The first command
executed is number one, and the second command executed is number two.  Only one command
needs to be picked, and all commands higher will automatically be selected.

Once commands have been undone, they will appear in the multiple redo list until another
command is executed.  Then the multiple redo list is emptied.  Redo will have no effect.

Dialog Box: Redo Multiple
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Dialog Box: Redo Multiple

Related Topics

Undo

Undo Multiple

Redo

Commands Pane, Modeling Aids Ribbon Bar

5.3.3.5 Command Recall

Redo the previous command.

Related Topics

Commands Pane, Modeling Aids Ribbon Bar

5.3.3.6 Continuous Command Recall

Automatically repeats the last command without having to go back & reselect the command
from the toolbar or use the right mouse button click or enter option to repeat the previous

command.

Related Topics

Commands Pane, Modeling Aids Ribbon Bar

5.3.4 Objects

The Modeling Aids Ribbon Bar contains the following Objects pane with
associated functions.

Related Topics
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Lock Selection

Unlock All

Hide Selection

Hide Non-Selected

Show All

Modeling Aids Ribbon Bar

5.3.4.1 Lock Selection

Locks all selected objects. Sets the state of selected objects so they can be seen but
cannot be selected for editing.

Related Topics

Unlock

5.3.4.2 Unlock All

Unlocks all locked objects.

Related Topics

Lock

5.3.4.3 Hide Selection

Hides or Conceals selected objects from view.

Related Topics

Show

Hide Non-Selected

5.3.4.4 Hide Non-Selected

Hides or Conceals non selected objects from view.

Related Topics
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Hide

Show

5.3.4.5 Show All

Displays all hidden objects.

Related Topics

Hide

Hide Non-Selected

5.3.5 C-Plane

The Modeling Aids Ribbon Bar contains the following C-Plane pane with associated functions.

C-Plane Pane, Modeling Aids Ribbon Bar

Related Topics

Set C-Plane to View

Set C-Plane to Top View

Set C-Plane to Bottom View

Set C-Plane to Front View

Set C-Plane to Back View

Set C-Plane to Left View

Set C-Plane to Right View

Set C-Plane Origin

Set C-Plane Elevation

Rotate the C-Plane

Set C-Plane by 3 Points

Set C-Plane to 3D Face

Set C-Plane to Planar Curve

Set C-Plane by X Axis



The Ribbon Bar 175

© 2025 Mecsoft Corporation

Set C-Plane to WCS

Save C-Plane

Load a C-Plane

Modeling Aids Ribbon Bar

5.3.5.1 Set to View

This option immediately sets the orientation of the C-Plane to be parallel to the plane of
the currently active view.  The origin remains the same.

Command Prompts

C-Plane by View:: Done

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.2 Set to Top View

Move the construction plane to the origin and in the z-plane.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.3 Set to Bottom View

Move the construction plane to the origin and in the z-plane.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.4 Set to Front View

Move the construction plane to the origin and in the y-plane.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar
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5.3.5.5 Set to Back View

Move the construction plane to the origin and in the y-plane.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.6 Set to Left View

Move the construction plane to the origin and in the x-plane.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.7 Set to Right View

Move the construction plane to the origin and in the x-plane.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.8 Set Origin

Moves the origin of the C-Plane to a selected point or entered coordinates.  The current
configuration of the construction plane is saved whenever the model is saved into the
VCP (VisualCAD Part) file.

Command Prompts

C-Plane Origin:: Pick origin point or enter coordinates x, y and z

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.9 Set Elevation

Moves the elevation of the C-Plane along its normal (perpendicular to the plane). 
Input is a single distance and may be positive or negative.  A positive number moves

the plane towards the positive end of the coordinate axes even if the viewing location is along
the negative axis.  All input values are treated as an incremental distance relative to the current
location of the plane.
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Command Prompts

C-Plane Elevation:: Enter C-Plane elevation

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.10 Rotate

Rotates the C-Plane about one of the principle axes of the current C-Plane, X, Y, or Z. 
The center of rotation is the center of the plane and not necessarily the origin. Input is

'axis,degrees'.

Command Prompts

Rotate C-Plane:: Enter axis to rotate about and angle to rotate by (eg: X,45)

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.11 Set by 3 Pts

Three points are selected (origin, x-axis and y-axis) or entered to re-orient the C-
Plane.  The y-axis point defines the C-Plane and the general direction of the positive

y-axis. 

Command Prompts

C-Plane by 3Pts:: Pick origin point or enter coordinates x, y and z

C-Plane by 3Pts:: Pick x axis point or enter coordinates x,y and z

C-Plane by 3Pts:: Pick y axis point or enter coordinates x,y and z

Notes

1. The true y-axis will lie in the plane and be perpendicular to the x-axis and will
pass through the origin point. 

2. The third point cannot be collinear with the other two points.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar
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5.3.5.12 C-Plane to 3D Face

The C-Plane will be oriented to a selected flat plane of a geometry object.  The pick
point will become the C-Plane origin.

Command Prompts

C-Plane to 3D Face:: Pick flat area:

Basic Procedure

Screen Pick  Command Input

Step 1 Select the 3D face to align the C-
Plane to.

None

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.13 C-Plane to Planar Curve

The C-Plane will be oriented to a selected planar curve.  The pick point will become
the C-Plane origin.

Command Prompts

C-Plane to Planar Curve:: Pick a planar curve

Basic Procedure

Screen Pick  Command Input

Step 1 Select the 3D planar curve to align
the C-Plane to.

None

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.14 Set by X Axis

Two points are entered to re-orient the x-axis of the C-Plane:
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Command Prompts

C-Plane by X-Axis:: Pick origin point or enter coordinates x, y and z

C-Plane by X-Axis:: Pick x axis point or enter coordinates x,y and z

Basic Procedure

 Screen Pick  Command Input

Step 1 Pick the new origin point or enter
the x,y,z coordinates.

Final Pick a point on the new x-axis. 
The new C-Plane is parallel to the
prior orientation.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.15 Set to WCS

Resets the C-Plane back to its default orientation relative to the WCS and the
currently active viewport.  The origin will be the WCS origin.

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.5.16 Save ...

This option saves the C-Plane orientation from the currently active view.  A name must be
provided for later reference when loading.

C-Plane Name dialog box

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar
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5.3.5.17 Load ...

This option allows the retrieval of a saved C-Plane into the currently active view.  A list of
previously saved C-Planes is presented.  These saved C-Planes may also be deleted in this

option or renamed.

Saved C-Planes dialog box

Related Topics

C-Plane Pane, Modeling Aids Ribbon Bar

5.3.6 Background Image

The Modeling Aids Ribbon Bar contains the following Background Image pane with associated
functions.

Background Image Pane, Modeling Aids Ribbon
Bar

Related Topics

Place Background Image

Move Background Image

Scale Background Image

Toggle Display of Background Image

Gray Scale Background Image

Background Image Transparency
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5.3.6.1 Place Image

Use this command to place an image onto the background of the C-Plane.

Command Prompts

1. Select an image using the file browser.

2. Pick first point of enter x,y and z

3. Pick second point or enter coordinates x, y and z

Basic Procedure

Screen Pick Command Input

Step 1 none Select image file.

Step 2

Pick First Point

Pick first point of enter x,y and z.

Step 3

Pick Second Point

Pick first point of enter x,y and z.
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Final

Background Image

Background Image Full Viewport

Related Topics

Background Image

Move Background Image

Scale Background Image

Toggle Background Image On/Off

Gray Scale Background Image

Background Image Transparency

Delete Background Image

5.3.6.2 Move Image

Use this command to Move the existing background image from one point to another
on the C-Plane.

Command Prompts

1. Pick first point or enter coordinates x,y and z

2. Pick first point or enter coordinates x,y and z

Basic Procedure
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Screen Pick Command Input

Step 1 Pick a point to move from.  You
can use the Object Snaps
available from the Status
Toolbar.

Pick First Point

Pick first point or enter coordinates x,y
and z

Step 2 Pick a point to move to.  You
can use the Object Snaps
available from the Status
Toolbar.

Pick Second Point

Pick first point or enter coordinates x,y
and z

Related Topics

Background Image

Place Background Image

Scale Background Image

Toggle Background Image On/Off

Gray Scale Background Image

Background Image Transparency

Delete Background Image
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5.3.6.3 Scale Image

Use this command to Scale the existing background image on the C-Plane.

Command Prompts

1. Enter scale center point

2. Enter first reference point or scale factor

3. Enter second reference point

Basic Procedure

Screen Pick Command Input

Step 1 Pick a point to serve as the
scaling center point.  You can
use the Object Snaps available
from the Status Toolbar.

Enter scale center point

Enter scale center point

Step 2 Pick a reference point or enter
a scale factor.  You can use the
Object Snaps available from
the Status Toolbar.

Enter first reference point or scale factor

Enter first reference point or scale
factor
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Step 3 Pick a second reference point. 
You can use the Object Snaps
available from the Status
Toolbar.

Enter second reference point

Enter second reference point

Related Topics

Background Image

Place Background Image

Move Background Image

Toggle Background Image On/Off

Gray Scale Background Image

Background Image Transparency

Delete Background Image

5.3.6.4 Toggle Image On/Off

Use this command to toggle the display of the background image on and off.

Command Prompts

1. None

Basic Procedure

Screen Pick Command Input

Step 1 Pick the command icon to toggle the
display of the background image off.

None
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Background Image On

Step 2 Pick the command icon to toggle the
display of the background image on.

Background Image Off

None

Related Topics

Background Image

Place Background Image

Move Background Image

Scale Background Image

Gray Scale Background Image

Background Image Transparency

Delete Background Image

5.3.6.5 Gray Scale Image

Use this command to toggle the display of the background image to and from gray
scale.
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Command Prompts

1. None

Basic Procedure

Screen Pick Command Input

Step 1 Pick the command icon to toggle the
display of the background to gray scale
(On)

Gray Scale On

None

Step 2 Pick the command icon to toggle the
display of the background from gray
scale (Off)

Gray Scale Off

None

Related Topics

Background Image

Place Background Image

Move Background Image
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Scale Background Image

Toggle Background Image On/Off

Background Image Transparency

Delete Background Image

5.3.6.6 Image Transparency

Use this command to adjust the transparency of the background image.

Command Prompts

1. None

Basic Procedure

Screen Pick Command Input

Step 1 Pick the dropdown menu indicator to the
right of the command icon to display the
transparency slider.  

Move the slider to the right for no
transparency

Transparency Slider full right

None

Step 2 Move the slider to the middle for half
transparency.

None
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Transparency half

Related Topics

Background Image

Place Background Image

Move Background Image

Scale Background Image

Toggle Background Image On/Off

Gray Scale Background Image

Delete Background Image

5.3.6.7 Delete Image

Use this command to delete the currently active background image. 

Command Prompts

1. None

Basic Procedure

Screen Pick Command Input

Step 1 Pick the command icon to
delete the background image.

None

Related Topics
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Background Image

Place Background Image

Move Background Image

Scale Background Image

Toggle Background Image On/Off

Gray Scale Background Image

Background Image Transparency

5.4 Curve Modeling

The Curve Modeling Ribbon Bar contains Curves and Edit Curves panes and associated functions.

The Curve Modeling Ribbon Bar

Curve Modeling Ribbon Bar

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

Edit Curves Pane, Curve Modeling Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.4.1 Curves

The Curve Modeling Ribbon Bar contains the following Curves pane with associated functions.

Curve Modeling Ribbon Bar
Curves Pane
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Related Topics

Point

Mid Point

Center Point

Point Grid

Polar Grid of Points

Points along a Curve

Line

Rectangle, 2 Points

Rectangle, Center

Rectangle, 3 Points

Rectangle, Vertical

Rectangle

Polyline

Rounded Rectangle

Line at an Angle

Mid-Point Line

Line Normal to a Curve

Line Normal to 2 Curves

Line Normal & Tangent

Line Tangent to a Curve

Line Tangent to 2 Curves

Circle at Center and a Point

Circle by 2 Dia. Points

Circle with 3 Dia Points

Circle Tangent to 3 Curves

Arc with Center, Start and Angle

3-Point Arc

Arc with Center, Start and On Point

Ellipse, Diameter

Ellipse, Foci

Nurbs Curve
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Text Curves

Text on a Curve

Spiral Curve

Helix Curve

Curves from Flat Area

Boundary Curves from all Flat Areas

Extract all Silhouette Curves

Curve from a Surface Boundary

Bounding Rectangle

Section Curves

Curve Modeling Ribbon Bar

5.4.1.1 Point

Create a point by picking on the screen or by entering X, Y, Z coordinates.

Command Prompts

Point:: Pick point or enter coordinates x,y and z

Basic Procedure

 Screen Pick  Command Input

Step 1 Create a point by
picking a
location on the
screen. 

(Optional) Enter the X, Y, Z coordinates of the
point. 

Also:  Other valid entries are...

X, Y coordinates only.

Z is 0.000

Note: X, Y, Z coordinates are relative to the
Construction Plane in the Active View.
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Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.2 Point, Mid

Create a point mid-way between two screen picks or by entering X, Y, Z coordinates for
either point.

Command Prompts

Mid:: Pick first point or enter coordinates x,y and z

Mid:: Pick second point or enter coordinates x, y and z

Basic Procedure

 Screen Pick  Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the first
point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the second
point.
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Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.3 Point, Center

Create a point at the center of a circle made from three construction points.

Command Prompts

Basic Procedure

 Screen Pick Command Input

Step 1  Pick three points to
define a circle.

(Optional) Enter X, Y, [Z] coordinates for any of the
three points.

Step 2 (Optional) Enter X, Y, [Z] coordinates for any of the
three points.
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Step 3 (Optional) Enter X, Y, [Z] coordinates for any of the
three points.

Final

Notes

1. All construction points and circle are on the Construction Plane and are not kept.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.4 Point, Grid

Create points in a rectangular grid array.

Command Prompts

Basic Procedure

Screen Pick  Command Input

Step 1 Enter the number of columns (along X) and rows
(along Y).  The default values are shown in the
Prompt.
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Step 2 Enter the angle that the array makes with the X axis.
 The Default value is shown in the Prompt.

Step 3 (Optional) Enter X, Y, [Z] coordinates for the first
point.

Step 4 (Optional) Enter X, Y, [Z] coordinates for the second
point.

Final

Notes

1. The incremental distance between the two points (in X and Y) determines the
incremental distance between columns and rows respectively.

2. Since the construction plane changes between the different views, the
directions “First” and “Normal” will also change.

Example with a 45-degree rotation

Related Topics

Curves Pane, Curve Modeling Ribbon Bar
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5.4.1.5 Point, Polar Grid

Create points in a circular grid array.

Command Prompts

Basic Procedure

 Screen Pick Command Input

Step 1 Enter the number of points in the circular
array.  The default value is shown in the
Prompt.

Step 2 Enter the angle that a radial line through the
first circumference point makes with the X
axis.  The Default value is shown in the
Prompt.

Step 3 (Optional) Enter X, Y, [Z] coordinates for the
first point.
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Step 4 (Optional) Enter X, Y, [Z] coordinates for the
second point (determines the radius).

or... 

(Optional) Enter the radius value directly.

Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.6 Point, On Curve

Create points equidistant along a curve.

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1

Step 2 Enter the number of points to be created. 
The default value is shown in the Prompt.

Final

Notes

1. If multiple curves are selected, a full set of points will be created on each curve.

2. The curves can be 3D spatial curves.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.7 Line

Create a line between two points by picking on the screen or by entering X, Y, Z
coordinates.

Command Prompts

Basic Procedure
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 Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point.

Notes

1. Coordinate entry can be in absolute or relative coordinates.  An example of
absolute coordinate is shown above.

2. Example of coordinate entry Input for relative coordinates:

a. Pick first point or enter coordinates x,y and Z: 2,0

b. Pick second point or enter coordinates x,y and Z: R5,0

3. For the second point, the coordinate input can also be entered as @5,0.  This
creates a horizontal line that is 5 units in length from 2,0 to 7,0 in X Y coordinates.

4. To create a vertical line, the coordinate entry for second point can be entered as
@0,5. This creates a vertical line that is 5 units in length from 2,0 to 2,5 in X Y
coordinates.

5. To create a line at an angle the coordinate entry for the second point can be
entered as @5<45. This creates a line at 45 degrees which is 5 units in length.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.8 Rectangle, 2 Points

Create a rectangle between two points by picking on the screen or by entering X, Y, Z
coordinates.
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Command Prompts

Rectangle:: Pick first corner point or enter coordinates x,y and z

Rectangle:: Pick second corner point or enter coordinates x,y and z

Rectangle:: Done

Basic Procedure

 Screen Pick  Command Input

Step 1 (Optional) Enter X, Y, [Z]
coordinates for the first point.

Step 2 (Optional) Enter X, Y, [Z]
coordinates for the second point
(opposite corner).

Final

Notes

1. The rectangle is aligned with the axes of the Construction Plane.

2. The final rectangle will lie in a plane parallel to the Construction Plane and with
one corner at the first point selected.

3. If the second point selected is not in that same plane, it will be projected onto
the destination plane of the final rectangle.

4. Coordinate entry can be in absolute coordinates or in relative coordinates.  An
example of absolute coordinate is shown above.

5. Example of coordinate entry Input for relative coordinates:
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a. Pick first corner point or enter coordinates x,y and Z: 2,0

b. Pick second corner point or enter coordinates x,y and Z: R6,4

6. For the second point, the coordinate input can also be entered as @6,4. 
This creates a rectangle line that is 6 units in length and 4 units in width from 2,0
to 8,4 in X Y coordinates.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.9 Rectangle, Center

Create a rectangle about a center point. Picking points or entering
coordinates.

Command Prompts

Rectangle:: Pick center point or enter coordinates x,y and z

Rectangle:: Pick other corner point or enter coordinates x,y and z

Rectangle:: Done

Basic Procedure

 Screen Pick

Step 1 Rectangle:: Pick center point or enter coordinates x,y and z

Step 2 Rectangle:: Pick other corner point or enter coordinates x,y and z

Final Rectangle:: Done
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Notes

1. The rectangle is aligned with the axes of the Construction Plane.

2. The final rectangle will lie in a plane parallel to the Construction Plane and with
one corner at the first point selected.

3. If the second point selected is not in that same plane, it will be projected onto
the destination plane of the final rectangle.

4. Coordinate entry can be in absolute coordinates or in relative coordinates.

5. Example of coordinate entry Input for relative coordinates:

a. Pick first corner point or enter coordinates x,y and Z: 2,0

b. Pick second corner point or enter coordinates x,y and Z: R6,4

6. Coordinate input can also be entered as @6,4. 
This is 6 units in length and 4 units in width from 2,0 to 8,4 in X Y coordinates.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.10 Rectangle, 2 Points 2

Create a rectangle between two points by picking on the screen or by entering X, Y, Z
coordinates.

Command Prompts

Rectangle:: Pick first corner point or enter coordinates x,y and z

Rectangle:: Pick second corner point or enter coordinates x,y and z

Rectangle:: Done

Basic Procedure

 Screen Pick  Command Input
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Step 1 (Optional) Enter X, Y, [Z]
coordinates for the first point.

Step 2 (Optional) Enter X, Y, [Z]
coordinates for the second point
(opposite corner).

Final

Notes

1. The rectangle is aligned with the axes of the Construction Plane.

2. The final rectangle will lie in a plane parallel to the Construction Plane and with
one corner at the first point selected.

3. If the second point selected is not in that same plane, it will be projected onto
the destination plane of the final rectangle.

4. Coordinate entry can be in absolute coordinates or in relative coordinates.  An
example of absolute coordinate is shown above.

5. Example of coordinate entry Input for relative coordinates:

a. Pick first corner point or enter coordinates x,y and Z: 2,0

b. Pick second corner point or enter coordinates x,y and Z: R6,4

6. For the second point, the coordinate input can also be entered as @6,4. 
This creates a rectangle line that is 6 units in length and 4 units in width from 2,0
to 8,4 in X Y coordinates.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar
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5.4.1.11 Rectangle, 3 Points

Create a rectangle between two base points and a height point.
Picking points or entering coordinates.

Command Prompts

Rectangle:: Pick edge start point or enter coordinates x,y and z

Rectangle:: Pick edge end point or enter coordinates x,y and z

Rectangle:: Pick point or enter coordinates x,y and z or enter width

Rectangle:: Done

Basic Procedure

 Screen Pick

Step 1 Rectangle:: Pick edge start point or enter coordinates x,y and z

Step 2 Rectangle:: Pick edge end point or enter coordinates x,y and z

Step 3 Rectangle:: Pick point or enter coordinates x,y and z or enter width

Final Rectangle:: Done

Notes
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1. The rectangle is aligned with the axes of the Construction Plane.

2. The final rectangle will lie in a plane parallel to the Construction Plane and with
one corner at the first point selected.

3. If the second point selected is not in that same plane, it will be projected onto
the destination plane of the final rectangle.

4. Coordinate entry can be in absolute coordinates or in relative coordinates.  An
example of absolute coordinate is shown above.

5. Example of coordinate entry Input for relative coordinates:

a. Pick first corner point or enter coordinates x,y and Z: 2,0

b. Pick second corner point or enter coordinates x,y and Z: R6,4

6. For the second point, the coordinate input can also be entered as @6,4. 
This creates a rectangle line that is 6 units in length and 4 units in width from 2,0
to 8,4 in X Y coordinates.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.12 Rectangle, Vertical

Create a rectangle between two base points and a height point.
You can pick points or enter coordinates (See notes below).

Command Prompts

Rectangle:: Pick edge start point or enter coordinates x,y and z

Rectangle:: Pick edge end point or enter coordinates x,y and z

Rectangle:: Pick point or enter coordinates x,y and z or enter width

Rectangle:: Done

Basic Procedure

 Screen Pick

Step 1 Rectangle:: Pick edge start point or enter coordinates x,y and z
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Step 2 Rectangle:: Pick edge end point or enter coordinates x,y and z

Step 3 Rectangle:: Pick point or enter coordinates x,y and z or enter width

Final Rectangle:: Done
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Notes

1. The rectangle is aligned with the axes of the Construction Plane.

2. The final rectangle will lie in a plane parallel to the Construction Plane and with
one corner at the first point selected.

3. If the second point selected is not in that same plane, it will be projected onto
the destination plane of the final rectangle.

4. Coordinate entry can be in absolute coordinates or in relative coordinates.  An
example of absolute coordinate is shown above.

5. Example of coordinate entry Input for relative coordinates:

a. Pick first corner point or enter coordinates x,y and Z: 2,0

b. Pick second corner point or enter coordinates x,y and Z: R6,4

6. For the second point, the coordinate input can also be entered as @6,4. 
This creates a rectangle line that is 6 units in length and 4 units in width from 2,0
to 8,4 in X Y coordinates.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.13 Polyline

Create a polyline between consecutive points by picking on the screen or by entering X, Y, Z
coordinates. Polylines are continuous line segments connected end-to-end.

Command Prompts

The Prompt (and point selection) is repeated until the right mouse button is clicked.

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for
the first point.
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Step 2 (Optional) Enter X, Y, [Z] coordinates for
any of the intermediate points.

Step 3

After the last point is
selected, click the right mouse
button to end the selection.

Final

Notes

1. Coordinate entry can be in absolute coordinates or in relative coordinates.  An
example of absolute coordinate is shown above.

2. Example of coordinate entry Input for relative coordinates:

a. Pick point or enter coordinates x,y and Z: 2,0

b. Pick point or enter coordinates x,y and Z: R5,0

3. For the second point, the coordinate input can also be entered as @5,0.  This
creates a horizontal line that is 5 units in length from 2,0 to 7,0 in X Y coordinates.

4. To create a vertical line, the coordinate entry for next point can be entered as
@0,5. This creates a vertical line that is 5 units in length from 2,0 to 2,5 in X Y
coordinates.

5. To create a line at an angle the coordinate entry for the next point can be
entered as @5<45. This creates a line at 45 degrees which is 5 units in length.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar
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5.4.1.14 Rounded Rectangle

Create a rounded rectangle between two points by picking on the screen or by entering X, Y,
Z coordinates.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (opposite corner).
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Step 3 Enter the radius of the rounded corners.

or...

(Optional) Enter X, Y, [Z] coordinates that the
arc of the rounded corner should pass through.

If the point specified is too far inside the
rectangle, the maximum radius will be
maintained. 

Final

Notes

1. The rules for alignment and positioning are the same as for Rectangle.

2. All four rounded corners will have the same radius.

3. A radius value of 0.00 will produce a standard rectangle with sharp corners.

4. If the entered radius equals or exceeds half the width of the rectangle, then a
full-radius rectangle will result.

Example of coordinate entry Input for relative coordinates.

1. Pick first corner point or enter coordinates x,y and Z: 2,0

2. Pick second corner point or enter coordinates x,y and Z: R6,4
For the second point, the coordinate input can also be entered as @6,4
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This creates a rounded rectangle line that is 6 units in length and 4 units in width
from 2,0 to 8,4 in X Y coordinates.

3. Enter radius: 0.25

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.15 Line at Angle

Create a line at an angle to a base line, and either through a point or you can input an angle
and a line length.

Command Prompts

Basic Procedure

 Screen Pick  Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the first
point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the second
point.
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Step 3 (Optional) Enter X, Y, [Z] coordinates for the third
point.

or...

(Optional) Enter the angle of the line from this
base line.

and...

(optional) Enter the length of the line to be
created.

Final

Notes

1. The first point selected is the pivot point about which the angle is measured.

2. If the second point is defined by picking on the screen or by entering
coordinates, then the distance between those two points becomes the length of
the created line, unless the length is entered through Input.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.16 Line, from Mid-Point

Create a line by specifying its mid-point and an end-point.

Command Prompts
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Basic Procedure

 Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point (mid-point).

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (end point).

Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.17 Line, Normal to

Create a line that is normal (perpendicular) to a curve.  Line segments, polylines, and
rectangles can also be selected.

Command Prompts

Tangent to:: Pick the curve to draw the tangent to
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Tangent to:: Pick end point of Tangent line. You can use "S" key to change tangent line
(BLACK line will be created)

Basic Procedure

Screen Pick Command Input

Step 1

Step 2 (Optional) Enter X, Y, [Z] coordinates for the far
end point.

Final

Notes

1. If the normal line cannot be calculated, no line will appear on the screen.

2. In the case of multiple solutions, the nearest normal point will be used.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.18 Line, Normal to 2

Create a line that is normal (perpendicular) to two curves.  Line segments, polylines, and
rectangles can also be selected.



VisualCAD 2025 Companion216

© 2025 Mecsoft Corporation

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Step 2

Step 3

In step 3 above where there are
multiple solutions, move the cursor
along the line and left click when the
desired solution appears.

Notes

1. If the normal line cannot be calculated, no line will appear on the screen.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar
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5.4.1.19 Line, Normal & Tangent

Create a line that is normal (perpendicular) to the first curve and tangent to the second
curve.  Line segments, polylines, and rectangles can also be selected.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 none

Step 2

Step 3

Final

Notes
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1. If the line cannot be calculated, a line will not appear on the screen.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.20 Line, Tangent to

Create a line that is tangent to a curve.  Line segments, polylines, and rectangles can also be
selected.

Command Prompts

Tangent to:: Pick the curve to draw the tangent to

Tangent to:: Pick end point of Tangent line. You can use "S" key to change tangent line
(BLACK line will be created)

Basic Procedure

Screen Pick Command Input

Step 1

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
non-tangent end point.

(Optional) Pick the S key to switch the
tangent direction of the line:
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Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.21 Line, Tangent to 2

Create a line that is tangent to a two curves.  Line segments, polylines, and rectangles can
also be selected.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Step 2
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Final

Notes

1. If multiple curves are pre-selected at the time that this function is used, only one
of the pre-selected curves is retained as the first, picked curve.

2. If no solution is possible, then no line will appear on the screen.

3. Moving the cursor around will reveal the other solutions of tangency.  

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.22 Circle, Center, On Pt

Create a circle by picking a center point and a point on the circle.

Command Prompts

Basic Procedure

 Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
center point.
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Step 2 (Optional) Enter X, Y, [Z] coordinates for the
point (diameter) on the circle.

Final

Notes

1. The circle will be created in a plane that passes through the specified center
point and that is parallel to the Construction Plane of the currently selected
view.

2. If the circumference point is not on the plane of the circle, it will be projected
normal onto that plane.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.23 Circle, Start, Diameter Pt

Create a circle by picking two opposite points on the circumference that determine the
diameter of the circle.

Command Prompts

Basic Procedure

Screen Pick Command Input



VisualCAD 2025 Companion222

© 2025 Mecsoft Corporation

Step 1 (Optional) Enter X, Y, [Z] coordinates for the first
point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the second
point.

Final

Notes

1. The circle will be created in a plane that passes through the first circumference
point and that is parallel to the Construction Plane of the currently selected
view.

2. If the second circumference point is not on the plane of the circle, it will be
projected normal onto that plane.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.24 Circle, 3 Pts

Create a circle by picking three points on the circumference of the circle.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point.

Step 3 (Optional) Enter X, Y, [Z] coordinates for the
third point.

Final

Notes

1. The circle will be created in a plane that passes through all three points.  These
points may not be collinear.

2. The start of the circle will be at the first circumference point specified.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.25 Circle, Tangent to 3

Create a circle that will be mutually tangent to three curves or locations.  The geometry
selected may be points, lines, or curves.
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Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Step 2

Step 3
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Step 4

 or

Notes

1. If line segments are used, they are extended to lines for the purpose of
computing the tangency.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.26 Arc, Center, Start, Angle Pts

Create an arc by giving a center point, a starting point which determines the radius, and an
end point, which determines the angle of the arc.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the first
point (center of circle).
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Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (determines radius and arc start).

Step 3 (Optional) Enter X, Y, [Z] coordinates for the third
point (determines angle and arc end).

Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.27 Arc, 3 Pts

Create an arc by selecting three points on the circumference:  a start point, an intermediate
point, and an end point (in that order of selection).

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point (start of arc).

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (intermediate point on arc).

Step 3 (Optional) Enter X, Y, [Z] coordinates for the
third point (end of arc).

Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.28 Arc, Start, End, On

Create an arc by selecting three points on the circumference:  a start point, an end point,
and then an intermediate point (in that order of selection).

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the first
point (start of arc).

Step 2 (Optional) Enter X, Y, [Z] coordinates for the second
point (end of arc).

Step 3 (Optional) Enter X, Y, [Z] coordinates for the third
point (intermediate point on arc).

Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.29 Ellipse, Center, Diameter, End Pt.

Create an Ellipse by selecting three points. The first two points define the major axis
while the third point defines the minor axis. 

Command Prompts

Ellipse:: Pick major axis start point or enter coordinates x,y and z

Ellipse:: Pick major axis end point or enter coordinates x,y and z
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Ellipse:: Pick minor axis end point or enter coordinates x,y and z or Enter width value

Basic Procedure

Screen Pick / Command Input

Step 1

Ellipse:: Pick major axis start point or enter coordinates x,y and z

Step 2

Ellipse:: Pick major axis end point or enter coordinates x,y and z

Step 3

Ellipse:: Pick minor axis end point or enter coordinates x,y and z or Enter width
value.

Final

Related Topics
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Curves Pane, Curve Modeling Ribbon Bar

5.4.1.30 Ellipse, Diameter, End Pt.

Create an Ellipse by selecting two diameter points and a third point to
define the axis end point. 

Command Prompts

Ellipse:: Pick major axis start point or enter coordinates x,y and z

Ellipse:: Pick major axis end point or enter coordinates x,y and z

Ellipse:: Pick minor axis end point or enter coordinates x,y and z or Enter width value

Basic Procedure

Screen Pick / Command Input

Step 1

Ellipse:: Pick major axis start point or enter coordinates x,y and z

Step 2

Ellipse:: Pick major axis end point or enter coordinates x,y and z

Step 3

Ellipse:: Pick minor axis end point or enter coordinates x,y and z or Enter width
value.
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Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.31 Ellipse, Foci

Create an Ellipse by defining a focal point about which the ellipse is
positioned. The first two points define the ellipse major axis and are

the focal points about which the ellipse is located. The minor axis of the ellipse passes through a
third point defining the minor axis.  Refer to the steps below. 

Command Prompts

Ellipse:: Pick first foci point or enter coordinates x,y and z

Ellipse:: Pick second foci point or enter coordinates x,y and z

Ellipse:: Pick point or enter coordinates x,y and z

Basic Procedure

Screen Pick / Command Input

Step 1

Ellipse:: Pick first foci point or enter coordinates x,y and z
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Step 2

Ellipse:: Pick second foci point or enter coordinates x,y and z

Step 3

Ellipse:: Pick point or enter coordinates x,y and z

Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.32 Nurbs Curve

Non-uniform rational basis-spline (NURBS) is a mathematical way of defining curves. The
control points determine the shape of the curve. Typically, each point of the curve is
computed by taking a weighted sum of a number of control points. The degree of the
Nurbs curve can be set between 1 and 11.

Create a NURBS Curve by first entering the degree of B-Spline and then pick point or enter the X,
Y, Z coordinates. Open and closed curves can be created using NURBS Curve. NURBS Curve icon can
be selected in the Geometry Ribbon Bar under the Curves tab.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Enter degree of B Spline ( 1 < degree < 11 )::
[degree=2]

Step 2 (Optional) Pick point or enter coordinates x,y
and z

Step 3 (Optional) Pick point or enter X, Y, [Z]
coordinates for the second point.

Step 4 (Optional) Pick point or enter X, Y, [Z]
coordinates for the last point.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.33 Text Curves

Create text curves from keyed-in text.  The outlines of letters are created as a series of
separate curves.

Command Prompts

Enter parameters and text in dialog.

Dialog Box: Text to Create
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Dialog Box: Text to Create

Choose Font

VisualCAD supports over 300 different text fonts.  Select one from the list.

Auto Kerning

Kerning is the process of adjusting the spacing between characters in a
proportional font, usually to achieve a visually pleasing result. Kerning adjusts
the space between individual letter forms, while tracking (letter-spacing)
adjusts spacing uniformly over a range of characters.  In a well-kerned font, the
two-dimensional blank spaces between each pair of characters all have a
visually similar area.

· Use the slider to adjust Kerning or check the box to Auto Kerning.

Other Options

· Bold/Italic  

· Text Size  

· Allow Single Line Font  

Basic Procedure

Screen Action Comments
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Step 1 Font:  font style, size, bold,
and italic can be specified.

Kerning slider bar: The
spacing between the
characters can be set
between 0 (closest) to 1000
(farthest).

Enter text. 

Step 2 (Optional) Enter X, Y, [Z]
coordinates for the text
start point

Final Top line kerning = 0

Middle line kerning = 250

Bottom line kerning = 500

Notes

1. The text curves will be created on a plane parallel to the Construction Plane.

2. After the text is created, the curves can be independently manipulated. 

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.34 Text on Curve

Create text curves that follow a curve.  The outlines of letters are created as a series of
separate curves.

Command Prompts
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Enter parameters and text in dialog.

Dialog Box: Text to Create

Text to Create (on Curve)

Choose Font

VisualCAD® supports over 300 different text fonts.  Select one from the list.

Auto Kerning

Kerning is the process of adjusting the spacing between characters in a
proportional font, usually to achieve a visually pleasing result. Kerning adjusts
the space between individual letter forms, while tracking (letter-spacing)
adjusts spacing uniformly over a range of characters.  In a well-kerned font, the
two-dimensional blank spaces between each pair of characters all have a
visually similar area.

· Use the slider to adjust Kerning or check the box to Auto Kerning.

Other Options



The Ribbon Bar 237

© 2025 Mecsoft Corporation

· Bold/Italic  

· Text Size  

· Allow Single Line Font  

· Text Justification  

· Text Size  

· Text Spacing  

· Text Orientation  

Basic Procedure

Screen Activity Comments

Step 1

Text to Create (on Curve)

See Dialog Box: Text to
Create below.

Font:  font style, size, bold,
and italic can be specified.

Kerning slider: The spacing
between the characters can
be set between 0 (closest)
to 1000 (farthest).

Enter text.

Step 2
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Final

Notes

1. The text curves will be created along the curve in oriented to the current view.

2. After the text is created, the curves can be independently manipulated. 

3. The text to appear is typed into the box.  It will appear in the box in the selected
font, bold, and italic applied.  Changes in size do not appear in the text in the box
but do take effect when the text is actually created.

4. Hanging text has the top of the letters on the curve; whereas, the default is the
bottom of the letters are on the curve.

5. Flip text flips each individual letter while keeping the sequence of letters the
same.

6. The plane of the text is the viewing plane of the currently selected view.  It
doesn’t have to be a construction plane.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.35 Curve, Spiral

Create a spiral curve in a plane.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Enter the number of revolutions of the spiral.
The Prompt shows the default.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
center point.

Step 3 (Optional) Enter the radius.

or...

(Optional) Enter X, Y, [Z] coordinates for the
second point which determines the radius.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.36 Curve, Helix

Create a helix curve.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Enter the number of revolutions of the helix.
The Prompt shows the default.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
center point.

Step 3 (Optional) Enter X, Y, [Z] coordinates for the
second point which determines the axis and
height of the helix.

Step 4 (Optional) Enter the radius.

or...

(Optional) Enter X, Y, [Z] coordinates for the
third point which determines the radius of
the helix.
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Final

 

Notes

1. Intermediate geometry is discarded and only the helix is retained.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.37 Curve, Flat Area

Create a curve(s) forming the boundary of a flat-area region.  The region could be a face of a
mesh or a plane.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none
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Final

Notes

1. If there are holes in the area, multiple curves will be made, one for the outer
boundary, and one curve each for the inner boundary of the holes.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.38 Curve, All Flat Areas

Create a set of curves enclosing flat-area regions.  All flat regions parallel to the construction
plane will generate curves including surfaces on multiple meshes. 

Command Prompts

Click on the function 'All Flat Areas'

Basic Procedure

Screen Pick Command Input

Select
Function

none

Final
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Notes

1. Each of the generated curves is independent after it is created.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.39 Silhouette Curves

Creates a 2D curve that represents the boundaries of the part for all selected solids and
surface geometries on the screen.  The curves will be independent once created and will be

parallel to the active construction.

Reminder: You might want to set a new Layer as the destination for the newly created
curves.

Command Prompts

Basic Procedure

Screen Entry Command Input

Step 1 Select Surfaces by
single pick or
rectangular
selection.

Hit the ENTER key
when done.
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Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.40 Curve, Surface Boundary

Create a single curve from the outer boundary of a surface.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Final

Related Topics
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Curves Pane, Curve Modeling Ribbon Bar

5.4.1.41 Curve, Bounding Rect.

Create a rectangular curve that is derived from a volumetric box that surrounds selected
geometry objects.

The volumetric box and rectangle are oriented to either the Construction Plane or the World
Coordinate System (your choice). The bounding rectangle will then be created at the top, middle,
or bottom of that volumetric box (your choice).

Command Prompts

Basic Procedure

Screen Pick or Screen Results Command Input

Step 1

Select all objects to be included in the
volumetric box.  Hit ENTER to end the

selection.

Step 2

C

Enter 'C' or 'W'.

'C' orients the volumetric box
to the Construction Plane.
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W

'W' orients the volumetric box
to the World Coordinate
System.

Step 3 Enter X and Y offsets.  These are
incremental offsets that will
enlarge the volumetric box in the
X and Y directions respectively. 
Negative values are not allowed.

Step 4

T

 M

B

Enter 'T', 'M', or 'B'.

'T' creates the rectangle at the
top of the volumetric box.

'M' creates the rectangle at the
middle of the volumetric
box.

'B' creates the rectangle at the
bottom of the volumetric
box.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.42 Section Curves

Creates cross-section curves through all solids, surface and mesh geometries on the screen. 
The curves will be independent once created.

Reminder: You might want to set a new Layer as the destination for the newly created
curves.

Basic Procedure
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Screen Entry Command Input

Step 1

Adjust the Bounding Box slider to raise or lower the
cutting plane (dynamically shown on the models). 
When the cutting plane is positioned correctly, hit
OK on the dialog to create the curves.

or...

...Pick a point on the model to determine where the
cutting plane is positioned.

(Optional) Enter X, Y,
and Z values that
define the point of
the cutting plane.

Hit the ENTER key
when done.

Final

   

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.1.43 Extract Curve

Creates (extracts) a curve from a surface edge.  The curve will be independent of the surface
once created.

Reminder: You might want to set a new Layer as the destination for the newly created
curves.

Command Prompts
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Extract curve from face edge:: Select face edge(s) and hit Right Mouse Button/Enter
when done

Basic Procedure

Screen Entry Command Input

Step 1 Select the surface edge to create a curve from.  You
can pre-select the surface edge before executing
this command.

Right-click or press
<ENTER> when done.

Final

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.2 Edit Curves

The Curve Modeling Ribbon Bar contains the following Edit Curves pane with associated functions.

Curve Modeling Ribbon Bar
Edit Curves Pane

Related Topics
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Fillet 2 Curves

Create Offset Curves

Trim a Curve

Extend Curve

Merge Curves

Curve Boolean

Split by Curve

Close Curve

Change Curve Start Point

Chamfer Curves

Extend Curve by Distance

Reverse Curve Direction

Automatically Fillet Curves of a Polyline

Fit an Arc to a Polyline

Smooth a Curve

Project Curves to a C-Plane

Create a Curve Chain

Split Curves

Break Curves at Sharp Corners

Explode Curves

Reduce a Curve

Wrap a Curve onto a Cylinder

Curve Modeling Ribbon Bar

5.4.2.1 Fillet

Create a tangent arc blend (fillet) at the intersection of two curves.  The radius of the
fillet is user specified.  Zero radius fillets can be created with this command by entering 0
as the fillet radius.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Enter the radius of the desired
corner fillet.

Step 2

Step 3

Final

Notes

1. If necessary, the ends of the target curves will be trimmed back to meet the ends
of the fillet arc.

2. Curve ends will not be extended to meet the intended fillet arc.  If the ends are
too short, the fillet will not be created.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar
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5.4.2.2 Offset

Create a new curve that is offset from a selected curve.  The curve may be open or closed.
 Corners may be rounded or sharp.

Command Prompts

1. Offset:: Select convex corner type [r - rounded; s - sharp] or Pick curve to
offset [convex corners will be rounded]

2. Pick curve to offset

3. Enter offset distance [D=1.000000]

Basic Procedure

Screen Pick Command Input

Step 1 Select convex corner type [r - rounded; s - sharp] or
Pick curve to offset [convex corners will be
rounded]

Step 2

Step 3 Use the cursor to indicate the
offset side and offset distance.

(Optional) Enter the offset distance.

Note: Negative offset distances are not allowed. 
To offset toward the inside, position the cursor
inside the curve and enter a positive offset
distance.

Final

Notes

1. The existing curve may be pre-selected.
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2. Sharp, outside corners in the original curve will result in radius offset corners in
the new curve.

An example of offsetting on the inside of the curve using the cursor pick position.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.3 Trim

Modify a curve by trimming away part of it.  The curve can be trimmed in the following
two cases:

1. Between its end point and an intersection with another curve, or

2. Between two intersections with other curves.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

1   or 2

none

Final

1  or 2
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Notes

1. Where you select the curve also selects the segment to be trimmed away.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.4 Extend

Extend a curve along its tangency to its nearest intersection with another geometry
object.

The curve is extended only on the end where it is picked.  To extend the other end, the
EXTEND function must be used again by picking the other end.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Final

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.5 Merge

Convert two or more curves into one curve.  The adjacent endpoints must be within
VisualCAD tolerance.  See Note 1 below.
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Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Step 2

Final

Notes

1. To set the system tolerance for curve hookup, go to: Home > Options > Tolerance
and Units > Curve Hookup Tolerance.

2. If curves do not merge as expected, check to see if their end point proximity
exceeds the system hookup tolerance.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar
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5.4.2.6 Change Start

Move the start/end position on a closed curve.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Final

Notes

1. This function has no effect on open curves.

2. To show curve start point, go to Home > Options > Display > Curve Display Style.
Check the box Display Curve / Region Start Point.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.7 Boolean

Use this command to perform boolean operations on selected curves.  The curves must
intersect each other and lie on the construction plane.  Also be sure to read the notes
section below.

Command Prompts

Boolean:: Pick curves to boolean and hit Right Mouse Button/Enter when done.

Boolean:: Pick point or enter coordinates x,y and z.
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Basic Procedure

Screen Pick Command Input

Step 1

Select the curves to boolean and hit
Right Mouse Button/Enter when

done.

Step 2 Make desired selections from the
Curve Boolean options dialog.

(see below)

Final Delete input curves: All

Combine Regions: Yes

Output: Curves

Curve Boolean Options Dialog
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Corve Booleam Dialog

Delete input curves

· None:  Do not delete the input curves.

· Used:  Delete only the affected input curves.  Leave all other selected curves
intact.

· All:  Delete ALL selected input curves, even those that are unaffected by the
operation.

Combine regions

· Yes:  Merge all affected curves into one curve region.

· No:  Do not merge the affected curves.

Output

· Curves:  The resulting regions should be curves.

· Surfaces:  The resulting regions should be planar surfaces.

Notes

1. All selected curves must be planar and lie on the construction plane.

2. Experiment with each dialog option until you understand the expected results.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar
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5.4.2.8 Split by Curve

Split a curve(s) by another curve.  If the curves to split are nested, you can choose to
honor the nest (Y) or not (N). 

Command Prompts

Split:: Pick Splitting curve

Split:: Pick curves to split. Hit Right Mouse Button/Enter when done.

Split:: Honor Nesting option(Y/N)?

Split:: Done

Basic Procedure

Screen Pick / Command Input

Geometry
to split

Step 1

Split:: Pick Splitting curve

Step 2

Split:: Pick curves to split. Hit Right Mouse Button/Enter when done.
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Step 3

Split:: Honor Nesting option(Y/N)? Y (Results)

Split:: Honor Nesting option(Y/N)? Y (Results separated)

Split:: Honor Nesting option(Y/N)? N (Results)

Split:: Honor Nesting option(Y/N)? N (Results separated)

Related Topics

Curves Pane, Curve Modeling Ribbon Bar
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5.4.2.9 Close Curve

Use this command to close a curve by automatically connecting its endpoints. Note that
this command will not close multiple curves. There needs to be a single curve and
multiple curves that have been merged into a single curve. Also Note: You can use the
Merge Curve command to close multiple curves as long as the Curve Hookup Tolerance is

larger than the gap you are attempting to close. You can find the Curve Hookup Tolerance
parameter on the Tols. & Units tab of the VisualCAD Options dialog.  

Command Prompts

Close:: Pick curve to close and Hit Right Mouse Button/Enter when done.

Basic Procedure

Screen Pick / Command Input

Curve to
Close

Step 1

Final

Close:: Pick curve to close and Hit Right Mouse Button/Enter
when done.

Related Topics

Curves Pane, Curve Modeling Ribbon Bar

5.4.2.10 Chamfer

Create a chamfer at the intersection of two curves.  The length of the chamfer is user
specified.
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Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Enter the length of the desired
chamfer.

Step 2

  

Step 3

  

Final

Notes

1. If necessary, the ends of the target curves will be trimmed back to meet the ends
of the chamfer line.

2. Curve ends will not be extended to meet the intended chamfer.  If the ends are
too far apart, the chamfer will not be created.
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Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.11 Extend by Dist

Extend a curve along its tangency by the specified distance.  The curve is extended only on
the end where it is picked.  To extend the other end, the EXTEND function must be used

again by picking the other end.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Enter extension distance

Final

Notes

1. This command can be used with arcs, polylines, poly-curves and Nurbs curve.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar
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5.4.2.12 Reverse

Reverse the definition direction of curves.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Final

Notes

1. To show curve direction arrow: Home > Options > Display > Curve Display Style.
Check the box Display Curve / Region Direction Arrow.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.13 Auto Fillet

Rounds the corners of Polycurves and Polylines with arcs of a specified radius at the
intersection of two curves.

Command Prompts
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Basic Procedure

 Screen Pick Command Input

Step 1 Enter the radius of the desired corner fillet.

Step 2

Final

Notes

1. The prompt displays the filleted corner count.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.14 Arc Fit

Fit arcs to a polyline.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Enter the fillet radius and press
enter.

Step 2

Final

Notes

1. The properties dialog is displayed to show the geometry type as polyline before
arc fit and as a curve after the arc fit command is executed.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.15 Smooth

Modify a curve to smooth sharp corners.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1

Step 2 Enter the smoothing tolerance.  A
smaller number produces greater
smoothing.

Final

Notes

1. Curves may be pre-selected.

2. Highly smoothed curves will contain many underlying segments.  This increases
computation when these curves are used in calculations.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.16 Project to CPlane

Projects the selected curves to active construction plane. Split an existing curve into
two segments at the pick point.

Command Prompts
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Basic Procedure

 Screen Pick Command Input

Step 1 Pick curves to be projected with left
mouse click selection or dragging a
window with left mouse hold.

none

Final Hit right mouse button or hit Enter on
keyboard to accept selection.

Selected geometry is now projected to
the C-Plane coordinate.
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Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.17 Chain

Create a single curve out of multiple curves that form a closed loop.  You can automatically
select a chain of curves or edges using the <Shift> key while selecting.  The curve chain does

not have to be created using this command.  See Chain Select for more information.

Command Prompts

Basic Procedure

 Screen Pick Command Input
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Step 1

Select any one curve of a set of
curves that form a closed region.

none

Final

Notes

1. To show curve direction arrow and start point: Home > Options > Display > Curve
Display Style. Check the box Display Curve / Region Direction Arrow and Display
Curve / Region Start Point.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

Chain Select 

5.4.2.18 Split

Split an existing curve into two segments at the pick point.

Command Prompts
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Basic Procedure

 Screen Pick Command Input

Step 1

none

Step 2 Move the cursor to determine the
split position.  Left click causes
split.

Final

Notes

1. If the curve is pre-selected, the function will begin at Step 2 above.

2. If the curve is not pre-selected, then the pick point becomes the split point.

3. If the curve is picked very near a sharp corner, the split will be at the corner.

To create breaks in curves at multiple corners that have a given
angle size, see the Break command.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.19 Break

Break a curve into segments at its sharp corners, where the corners are equal or less than a
user-entered angle value.
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Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

Step 2 Enter the angle where breaks
should occur.

Final

Notes

1. Curves may be pre-selected.

2. Tip: If you wish to break a curve at selected corners and are not concerned about
the corner angle, then use the Curve Modeling > Edit Curves > Split command to
directly select a corner of the curve where you want the curve break to occur.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar
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5.4.2.20 Explode

Convert one curve into multiple curve segments.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Final Gaps are magnified to show
separation into independent
curves.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.21 Reduce

Modify a curve by reducing the number of underlying segments which make up the curve.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1

Step 2 Enter the reduction tolerance.  A
larger number produces fewer
underlying curves.

Final

Notes

1. Curves may be pre-selected.

2. This function will improve the speed of computation for curves that have had
their underlying segments reduced.

3. Reducing the number of underlying segments of a curve will result in less
accurate calculations with that curve.

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar

5.4.2.22 Wrap

Wrap curves onto a construction cylinder whose center-line is aligned with one of the
principle axes of the CPlane.

Dialog Box: Wrap Curve on a Cylinder
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Dialog Box: Wrap Curve on a Cylinder

· Number of curves picked  
The number of curves selected is displayed.  Select the Pick Curves button to add
more curves to the selection.

· Wrap Cylinder Axis  
Select X, Y or Z to determine the cylinder axis.

· Wrap Cylinder Size  
Select Radius, Diameter or Circumference to determine the size of the cylinder
to wrap the selected curves on.  Then enter the appropriate value or select the
Pick Size button to select two points to set the size value.

· Seam Start Angle  
Specify the start angle for the seam of the cylinder according to the right-hand
rule (counter-clockwise).

Basic Procedure

Dialog Interaction
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Initial

Step 1 Select the Pick Curves button and pick the curves to be wrapped.  The curves
may be pre-selected.

Step 2 Select one of the C-Plane axes that is used as the construction cylinder's axis.

Step 3 Choose the method to input the size of the construction cylinder.

Step 4 Enter the dimension size of the construction cylinder.  You may pick a geometry
object to determine that size.

Step 5 Enter the start angle on the cylinder where wrapping will begin.

Step 6 Hit the OK button

Final

  

Notes

1. The curves to be wrapped must be co-planar and parallel to the CPlane.

2. The curves will be wrapped in a positive direction around the construction
cylinder according to the right-hand rule (counter-clockwise).

Related Topics

Edit Curves Pane, Curve Modeling Ribbon Bar
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5.5 Surface Modeling

The Surface Modeling Ribbon Bar contains Surfaces and Edit Surfaces panes and associated
functions.

The Surface Modeling Ribbon Bar

Surface Modeling Ribbon Bar

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

Edit Surfaces Pane, Surface Modeling Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.5.1 Surfaces

The Surface Modeling Ribbon Bar contains the following Surfaces pane with associated functions.

Surface Modeling Ribbon Bar
Surfaces Pane

Related Topics

Create a Rectangular Plane

Create a Plane from Curves

Create a Surface from 4 Curves

Create a Surface from 2 Planar Curves

Create an Extruded Surface

Create a Revolved Surface
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Create a Surface from 4 Points

Create a Parting Line Surface

Surface Modeling Ribbon Bar

5.5.1.1 Rectangular Plane

Create a rectangular plane parallel to the Construction Plane.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z]
coordinates for the first point.

Note: This point will determine a
level (parallel to the Construction
Plane), on which the final
rectangular plane will be created.

Step 2 (Optional) Enter X, Y, [Z]
coordinates for the second point.

Note: This point will be projected
onto the parallel level of the first
point.

Final
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Notes

1. The created plane will be parallel to the Construction Plane and through the first
point.
Coordinate entry can be in absolute coordinates or in relative coordinates.
An example of absolute coordinate is shown above.

Example of coordinate entry Input for relative coordinates.

a) Pick first point or enter coordinates x,y and Z: 2,0

b) Pick second point or enter coordinates x,y and Z: R6,4

2. For the second point, the coordinate input can also be entered as @6,4
This creates a rectangular plane that is 6 units in length and 4 units in width from
2,0 to 8,4 in X Y coordinates.

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.1.2 Plane from Curves

Create a plane from curves (or surface edges) that define a closed region.  Internal
closed regions may also be selected to create voids or holes in the plane.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none
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Final

Notes

1. If the curves (or surface edges) are pre-selected, the plane will automatically be
created from those curves.

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.1.3 Surface by 4

Create a surface from four chain curves (or surface edges) that form a closed region.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none
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Final

Notes

1. The curves (or surface edges) may be pre-selected.

2. The curves (or surface edges) do not need to be co-planar.

3. The endpoints of adjacent curves (or surface edges) must be within the hookup
tolerance.  See Home > Options > Tolerance and Units > Curve Hookup
Tolerances.

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.1.4 Surface by 2

Create a surface between two planar curves (or surface edges).

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 none
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Pick two planar curves (or surface
edges).

Final

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.1.5 Surface of Extrusion

Create a surface by extruding a curve (or surface edge).  Multiple curves (or surface
edges) may be selected, which will create multiple surfaces.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

Hit right mouse button when done.
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Step 2 (Optional) Enter an extrusion
distance.

Final

Notes

1. The curves (or surface edges) may be pre-selected.

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.1.6 Surface of Revolution

Create a surface by revolving a curve (or surface edge) around an axis.  Start and end
angles may be entered according to the right-hand rule of positive rotation, as
determined by the direction that the axis line is defined.

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1

The curves (or surface edges) may be
pre-selected.

Step 2 (Optional) Enter X, Y, [Z]
coordinates for the first point
(start of axis line).

Step 3 (Optional) Enter X, Y, [Z]
coordinates for the second point
(end of axis line).

Step 4 Enter the start angle of revolution
(according to the right-hand rule
of positive rotation).

Step 5 Enter the end angle of revolution.

Final

  

Notes

1. The direction of definition of the axis line is important because it determines the
right-hand rule of positive rotation for the start and end angles of the revolved
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surface.

2. The curve's (or surfaces edge's) existing position defines the zero degree
position for angles.
Here is an example doing a partial rotation from 20 to 100 degrees.

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.1.7 Bi-linear Surface from 4 Points

Create a surface by specifying four corner points.

Command Prompts

Basic Procedure

Screen Pick Command Input

Steps 1-4 (Optional) Enter X, Y, [Z]
coordinates for any of the points 1-
4.
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Final

Notes

1. Pre-selected points are not allowed.

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.1.8 Parting Plane

Create a parting plane positioned relative to a volumetric box around selected
surfaces or meshes.  VisualCAD creates a volumetric box around the surfaces

and/or meshes.  The box is oriented to either the Construction Plane of the World Coordinate
System (your choice). The parting plane will then be created at the top, middle, or bottom of that
volumetric box (your choice).

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1

Step 2 Enter 'C' or 'W'.

'C' orients the parting plane
parallel to the Construction
Plane.

'W' orients the parting plane
parallel to the World
Coordinate System.

Step 3 Enter X and Y offsets into the
Command Input Bar.  These are
incremental offsets that will
enlarge the parting plane in the X
and Y directions respectively. 
Negative values are not allowed.

Step 4

T   

M   

Enter 'T', 'M', or 'B'.

'T' creates the parting plane at
the top of the volumetric
box.

'M' creates the parting plane at
the middle of the
volumetric box.

'B' creates the parting plane at
the bottom of the
volumetric box.
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B  

Related Topics

Surfaces Pane, Surface Modeling Ribbon Bar

5.5.2 Edit Surfaces

The Surface Modeling Ribbon Bar contains the following Edit Surfaces pane with associated
functions.

Surface Modeling Ribbon Bar
Edit Surfaces Pane

Related Topics

Trim Surfaces with Curves

Delete Holes from Surfaces

Project Curves onto a Surface

Reverse Surface Normals

Wrap a Surface

5.5.2.1 Trim

Trim away sections of surfaces by selecting closed curves that bound those sections.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1

 None

Step 2

Final

Notes

1. When you pick the surface to be trimmed, select the piece of the surface that
you want trimmed away.  The pick point determines which surface region is
trimmed away.

Related Topics

Edit Surfaces Pane, Surface Modeling Ribbon Bar
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5.5.2.2 Delete Holes

This function will remove holes from a surface.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Select the edges of the holes that you
want removed. 

None

Step 2 When the selection is complete, hit the
Right-Mouse Button or Enter to remove
the holes.

Notes

1. This function will not remove holes in mesh surfaces.

Related Topics

Edit Surfaces Pane, Surface Modeling Ribbon Bar
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5.5.2.3 Project Curves

Project curves along the surface normals onto a surface.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Step 2

Final

Notes
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1. Meshes are not allowed as the projection surface.

Related Topics

Edit Surfaces Pane, Surface Modeling Ribbon Bar

5.5.2.4 Reverse Normals

This function will reverse the normal vectors for each surface selected.

Command Prompts

Basic Procedure

Screen Pick Command Input

Initial

None

Step 1
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Final

Related Topics

Edit Surfaces Pane, Surface Modeling Ribbon Bar

5.5.2.5 Wrap

Wraps a surface onto a construction cylinder whose center line is aligned with one of
the principle axes of the CPlane.

Dialog Box: Edit Surface Wrap
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Dialog Box: Edit Surface Wrap

· Number of objects picked  
The number of curves selected is displayed.  Select the Pick Curves button to add
more curves to the selection.

· Cylinder Circumference  
Enter a circumference for the wrapped cylinder.

· Unwrap  
Check this box to unwrap the selected surface.

· Cylinder Base Point  
Enter the Cylinder Base Point XYZ coordinates or select the Pick Base Point
button and then select a point to locate the base of the cylinder.

· Cylinder Axis Vector  
Enter the Cylinder Axis Vector XYZ coordinates or select the Pick Axis Vector
button and then select a start point and end point to define the axis.
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· Upper point  
Enter the Cylinder Upper Point XYZ coordinates or select the Pick Upper Point
button and then select a point to locate the upper point of the cylinder.

Basic Procedure

 Dialog Interaction

Step 1 Select the Pick Objects button and pick the surface to be wrapped.  The surface
may be pre-selected.

Step 2 Specify the cylinder circumference.

Step 3 Select one of the C-Plane axes that is used as the construction cylinder's axis.

Step 4 Set the cylinder base point

Step 5 Set the cylinder upper point

Step 6 Hit the OK button

Notes

1. The surface to be wrapped must be co-planar and parallel to the C-Plane.

2. The surface will be wrapped in a positive direction around the construction
cylinder according to the right-hand rule (counter-clockwise).

Related Topics

Edit Surfaces Pane, Surface Modeling Ribbon Bar

5.6 Solid Modeling

The Solid Modeling Ribbon Bar contains Solid Modeling and Edit Solids panes and associated
functions.

The Solid Modeling Ribbon Bar

Solid Modeling Ribbon Bar
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Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

Edit Solids Pane, Solid Modeling Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.6.1 Solid Modeling

The Solid Modeling Ribbon Bar contains the following Solid Modeling pane with associated
functions.  See What is a Solid? for information about Meshes and Solids in VisualCAD.

Surface Modeling Ribbon Bar
Solid Modeling Pane

Related Topics

What is a Solid?

Create a Solid Box

Create a Solid Sphere

Create a Solid Cylinder

Create a Solid Cone

Create a Solid Torus

Create an Extruded Solid

Create a Revolved Solid

Create a Solid Rectangular Tube

Create a Solid Circular Tube

Create a Solid Bounding Box

Solid Modeling Ribbon Bar
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5.6.1.1 Solid Box

Create a Mesh Solid in the shape of a rectangular box.  See What is a Solid? for
information about Meshes and Solids in VisualCAD.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates
for the first point.

Step 2 (Optional) Enter X, Y, [Z] coordinates
for the second point (opposite corner).
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Step 3 (Optional) Enter X, Y, [Z] coordinates
for the extrusion Length.

or...

(Optional) Enter the Length.

Final

Notes

1. The bottom of the box will lie in a base plane (parallel to the Construction Plane
of the active view) with its corner at the first point defined.

2. If the second point does not lie on the base plane, it will be projected onto that
base plane.

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.2 Solid Sphere

Create a solid in the shape of a sphere.  See What is a Solid? for information about
Meshes and Solids in VisualCAD.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates
for the first point (center).

Step 2 (Optional) Enter X, Y, [Z] coordinates
for the second point (radius point).

or...

(Optional) Enter the radius.

Final

Notes

1. In Step 2, if a single number is entered, it will be interpreted as the radius.  If 2 or
3 numbers are entered, they will be interpreted as the coordinates of the radius
point.

Related Topics
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Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.3 Solid Cylinder

Create a solid in the shape of a cylinder.  See What is a Solid? for information about
Meshes and Solids in VisualCAD.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for
the first point (center).

Step 2 (Optional) Enter X, Y, [Z] coordinates for
the second point (radius point).

or...

(Optional) Enter the radius.
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Step 3 (Optional) Enter X, Y, Z coordinates for the
third point (height).

or...

(Optional) Enter the height.

Final

Notes

1. The axis of the cylinder will be normal (perpendicular) to the Construction Plane.

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.4 Solid Cone

Create a mesh that is the shape of a cone.  See What is a Solid? for information about
Meshes and Solids in VisualCAD.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates
for the first point (center).

Step 2 (Optional) Enter X, Y, [Z] coordinates
for the second point (radius point).

or...

(Optional) Enter the radius.

Step 3 (Optional) Enter X, Y, Z coordinates for
the third point (height).

or...

(Optional) Enter the height.
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Final

Notes

1. The base plane for the cone will be parallel to the Construction Plane of the
active view when the second point (radius point) is defined.

2. The axis of the cone will be normal (perpendicular) to the base plane.

3. The height of the cone is measured from the base along the axis of the cone.

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.5 Solid Torus

Create a mesh that is the shape of a ring torus.  See What is a Solid? for information about
Meshes and Solids in VisualCAD.

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point (hole center).

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (center-line radius point).

or...

(Optional) Enter the radius.

Step 3 (Optional) Enter the radius of the tube
section (tube radius or outer diameter point).

or...

(Optional) Enter X, Y, [Z] coordinates for the
third point on the surface (tube radius or
outer diameter point).

Final

Notes

1. The plane of the circular center line of the torus will be parallel to the
Construction Plane of the active view when the second point (center line radius
point) is defined.

Related Topics
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Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.6 Solid Extrusion

Create a solid by extruding a closed curve (or surface edge) set.  See What is a Solid? for
information about Meshes and Solids in VisualCAD.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1

none

Step 2 (Optional) Enter the extrusion distance.

or..

(Optional) Enter X, Y, Z coordinates for the
extrusion distance point.
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Step Final

Notes

1. The curve (or surface edge) set may be pre-selected.

2. If the curve (or surface edge) set is not coplanar, each curve (or surface edge) is
projected onto the Construction Plane.

3. The extrusion is performed normal to the Construction Plane.

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.7 Solid Revolve

Create a solid by revolving a closed curve (or surface edge) around an axis.  See What is a
Solid? for information about Meshes and Solids in VisualCAD.

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1

none

Step 2

Step 3

Final

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.8 Solid Rectangular Tube

Create a solid that is the shape of a rectangular tube with constant wall
thickness.  See What is a Solid? for information about Meshes and Solids in

VisualCAD.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (opposite corner).

Step 3 (Optional) Enter X, Y, Z coordinates for the
third point (wall thickness).

or...

(Optional) Enter the wall thickness.

Step 4 (Optional) Enter X, Y, Z coordinates for the
fourth point (height).

or...

(Optional) Enter the extrusion distance.
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Final

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.9 Solid Circular Tube

Create a solid that is the shape of a circular tube (pipe).  See What is a Solid? for
information about Meshes and Solids in VisualCAD.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point (hole center).

Step 2 (Optional) Enter the first radius of the tube.

or...

(Optional) Enter X, Y, [Z] coordinates for the
second point (first radius point).
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Step 3 (Optional) Enter the other radius of the tube.

or...

(Optional) Enter X, Y, [Z] coordinates for the
third point (other radius point).

Step 4 (Optional) Enter X, Y, Z coordinates for the
fourth point (height).

or...

(Optional) Enter the extrusion distance.

Final

Notes

1. The base plane for the circular tube will be parallel to the Construction Plane of
the active view when the second point (radius point) is defined.

2. The axis of the circular tube will be normal (perpendicular) to the base plane.

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.1.10 Solid Bounding Box

Create a rectangular box solid that encompasses selected geometry objects. 
See What is a Solid? for information about Meshes and Solids in VisualCAD.
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Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Select all objects to be included
in the volumetric box.  Hit Right
Mouse Button or ENTER to end
the selection.

Step 2 Enter 'C' or 'W'.

'C' orients the volumetric box to the
Construction Plane.

'W' orients the volumetric box to the
World Coordinate System. 

Step 3 Enter X, Y and Z offsets.  These are
incremental offsets that will enlarge the
volumetric box in the X, Y and Z
directions respectively.  Negative values
are not allowed.

Final
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Notes

1. All geometry types are permitted.

Related Topics

Solid Modeling Pane, Solid Modeling Ribbon Bar

5.6.2 Edit Solids

The Solid Modeling Ribbon Bar contains the following Edit Solids pane with associated functions. 
See What is a Solid? for information about Meshes and Solids in VisualCAD.

Related Topics

What is a Solid?

Unify Surface Normals

Explode Surfaces

Stitch Surfaces into a Solid

Solid Modeling Ribbon Bar

5.6.2.1 Unify Normals

For a set of surfaces that are adjacent and share edges, this function will make
all surface normals consistent in direction, relative to the other surfaces.

Command Prompts

Basic Procedure

Screen Pick Command Input
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Initial

none

Step 1

Final

Related Topics

Edit Solids Pane, Solid Modeling Ribbon Bar

5.6.2.2 Explode

This function will separate all the surfaces of a shell or poly-surface into independent
surfaces with no topological relationships to each other.

Command Prompts

Basic Procedure
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Screen Pick Command Input

Initial

none

Step 1 Select poly-surface part.

Final After Explode, each surface is
independent from others.

Notes

1. Meshes are not allowed for the Explode function.

Related Topics

Edit Solids Pane, Solid Modeling Ribbon Bar

5.6.2.3 Stitch

This function will join selected surfaces to form a shell or poly-surface.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Initial

none

Step 1 Select surface(s) part. You can either
use single select and pick individual
surfaces or draw a window to select
all surfaces.

Selected surface(s) are now
highlighted.

Final After Stitch, selected surfaces are
merged to shell or poly-surface.



The Ribbon Bar 315

© 2025 Mecsoft Corporation

.

Notes

1. Meshes are not allowed for the Stitch function.

Related Topics

Edit Solids Pane, Solid Modeling Ribbon Bar

5.7 Mesh Modeling

The Mesh Modeling Ribbon Bar contains Meshes and Edit Meshes panes and associated functions.

The Mesh Modeling Ribbon Bar

Mesh Modeling Ribbon Bar

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

Edit Meshes Pane, Mesh Modeling Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options
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5.7.1 Meshes

The Mesh Modeling Ribbon Bar contains the following Meshes pane with associated functions.

Mesh Modeling Ribbon Bar
Meshes Pane

Related Topics

Create a Mesh Box

Create a Mesh Sphere

Create a Mesh Cylinder

Create a Mesh Cone

Create a Mesh Torus

Create a Rectangular Tube Mesh

Create a Mesh Circular Tube

Create Extruded Mesh

Create a Revolved Mesh

Create a Mesh Bounding Box

Mesh Modeling Ribbon Bar

5.7.1.1 Box

Create a mesh that is the shape of a rectangular box.  The bottom of the box will lie in a
base plane (parallel to the Construction Plane of the selecting view) with its corner at the
first point defined.  If the second point does not lie on the base plane, it will be projected
onto that base plane.  

Basic Procedure

Screen Pick Command Input

Step 1 Pick the first corner of the base
rectangle. 

(Optional) Enter X, Y, Z coordinates for
the first point. 

Example: 0,0,0



The Ribbon Bar 317

© 2025 Mecsoft Corporation

Step 2 Pick the diagonal corner of the
base rectangle. 

(Optional) Enter X, Y, Z coordinates for
the second point (opposite corner).

Example: 1,1,0

Step 3 Pick a point to define the
height of the box.

(Optional) Enter X, Y, Z coordinates for
the third point (height).

Example: 1,1,1

or...

(Optional) Enter the height.

Example: 4.5

Final

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.2 Sphere

Create a mesh that is the shape of a sphere.  In Step 2 (see below), if a single number is
entered, it will be interpreted as the radius.  If 2 or 3 numbers are entered, they will be
interpreted as the coordinates of the radius point.  

Basic Procedure
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Screen Pick Command Input

Step 1 Pick the center point for the
sphere.

(Optional) Enter X, Y, Z coordinates for the
first point (center).

Example: 0,0,0

Step 2 Pick the radius point for the
sphere.

(Optional) Enter X, Y, Z coordinates for the
second point (radius point).

Example: 1,1,0

or...

(Optional) Enter the radius.

Example: 2.25

Final

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.3 Cylinder

Create a mesh that is the shape of a cylinder.  The axis of the cylinder will be normal
(perpendicular) to the Construction Plane.  

Basic Procedure

Screen Pick Command Input

Step 1 Pick the center point of the
base circle.

(Optional) Enter X, Y, [Z] coordinates for
the first point (center).

Example: 0,0,0
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Step 2 Pick the radius point of the
base circle.

(Optional) Enter X, Y, [Z] coordinates for
the second point (radius point).

Example: 1,1,0

or...

(Optional) Enter the radius.

Example: 2.25

Step 3 Pick the length point of the
cylinder.

(Optional) Enter X, Y, [Z] coordinates for
the third point (height).

Example: 1,1,1

or...

(Optional) Enter the height.

Example: 4.5

Final

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.4 Cone

Create a mesh that is the shape of a cone.  The base plane for the cone will be parallel to
the Construction Plane of the active view when the second point (radius point) is
defined.  The axis of the cone will be normal (perpendicular) to the base plane.  The
height of the cone is measured from the base along the axis of the cone.  

Basic Procedure
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Screen Pick Command Input

Step 1 Pick the center point of the
base circle.

(Optional) Enter X, Y, Z coordinates for
the first point (center).

Example: 0,0,0

Step 2 Pick the radius point of the base
circle.

(Optional) Enter X, Y, Z coordinates for
the second point (radius point).

Example: 1,1,0

or...

(Optional) Enter the radius.

Example: 2.25

Step 3 Pick the length point of the
cone.

(Optional) Enter X, Y, Z coordinates for
the third point (height).

Example: 1,1,1

or...

(Optional) Enter the height.

Example: 4.5

Final

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.5 Torus

Create a mesh that is the shape of a ring torus.  The plane of the circular center line of the
torus will be parallel to the Construction Plane of the active view when the second point
(center line radius point) is defined.  
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Basic Procedure

Screen Pick Command Input

Step 1 Pick the center point of
the torus.

(Optional) Enter X, Y, Z coordinates for the
first point (hole center).

Example: 0,0,0

Step 2 Pick the radius point of the
torus.

(Optional) Enter X, Y, Z coordinates for the
second point (center line radius point).

Example: 1,1,0

or...

(Optional) Enter the radius.

Example: 2.25

Step 3 Pick the second radius
(i.e., cross-section radius)
point of the torus.

(Optional) Enter the radius of the tube
section.

Example: 2.25

or...

(Optional) Enter X, Y, Z coordinates for the
third point on the surface (tube radius point).

Example: 1,1,0

Final

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.6 Rectangular Tube

Create a mesh that is the shape of a rectangular tube with constant wall
thickness.
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Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (opposite corner).

Step 3 (Optional) Enter X, Y, [Z] coordinates for the
third point (wall thickness).

or...

(Optional) Enter the wall thickness.

Step 4 (Optional) Enter X, Y, [Z] coordinates for the
fourth point (height).

or...

(Optional) Enter the extrusion distance.

Final
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Create a mesh that is the shape of a rectangular tube with constant wall
thickness.

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point.

Step 2 (Optional) Enter X, Y, [Z] coordinates for the
second point (opposite corner).

Step 3 (Optional) Enter X, Y, [Z] coordinates for the
third point (wall thickness).

or...

(Optional) Enter the wall thickness.

Step 4 (Optional) Enter X, Y, [Z] coordinates for the
fourth point (height).

or...

(Optional) Enter the extrusion distance.
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Final

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.7 Circular Tube

Create a mesh that is the shape of a circular tube (pipe).

Basic Procedure

Screen Pick Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for the
first point (hole center).

Step 2 (Optional) Enter the first radius of the tube.

or...

(Optional) Enter X, Y, [Z] coordinates for the
second point (first radius point).

Step 3 (Optional) Enter the other radius of the tube.

or...

(Optional) Enter X, Y, [Z] coordinates for the
third point (other radius point).
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Step 4 (Optional) Enter X, Y, [Z] coordinates for the
fourth point (height).

or...

(Optional) Enter the extrusion distance.

Final

Notes

1. The base plane for the circular tube will be parallel to the Construction Plane of
the active view when the second point (radius point) is defined.

2. The axis of the circular tube will be normal (perpendicular) to the base plane.

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.8 Extrude

Create a mesh by extruding a closed curve (or surface edge) set.

Basic Procedure

Screen Pick Command Input

Step 1 Pick curves (or surface
edges) to extrude and hit
right mouse when done
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Step 2 (Optional) Enter the extrusion distance.

or..

(Optional) Enter X, Y, [Z] coordinates for
the extrusion distance point.

Final

Notes

1. The curves (or surface edges) may be pre-selected.

2. If the curves (or surface edges) are not coplanar, they are projected onto the
Construction Plane.

3. The extrusion is performed normal to the Construction Plane.

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.9 Revolve

Create a mesh by revolving a closed curve (or surface edge) around an axis.

Basic Procedure

Screen Pick Command Input
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Step 1 Pick curve to revolve

none

Step 2 Pick start point of axis of
revolution  or enter coordinates x,y
and z

Step 3 Pick end point of axis of revolution
 or enter coordinates x,y and z

Final

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar

5.7.1.10 Bounding Box

Create a rectangular box mesh that encompasses selected geometry objects.

Basic Procedure
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Screen Pick Command Input

Step 1 Select all objects to be included
in the volumetric box.  Hit Right
Mouse Button or ENTER to end
the selection.

Step 2 Enter 'C' or 'W'.

'C' orients the volumetric box to the
Construction Plane.

'W' orients the volumetric box to the
World Coordinate System. 

Step 3 Enter X, Y and Z offsets.  These are
incremental offsets that will enlarge the
volumetric box in the X, Y and Z
directions respectively.  Negative values
are not allowed.

Final

Notes

1. All geometry types are permitted.

Related Topics

Meshes Pane, Mesh Modeling Ribbon Bar
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5.7.2 Edit Meshes

The Mesh Modeling Ribbon Bar contains the following Edit Meshes pane with associated
functions.

Related Topics

Unite Two Mesh Solid Bodies

Subtract one Mesh Solid Body from another

Intersect 2 Mesh Solids

Mesh Modeling Ribbon Bar

5.7.2.1 Unite

Unite two mesh objects into one mesh object.  The first mesh object may be pre-
selected.  Unite two or more mesh objects into one mesh object.  The first set of mesh
objects may be pre-selected.  A Mesh Revolve that is open-ended (not a full 360 degrees)
cannot be used in this function.

Meshes Must be Closed:  If any selected mesh does not form
closed volume (i.e., there are any open edges) the Mesh

Boolean operations (i.e., Unite, Subtract or Intersect) will fail.  This
can sometimes occur with imported data files.  If this occurs, use the
Auto Fix command on each mesh before using the Unit, Subtract or
Intersect Mesh commands.  You can also use the Diagnose command
to check for mesh errors.

Basic Procedure

Screen Pick Command Input

Step 1 Pick the first mesh to unite.

none
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Select meshes to unite.

Step 2 Pick the second mesh solid.  The Unite is
performed automatically.

Right-click
or press <Enter> to perform the unite.

Related Topics

Edit Meshes Pane, Mesh Modeling Ribbon Bar

5.7.2.2 Subtract

Subtract one mesh volume from another.  The two mesh objects must intersect.  The first
mesh may be pre-selected.  The second mesh will be deleted after the
subtraction.Subtract one or more mesh volumes from another.  At least one mesh in
each selection must intersect.  The first set of meshes may be pre-selected.  The second

set of meshes will be deleted after the subtraction.  A Mesh Revolve that is open-ended (not a
full 360 degrees) cannot be used in this Subtract function.

Meshes Must be Closed:  If any selected mesh does not form
closed volume (i.e., there are any open edges) the Mesh
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Boolean operations (i.e., Unite, Subtract or Intersect) will fail.  This
can sometimes occur with imported data files.  If this occurs, use the
Auto Fix command on each mesh before using the Unit, Subtract or
Intersect Mesh commands.  You can also use the Diagnose command
to check for mesh errors.

Basic Procedure

Screen Pick Command Input

Step 1 Select the mesh object to subtract
from.Select one or more mesh
objects to subtract from.  Right-
click or press <Enter> when done.

none

Step 2 Select the mesh object to
subtract.Select one or more mesh
objects to subtract.  Right-click or
press <Enter> when done.

Final The Subtract is performed
automatically.
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Related Topics

Edit Meshes Pane, Mesh Modeling Ribbon Bar

5.7.2.3 Intersect

Create a mesh that represents the volume that is shared between two intersecting
meshes.  The first mesh may be pre-selected.  Both of the original meshes will be
deleted after the Intersect function is completed.  Only their shared volume will
remain.Create a mesh that represents the volume that is shared between two or more

intersecting meshes.  The first set of meshes may be pre-selected.  Each of the original meshes
will be deleted after the Intersect function is completed.  Only their one shared volume mesh will
remain.  A Mesh Revolve that is open-ended (not a full 360 degrees) cannot be used in this
Intersect function.

Meshes Must be Closed:  If any selected mesh does not form
closed volume (i.e., there are any open edges) the Mesh

Boolean operations (i.e., Unite, Subtract or Intersect) will fail.  This
can sometimes occur with imported data files.  If this occurs, use the
Auto Fix command on each mesh before using the Unit, Subtract or
Intersect Mesh commands.  You can also use the Diagnose command
to check for mesh errors.

Basic Procedure

Screen Pick Command Input

Step 1 Select the first mesh object to
intersect.

Select the first set of mesh
objects to intersect.  Right-click or
press <Enter> when done.

none

Step 2 Select the second mesh object.
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Select the second set of mesh
objects.  Right-click or press
<Enter> when done.

Final The resulting mesh represents
their shared volume.

Related Topics

Edit Meshes Pane, Mesh Modeling Ribbon Bar

5.8 Dimensions

The Dimensions Ribbon Bar contains Linear Dimensions, Radial Dimensions, Angular Dimensions
and Annotations panes and associated functions.

The Dimensions Ribbon Bar

Dimensions Ribbon Bar

Related Topics

Linear Dimensions Pane, Dimensions Ribbon Bar

Radial Dimensions Pane, Dimensions Ribbon Bar

Angular Dimensions Pane, Dimensions Ribbon Bar
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Annotations Pane, Dimensions Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.8.1 Linear Dimensions

The Dimensions Ribbon Bar contains the following Linear Dimensions
pane with associated functions.

Related Topics

Create a Horizontal Dimension

Create a Vertical Dimension

Create an Oblique Dimension

Dimensions Ribbon Bar

5.8.1.1 Horizontal Dimension

Creates a linear dimension label horizontally.

More Information

Depending on the view, the horizontal will be parallel to different principle axes
(x, y, or z).  The horizontal direction is whichever axis is horizontal when a view is
first started.  For example, the Iso-view has the z-plane as a construction plane
and the horizontal direction is parallel to the x-axis.  Meanwhile, the right-view
has the x-plane as a construction plane with the horizontal direction parallel to
the y-axis.  If the view is rotated, the horizontal stays with the construction
plane.  If the construction plane is modified, then horizontal direction is then
modified.

Two points are selected and they are projected onto a horizontal line.  The
dimension is measured from the separation of these projected points.  In other
words, only the distance along the horizontal direction is measured.

The label can be slid vertically so that its projection line intersects the mouse. 
The picked point determines where the label appears.  The units are included.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Pick the first point or type in the
coordinates into the Command
Input Bar.

None

Step 2 Pick the second point or type in
the coordinates.
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Step 3 Pick a point to determine the
vertical position of the label.

   

Notes

1. Even if the picked points are not at the same level, the points will be projected
down onto a horizontal line.
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2. Here is the result.

Related Topics

Linear Dimensions Pane, Dimensions Ribbon Bar

5.8.1.2 Vertical Dimension

Creates a linear dimension label vertically. 

More Information

Depending on the view, the vertical will be parallel to different principle axes (x,
y, or z).  The vertical direction is whichever axis is vertical when a view is first
started.  For example, the Iso-view has the z-plane as a construction plane and
the vertical direction is parallel to the y-axis.  Meanwhile, the right-view has the
x-plane as a construction plane with the vertical direction parallel to the z-axis.  If
the view is rotated, the vertical stays with the construction plane.  If the
construction plane is modified, then vertical direction is then modified.

Two points are selected and they are projected onto a vertical line.  The
dimension is measured from the separation of these projected points.  In other
words, only the distance along the horizontal direction is measured.

The label can be slid horizontally so that its projection line intersects the mouse.
 The picked point determines where the label appears.  The units are included.

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1 Pick the first point or type in the
coordinates into the Command
Input Bar.

None

Step 2 Pick the second point or type in
the coordinates.

Step 3 Pick a point to determine the
vertical position of the label.

Notes

1. Even if the picked points are not at the same level, the points will be projected
down onto a horizontal line.
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Here is the result.

Related Topics

Linear Dimensions Pane, Dimensions Ribbon Bar

5.8.1.3 Oblique Dimension

Creates a linear dimension label at an angle.  Two points are selected.  The three-
dimensional distance between them is computed and is the number displayed.  The
label can be slid normally (perpendicular) to the line connecting the two points.  The
units are included.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Pick the first point or type in the
coordinates into the Command
Input Bar.

None



VisualCAD 2025 Companion340

© 2025 Mecsoft Corporation

Step 2 Pick the second point or type in
the coordinates.

Step 3 Pick a point to determine the
offset position of the label.

   

Related Topics
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Linear Dimensions Pane, Dimensions Ribbon Bar

5.8.2 Radial Dimensions

The Dimensions Ribbon Bar contains the following Radial Dimensions pane with associated
functions.

Dimensions Ribbon Bar
Radial Dimensions Pane

Related Topics

Create an Arc Circle/Diameter Dimension

Create an Arc Circle/Radius Dimension

Create a 3-Point Circular Diameter Dimension

Create a 3-Point Circular Radius Dimension

Create a 3-Point Arc Diameter Dimension

Create a 3 Point Arc Radius Dimension

Dimensions Ribbon Bar

5.8.2.1 Arc/Circle Diameter

Create a dimension label for an arc.  It measures the diameter of the circle of which the
arc is a part.  The letter ‘D’ appears in the label to show that it is measuring the
diameter.

An arrow specifies which arc is labeled.  The text is always horizontal.  Both are always
in the plane of the arc. Both can be slid around the arc.  The units are included.

Command Prompts

Basic Procedure

Screen Pick Command Input
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Step 1 Pick the arc or circle to dimension. None

Step 2 Select a point to locate the radial dimension.

Related Topics

Radial Dimensions Pane, Dimensions Ribbon Bar

5.8.2.2 Arc/Circle Radius

Create a dimension label for an arc.  It measures the radius of the circle of which the arc
is a part.  The letter ‘R’ appears in the label to show that it is measuring the radius.

An arrow specifies which arc is labeled.  The text is always horizontal.  Both are always
in the plane of the arc. Both can be slid around the arc.  The units are included.

Command Prompts

Basic Procedure
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Screen Pick Command Input

Step 1 Pick the arc or circle to dimension. None

Step 2 Select a point to locate the radial dimension.

Related Topics

Radial Dimensions Pane, Dimensions Ribbon Bar

5.8.2.3 3 Pt Circle Dia

Create a dimension label for a circle.  It measures the diameter of the circle.  The
letter ‘D’ appears in the label to show that it is measuring the diameter.

An arrow specifies which circle is labeled and is always radial.  The text is always horizontal.  Both
are always in the plane of the circle. Both can be slid around the circle.  The units are included. 
Note: You can use points as input to this command.

Command Prompts



VisualCAD 2025 Companion344

© 2025 Mecsoft Corporation

Basic Procedure

Screen Pick Command Input

Step 1 Pick the first point on the circle or type in the
coordinates into the Command Input Bar.

None

Step 2 Pick the second point on the circle or type in
coordinates.

Step 3 Pick the third point on the circle or type in
coordinates.
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Step 4 Pick the endpoint of the arrow which points at the
circle.  This is also where the text appears.

Related Topics

Radial Dimensions Pane, Dimensions Ribbon Bar

5.8.2.4 3 Pt Circle Rad

Create a dimension label for a circle.  It measures the radius of the circle.  The
letter ‘R’ appears in the label to show that it is measuring the radius.

An arrow specifies which circle is labeled and is always radial.  The text is always horizontal.  Both
are always in the plane of the circle. Both can be slid around the circle.  The units are included. 
Note: You can use points as input to this command.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Pick the first point on the circle or type in the
coordinates into the Command Input Bar.

None

Step 2 Pick the second point on the circle or type in
coordinates.

Step 3 Pick the third point on the circle or type in
coordinates.

Step 4 Pick the endpoint of the arrow which points at the
circle.  This is also where the text appears.
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Related Topics

Radial Dimensions Pane, Dimensions Ribbon Bar

5.8.2.5 3 Pt Arc Diameter

Create a dimension label for an arc.  It measures the diameter of the circle of
which the arc is a part.  The letter ‘D’ appears in the label to show that it is

measuring the diameter.

An arrow specifies which arc is labeled.  The text is always horizontal.  Both are always in the
plane of the arc. Both can be slid around the arc.  The units are included.  Note: You can use points
as input to this command.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Pick the arc.  It can be pre-selected. None
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Step 2 Pick the endpoint of the arrow which points at
the arc.  This is also where the text appears.

Related Topics

Radial Dimensions Pane, Dimensions Ribbon Bar

5.8.2.6 3 Pt Arc Radius

Create a dimension label for an arc.  It measures the radius of the circle of which
the arc is a part.  The letter ‘R’ appears in the label to show that it is measuring

the radius.

An arrow specifies which arc is labeled.  The text is always horizontal.  Both are always in the
plane of the arc. Both can be slid around the arc.  The units are included.  Note: You can use points
as input to this command.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Pick the arc.  It can be pre-selected. None

Step 2 Pick the endpoint of the arrow which points at
the arc.  This is also where the text appears.

Related Topics

Radial Dimensions Pane, Dimensions Ribbon Bar
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5.8.3 Angular Dimensions

The Dimensions Ribbon Bar contains the following Angular Dimensions
pane with associated functions.

Related Topics

Create an Angle Dimension

Create a 3 Point Angle Dimension

Dimensions Ribbon Bar

5.8.3.1 Angle

Create a dimension label for the angle between line segments.  The segments do not
have to intersect; they will be extended into lines for the purposes of calculation.

The text is always along the dimension label and centered.  The units are degrees and are
included.

There are four possible arcs.  Pick a point which will define the quarter of the labeling plane and
how far away from the vertex to put the label.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Pick the first line segment.  It can be pre-
selected.

None
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Step 2 Pick the second line segment.

Step 3 Pick the radial distance where the label should
be displayed.  Arrows go along the arc and point
at the two rays.  The label appears on the
outside of the arc.

Notes

1. It is possible to choose an arc not inside the angle that was just made.  For
example, the defined angle was the 63 degree angle, but the supplementary
117 degree angle can also be dimensioned.
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2. It is not necessary for the segments to intersect, the segments will be
extended to intersection for the purpose of calculation.

Related Topics

Angular Dimensions Pane, Dimensions Ribbon Bar

5.8.3.2 3 Pt Angle

Create a dimension label for an arc.  It measures the angle subtended.

An arrow specifies which arc is labeled.  The text is always along the dimension label and
centered.  Both are always in the plane of the arc. Both can be slid radially.  The units are degrees
and are included.

Pick three points, the first of which is the vertex of the arc and two additional points which define
lines going through the vertex point.  There are now four possible arcs, one in each quarter of
these intersecting lines.  Pick another point which defines which quadrant and how far away from
the vertex the label should be.  Note: You can use points as input to this command.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Pick the first point on the arc to dimension or
enter x,y,z coordinates.

None

Step 2 Pick the second point on the arc to dimension or
enter x,y,z coordinates.

Step 3 Enter the dimension point.
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Related Topics

Angular Dimensions Pane, Dimensions Ribbon Bar

5.8.4 Annotations

The Dimensions Ribbon Bar contains the following Annotations
pane with associated functions.

Related Topics

Create a Leader Line Dimension

Create a Text Annotation

Dimensions Ribbon Bar

5.8.4.1 Leader Line

Create a text label with an arrow pointing in a direction.  It can be used to label various
pieces of geometry or other items of interest.

More Information

Type in the text into the Command Input Bar.
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Create a dimension label for the angle between line segments.  The segments do
not have to intersect; they will be extended into lines for the purposes of
calculation.

The text is always along the dimension label and centered.  The units are degrees
and are included.

There are four possible arcs.  Pick a point which will define the quarter of the
labeling plane and how far away from the vertex to put the label.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Pick the point or type in coordinates.  This is
where the head of the arrow should go.  The
arrow is a polyline and so can have multiple
sections at angles.  This can be useful if
having to label something in the middle of a
collection of other items.  The labeling arrow
can bend its way through the collection to
point at the correct item.

None

Step 2 Right-click the mouse to stop adding
segments to the polyline.  The text will
appear at the last point selected.
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Notes

1. Here is an example of a multiple segment polyline leader.

2. Text does not have to be included.  This results in only an arrow.  When asked for
text, start picking the endpoints of the leader.
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Related Topics

Annotations Pane, Dimensions Ribbon Bar

5.8.4.2 Annotation

Create annotation text.  It can be used to put in notes or other information in your
drawing.  The text Font Height can be edited individually for each annotation.  See
Editing Annotation Text Font Height below for more information on how to do this.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Type in the text into the Command Input Bar. None

Step 2 Pick the point or type in coordinates.  This is
where the text will appear.

Editing Annotation Font Text Height

The height of annotation text can be edited individually for each annotation entity. 
Here's how its done:

1. Select the Text Annotation that you wish to edit.

Annotation Text Example

2. Right-click and select Properties.
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Right-click & select Properties

3. From the Properties dialog, change the Use global height value to False.

The Properties dialog

4. Then edit the Font Height.

The Properties dialog

Related Topics
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Annotations Pane, Dimensions Ribbon Bar

5.8.4.3 Dot Annotation

Create graphical dot text at a selected point.  This can be used to identify geometry in
VisualCAD without using a geometric element.  

Command Prompts

Dot annotation:: Enter start point of text

Basic Procedure

Screen Pick Command Input

Step 1 Use the Dot Annotation Input dialog to enter
your Text, Font and Height and then pick OK.

None

Step 2 Select a location in the drawing window to place
the dot annotation.

Related Topics

Annotations Pane, Dimensions Ribbon Bar

Annotation
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5.9 Analyze

The Analyze Ribbon Bar contains Measure and Anal panes and associated functions.

The Analyze Ribbon Bar

Analyze Ribbon Bar

Related Topics

Measure Pane, Analyze Ribbon Bar

Analyze Pane, Analyze Ribbon Bar

The Ribbon Bar

Customize Quick Access Toolbar

Customize Dialog

VisualCAD Options

5.9.1 Measure

The Analyze Ribbon Bar contains the following Measure pane with associated functions.

Related Topics

Measure a Vertex

Measure a Distance

Measure a 3 Vertex Diameter

Measure an Arc Diameter

Measure an Angle

Analyze Ribbon Bar
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5.9.1.1 Vertex

Get the X, Y, Z coordinates of a selected point (vertex).  Move the cursor over a point with
one of the object snaps active. The coordinates of the point are displayed dynamically. 
After you select the point, the coordinates are displayed in the command prompt
window. 

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Pick a vertex point.

Notes

1. Unless a point on an existing object is selected, the picked point will be in the
Construction Plane of the currently selected view.

Related Topics

Measure Pane, Analyze Ribbon Bar

5.9.1.2 Distance

Get the 3D distance between two points.  The point coordinates and the distance
between them are displayed dynamically.  The distance is also displayed in the
command prompt window.

Command Prompts
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Basic Procedure

Screen Pick Command Input

Step 1 Pick first point or enter x,y and z.

Step 2 (Optional) Enter X, Y, [Z]
coordinates for the second point.

Notes

1. The distance is displayed with a letter ‘D’ and the units.  The 3D coordinates of
the two picked points will also be displayed after the distance.

2. Unless points on an existing object are selected, picked points will be in the
construction plane of the currently selected view.

Related Topics

Measure Pane, Analyze Ribbon Bar

5.9.1.3 3 Vertex Diameter

Get the diameter and center coordinates of a temporary arc through three points.  The
coordinates of each of the three points are dynamically displayed.  The calculated
diameter between the three points is also dynamically displayed on the arc as well as in
the command prompt window.  The arc center coordinates are displayed in the

command prompt window.  Note: You can select arcs, Circles or surface edges.
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Command Prompts

(Optional) Enter X, Y, [Z] coordinates for the second point (intermediate point on arc).

(Optional) Enter X, Y, [Z] coordinates for the second point (intermediate point on arc).

(Optional) Enter X, Y, [Z] coordinates for the second point (intermediate point on arc).

Arc Diameter: 10.010000 mm, Center: {-52.656830,50.749151,0.000000}

Basic Procedure

 Screen Pick

Step 1

Step 2

Step 3

Notes

1. The diameter (with units) and center information is from the circle that contains
the temporary arc.
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2. Unless points on an existing object are selected, picked points will be in the
construction plane of the currently selected view.

Related Topics

Measure Pane, Analyze Ribbon Bar

5.9.1.4 Arc Diameter

Get the diameter of an arc or circle.  Pick an arc or circle and the diameter and center will
be displayed in the Prompt Input Bar.  Note: You can select arcs, Circles or surface edges.

Command Prompts

Basic Procedure

Screen Pick Command Input

Step 1 Select an arc or circle.

none

Related Topics

Measure Pane, Analyze Ribbon Bar

5.9.1.5 Angle

Get the angle formed between a vertex point and two other points.  

The coordinates of the points are dynamically displayed along with the included angle.

Command Prompts

Pick first point or enter coordinates x,y and z
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Pick second point or enter coordinates x,y and z

Pick third point or enter coordinates x,y and z

Angle: 48.089217 deg

Basic Procedure

Screen Pick

Step 1

Step 2

Step 3

Notes

1. The resultant angle is always between 0 and 180 degrees.

2. The picked points will be in the Construction Plane of the currently selected
view.

Related Topics

Measure Pane, Analyze Ribbon Bar
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5.9.2 Analyze

The Analyze Ribbon Bar contains the following Analyze pane with associated functions.

Analyze Ribbon Bar
Analyze Pane

Related Topics

Analyze the Part Information

Analyze the Bounding Box

Analyze the Part Center

Show Surface Normals

Analyze Ribbon Bar

5.9.2.1 Part Info.

When this function is selected, all geometry is evaluated and important information is
reported in a dialog, as shown below:

Dialog Box: Part Information
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Part Information dialog box

· Filename  
Shows the saved location of the current part file.  This field will be empty
if the part file has not yet been saved.

· Shells  
Refers to poly-surface geometry objects.

· Faces  
Refers to surface geometry objects.

· Meshes  
Refers to a Box, Sphere, Cylinder, Cone Torus, Rectangular Tube, Circular
Tube, Extrude, and Revolve.

· Curves  
Refers to the number of points, lines, polylines, arcs, circles, and other
curves in the part geometry.

· Faces  
Refers to the number of surfaces in the part geometry.

· Triangles  
Refers to the number of triangles in all mesh geometry.

· Box, Lengths, Center  
This information is the same as described in the Bounding Box function
and Part Center function.

· OK   
Closes the dialog.
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· Help
Brings up the on-line Help.

Related Topics

Analyze Pane, Analyze Ribbon Bar

5.9.2.2 Bounding Box

When this function is selected, VisualCAD will analyze all existing geometry, will
create an internal minimum, volumetric box that contains all that geometry,  and will
return the following information about the box:

· {minimum X, Y, Z} equals the lower left bottom vertex of the box.

· {maximum X, Y, Z} equals the upper right top vertex of the box.

· {lengths along X, Y, Z} of the box.

This information is oriented to the World Coordinate System (WCS).

Command Prompts

Notes

1. Existing geometry is required for the Analyze functions.  If none exists, a
message is returned.

Analyze Bounding Box Message

2. Geometry objects do not need to be selected since the bounding box will
automatically contain all existing objects.

3. All geometry is evaluated, including points, curves, surfaces, meshes, etc.

4. Geometry on all layers, visible or invisible, is contained in the box.

Related Topics

Analyze Pane, Analyze Ribbon Bar
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5.9.2.3 Part Center

This function will return the coordinates of the center of the bounding box that
contains all the part geometry, as referred to in the Bounding Box function above.

Command Prompts

Notes

1. Refer to the Notes in the Bounding Box function above.

Related Topics

Analyze Pane, Analyze Ribbon Bar

5.9.2.4 Show Surface Normals

Selecting this function will cause normal vector arrows to display on
every surface on the screen.  Geometry objects do not need to be

selected.  Mesh objects do not apply.

Command Prompts

Basic Procedure

Press the ESC key to abort the display of surface normals.

Notes
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1. Surface normals are also displayed for objects that are locked. If no valid surfaces
are found, the following error message will be displayed.

Related Topics

Analyze Pane, Analyze Ribbon Bar

5.10 Transform

The Transform Ribbon Bar contains a Transform pane and associated functions.

Enabling the Transform Ribbon Bar

When a geometry selection is made VisualCAD enter Edit Mode and allows access to the
Transform Ribbon Bar.

The Transform Ribbon Bar is Enabled
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Selecting Transform will display the Transform Ribbon Bar.

Selecting a Transform command will act upon the selected geometry. 

Transform Ribbon Bar

Context Transform Menu (Right-click)

Selecting geometry in a viewport and by using right mouse button click also provides
access to transformation tools. 

Context Transform Menu
(Right-click)

If you do not see the above options when you Right mouse
button click, enable Show pop-up menu under Home >

Options.

Related Topics

Move Objects by Mouse

Rotate Selected Object in 2D

Rotate Selected Object in 3D

Graphically Scale Selected Objects

Rectangle Scale selected Objects

Move Objects in 3D

Rotate Selected Objects

Orient the Entire Part

Scale Selected Objects

Mirror Selected Objects

Array Selected Objects

Polar Array Selected Objects
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Graphical Manipulator

Transform Ribbon Bar

5.10.1 Move by Mouse

All selected items will be moved in 3D.  The direction and distance to move is specified
by picking a starting and ending point.  All selected items will be moved that direction
and distance.

Command Prompts

Select objects and hit Right Mouse Button/Enter when done

Move by mouse:: Pick from point or enter coordinates x,y and z

Move by mouse:: Pick to point or enter coordinates x,y and z

Added # objects to selection!

Basic Procedure

Screen Activity Comments

Step 1 Select items to move.  The items could be
pre-selected.  If a mesh is selected, choose
from the pop-up selection options provided.

Step 2 Pick a starting point or type in coordinates
into the Command Bar.
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Step 3 Pick an ending point or type in coordinates.

Related Topics

Transform Ribbon Bar

5.10.2 Rotate 2D

Rotate selected objects around a picked point a given angle.  The plane of rotation is
parallel to the construction plane in the currently selected view.

Command Prompts

2D Rotate by mouse:: Select objects - hit right mouse to end

2D Rotate by mouse:: Enter rotation center point

2D Rotate by mouse:: Enter first reference point or rotation angle

2D Rotate by mouse:: Enter second reference point

Basic Procedure

Screen Activity Comments
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Step 1 Pick objects to be rotated.  They can be pre-
selected.

Step 2 Pick a center of rotation or type in the
coordinates into the Command Input Bar.

Step 3 Pick a starting point or type in the
coordinates.  A temporary ray from the
center of rotation going through the starting
point will be made.

Step 4 Pick an ending point or type in the
coordinates.  A temporary ray from the
center of rotation going through the ending
point will be made.  The angle of rotation
will be measured from the starting ray.

Example

In the example below, a rectangle was selected and is highlighted yellow.  A center point
of rotation was picked to the left of the rectangle.  The picture on the right side shows
that the starting point was picked inside the rectangle.  The cursor has moved to just
above the rectangle and its position is marked by a white dot.  A temporary line segment
goes from the center of rotation to that point.  The effects of the rotation on the selected
geometry (rectangle) are displayed in black.

Once the final point is selected, the geometry is rotated and all the temporary line
segments, circles, rays, and points disappear.  The final result is a rotated rectangle.

Related Topics

Transform Ribbon Bar
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5.10.3 Rotate 3D

Rotate selected objects around a picked point a given angle.

Command Prompts

3D Rotate by mouse:: Enter number of copies or Pick rotation axis base point

3D Rotate by mouse:: Pick axis head point

3D Rotate by mouse:: Enter angle or reference point

3D Rotate by mouse:: Enter second reference point

Basic Procedure

Screen Activity Comments

Step 1 Pick objects to be rotated.  They can be pre-
selected.

Step 2 Type in the number of copies to be made.  If
no copies are to be made, just go to step 3.

Step 3 Pick the axis basis point or type in the
coordinates into the Command Input Bar.

Step 4 Pick the axis head point or type in the
coordinates.  A temporary segment will
connect the axis base and axis head points.

Step 5 Pick a starting point or type in the
coordinates.  A temporary ray from the
center of rotation going through the starting
point will be made.

Step 6 Pick an ending point or type in the
coordinates.  A temporary ray from the
center of rotation going through the ending
point will be made.  The angle of rotation
will be measured from the starting ray

Example

In the example below, a box was selected and is highlighted yellow.  The axis base point
and head point were picked.  The axis is the vertical line to the left of the box.  The
starting point for the angle is being picked in the second picture.  The cursor location is
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the white dot below the box at the intersection of the rotary circle and a ray from the
axis base point.

In the first image below, the starting point was picked.  The current cursor position is to
the right of the selected box and is marked by a white dot.  The effects of the rotation
are displayed by the gray box.  Once the endpoint is picked the geometry is rotated and
all the temporary line segments, circles, rays, and points disappear.

Related Topics

Transform Ribbon Bar

5.10.4 Scale

This function will interactively scale selected 2D/3D geometry about a point.  The scale
factor can be directly keyed-in to the Command Bar or will be determined by the ratio of
two user-defined radial distances.  This method of scaling will maintain a constant aspect
ratio of the part model size.

Command Prompts

Graphical Scale:: Enter scale center point
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Graphical Scale:: Enter first reference point or scale factor

Graphical Scale:: Enter second reference point

Basic Procedure (also see Example below)

Screen Activity Comments

Step 1 Select Graphical Scale from Transform menu. None

Step 2 Select the 2D and/or 3D  geometry objects that you
want to be scaled.

Step 3 Enter the scale reference point (or scale focus point).

Step 4 Determine the scaling factor (factor or distance ratios).

Step 5 Select a second point for scaling. 

Step 6 ESC or Right Mouse Button to quit.

Example

1. Select the 2D and/or 3D  geometry objects that you want to be scaled. They may
also be pre-selected.  After the desired geometry is selected and right-click to
close the selection.

2. Enter the scale reference point (or scale focus point).  This can be any point on
the model or the grid or you can key-in World coordinates, etc.  Scaling will be
done toward or away from this point.
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3. Determine the scaling factor in one of two ways described below:

a. Enter scale factor:  A scale factor (decimal value) may be directly entered into
the Command Bar.  When this value is accepted, the geometry will
immediately be scaled and the function will end. 

b. Distance ratios: Select a point away from the scale reference point (from Step
3). The distance between this point and the scale reference point represents
100% or the full scale of the selected geometry.

4. Select a second point for scaling.  The distance between this second point and the
scale reference point (from Step 3) is compared to the first distance and this ratio
determines the scale factor for the geometry.  If this second point is selected using
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the cursor, you will see the geometry being scaled dynamically until this second point
is finally determined. 

5. Finally, after the second point is picked, the geometry will be scaled and the function
will end.  Scaling larger or smaller are both permitted.  The function can be canceled
at any time before completion by using ESC or the Right Mouse Button.

Related Topics

Transform Ribbon Bar

5.10.5 Rectangular Scale

This function will scale selected 2D/3D geometry by interactively changing the size of a
'minimum rectangle' around the geometry.  This scaling method performs 2D scaling
oriented to the C-Plane and does not maintain a constant aspect ratio of the part model
size.

Command Prompts

Rectangle Scale:: Select objects - hit right mouse to end

Rectangle Scale:: Move corners of rectangle to scale. Enter when done. ESC/Right-Mouse
to quit

Basic Procedure

Screen Activity Comments

Step 1 Select Rectangular Scale from Transform menu. None

Step 2 Select the geometry objects to scale.



VisualCAD 2025 Companion380

© 2025 Mecsoft Corporation

Step 3 Interactively move the rectangle corners/mid-points to
reshape the rectangle. 

Step 4 ESC or Right-click to quit.

Example

1. Select the 2D and/or 3D  geometry objects that you want to be scaled. They may
also be pre-selected.  After the desired geometry is selected, hit the Right
Mouse Button to close the selection.

2. VisualCAD will immediately create a minimum rectangle in the C-Plane that
surrounds the selected geometry.

3. Interactively move the rectangle corners/mid-points to reshape the rectangle. 
As the rectangle is changed, a temporary duplicate of the geometry will be
shown to help you visualize the resultant model change.  When all changes are
made to the rectangle, select ENTER to accept the changes or ESC/Right Mouse
Button to cancel the function.
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Related Topics

Transform Ribbon Bar

5.10.6 Move ...

All selected items will be moved in 3D.  The direction and distance to move is
specified by picking a starting and ending point.  All selected items will be moved

that direction and distance.  A dialog will appear where you can input parameters for the move.

Command Prompts

Select objects and hit Right Mouse Button/Enter when done

Basic Procedure

Screen Activity Comments

Step 1 From the Move select text by mouse dialog
box, select Pick Objects and select the
objects to move.

Step 2 Enter the Move From XYZ coordinates or
select the Pick From Point button and then
select a point.
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Step 3 Enter the Move To XYZ coordinates or select
the Pick To Point button and then select a
point.

Step 4 Select the Pick Translation Axis button to
define the translation axis.

Optional

Step 5 Enter the Number of Copies and then pick
OK to complete the Move. 

Dialog Box: Move select text by mouse

Number of objects picked

The number of items to be moved is displayed.  If more items need to be moved, use
the Pick Objects button.  

Move From / Move To

The starting point is defined in the Move From area, and the ending point is defined
in the Move To area.  The coordinates can be entered or a point can be picked.  All
picked points are projected down into the view’s construction plane. 

Pick Translation Axis

The Pick Translation Axis can be used to define the starting and ending points.  Once
the button is pushed, you make a temporary line segment:  the endpoints of that
segment are the start and end points of the move.

Number of Copies

The Number of Copies allows you to make additional copies of the objects, each
separated by the move vector.  For example, a point at the origin is moved from
(0,0,0) to (5,0,0) with three copies.  The result is four points at (0,0,0), (5,0,0), (10,0,0),
and (15,0,0).  The original point is unaffected, and the other points were copied using
the movement vector.

Related Topics

Transform Ribbon Bar
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5.10.7 Rotate ...

All selected objects will be rotated in 3D.  The axis and angle of rotation are
specified, and all selected items will be that angle about the axis.  Refer to the Basic

Procedure below.  Note additional information under the Dialog Box below.

Command Prompts

Select objects and hit Right Mouse Button/Enter when done

Basic Procedure

Screen Activity Comments

Step 1 From the Rotate selected objects dialog box,
select Pick Objects and select the objects to
rotate.

Step 2 Enter the Rotate About XYZ coordinates or
select the Pick About Point button and then
select a point.

Default is 0,0,0 origin.

Step 3 Enter the Axis Vector XYZ coordinates or
select the Pick Rotation Axis button and then
select a start point and end point to define
the axis.

Step 4 Enter the Rotation Angle.

Step 5 You can Copy and Rotate at the same time if
desired.  Enter the Number of Copies and
then pick OK to complete the Rotate. 

Optional

Dialog Box: Rotate selected objects

Number of objects picked

The number of items to be rotated is displayed.  If more items need to be rotated,
use the Pick Objects button.  

Rotate About

The point of reference is defined in the Rotate About section.  The coordinates can
be entered or an About Point can be picked.
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Axis Vector

The axis of rotation is defined with a point and a vector.  The point allows the axis to
be offset from the origin.  The vector is parallel to the axis, and the direction of the
vector tells which rotation is a positive angle.  This is the Right Hand Rule.  For
example, an axis of rotation at the origin ( point is (0,0,0) ) and a vector (0,0,1) has
positive angle going counterclockwise from the top view ( from positive x-axis to
positive y-axis).  Alternatively, if the axis of rotation was at the origin (0,0,0) but
went the other way with a vector (0,0,-1) has positive angle going clockwise (from
positive x-axis to negative y-axis).

Rotation Angle

The rotation angle is measured from the current location.

Number of Copies

This allows you to make additional copies of the objects, each separated by the
rotation angle.  The original object is unaffected, and the other points were copied
using the rotation angle.

Related Topics

Transform Ribbon Bar

5.10.8 Part Orient ...

This dialog allows user to orient the part to have it aligned parallel to World
Coordinate System (WCS).  The dialog offers a convenient way of selecting each of

the six principal directions to set the cutting direction.

Command Prompts

None.

Basic Procedure

Screen Activity Comments

Step 1 Open part file.
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Step 2 Select Part Orient… from Transform menu to
display the Orient Entire Part dialog box.

Step 3 From the dialog box, select the WCS
direction to orient the part to.

Step 4 Select to Set as Current View Direction if
desired.

Optional

Step 5 Pick OK and the part is now oriented as
shown below.

Dialog Box: Rotate selected objects
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World Coordinate System (WCS)

Once you select a WCS direction, all of the geometry will be rotated to an
orientation where the selected cutting direction becomes the negative Z axis.

Set as Current View Direction

Orients the part parallel to the current view orientation.

Related Topics

Transform Ribbon Bar

5.10.9 Orient by 3 Pts

This command allows you to transform the currently selected objects using
three reference points and three target points.
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Command Prompts

Pick or enter first reference point.

Pick or enter second reference point.

Pick or enter third reference point.

Pick or enter first target point.

Pick or enter second target point.

Pick or enter third target point.

Basic Procedure

Screen Activity Comments

Step 1 Pick three reference points in relation to the
selected objects.

The selected objects are 
re-oriented.

Step 2 Pick three target points to re-orient the
objects.

Related Topics

Transform Ribbon Bar

5.10.10 Scale ...

All selected objects will be magnified, shrunk, or stretched the same way.  A dialog
will appear where you can input parameters for the scaling.

Command Prompts

None.

Basic Procedure
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Screen Activity Comments

Step 1 Select Scale… from the Transform menu to
display the Scale selected objects dialog box.

Step 2 The number of objects is displayed.  Use Pick
Objects to add more to the selection.

Step 3 Select either Uniform or Non-Uniform
Scaling and enter the XYZ scale factors.

Step 4 Pick OK to Scale the selected objects. Optional

Dialog Box: Scale selected objects

Scale Selected Objects

Number of objects picked

The number of objects to be scaled is displayed.  If more items need to be scaled,
use the Pick Objects button.

Scale Units

This converts the units associated with the geometry to a different set of units. 
Conversions can go from millimeters to inches or from inches to millimeters.  The
object’s size remains constant, but the numbers associated with the size change.  A
one-inch object will be scaled into a 25.4 mm object.  The units of the display view
are not affected, so the object appears to grow or shrink.  When the units of the
display are changed, the object will appear as it did before the scaling.

Uniform scaling

This will magnify or shrink all dimensions equally.  A scaling of 1.0 is no change.  A
scaling of 0.5 will make the object half as small, and a scaling of 3 will make the
object 3 times bigger.

Non-Uniform Scaling
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This will stretch the object.  The coordinates of the object are what are scaled.  This
will cause an object not at the origin to move.  For example, if a point is at (5,0,0) and
is uniformly scaled by a factor of 3, the point will be at (15, 0, 0).

Related Topics

Transform Ribbon Bar

5.10.11 Mirror ...

Reflects all selected objects in a plane parallel to one of the principal planes.  A
dialog will appear where you can input parameters for the mirroring.

Command Prompts

None.

Basic Procedure

Screen Activity Comments

Step 1 Select Mirror... from Transform menu.

Step 2 The number of objects is displayed.  Use Pick
Objects to add more to the selection.

Step 3 Define the Mirror Plane and Pick (P) point.

Step 4 Check the box to mirror a copy if desired. Optional

Dialog Box: Mirror selected objects
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Mirror Selected Objects

Number of objects picked

The number of objects to be mirrored is displayed.  If more items need to be scaled,
use the Pick Objects button.

Mirror Plane / Point (P)

Mirror Plane is parallel to one of the principal planes:  XY Plane, XZ Plane, or YZ
Plane. 

Point (P) is defined to allow the planes to be offset.  This point is on the mirroring
plane.  You may also select Pick Plane Point.

Create Copy

This allows a copy to be made and leaves the original object in place and puts a copy
at the mirrored location.

Related Topics

Transform Ribbon Bar
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5.10.12 Array ...

All selected objects will be copied into a uniform grid of objects offset from each
other specified distances in x, y, and z.  A dialog will appear where you can input

parameters.

Command Prompts

None.

Basic Procedure

Screen Activity Comments

Step 1 Select Array... from Transform menu.

Step 2 The number of objects is displayed.  Use Pick
Objects to add more to the selection.

Step 3 Define the XYZ Spacing and # of Copies.

Step 4 Pick OK to complete the Mirror command.

Dialog Box: Array selected objects

Array selected objects

Number of objects picked

The number of objects to be arrayed is displayed.  If more items need to be scaled,
use the Pick Objects button.

XYZ Spacing
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The XYZ Spacing is the separation of a given point on an object and the corresponding
point on the copied objects.  The object’s size is not considered during this
command.

# of Copies

There can be a different Number of X, Y or Z Copies made in each direction.

Notes

1. If the spacing numbers are all positive, the original object will be the one with
the lowest (x, y, z) coordinates.

Related Topics

Transform Ribbon Bar

5.10.13 Polar Array ...

All selected objects will be copied into a uniform ring of objects around a circle. 
A dialog will appear where you can input parameters.

Command Prompts

None.

Basic Procedure

Screen Activity Comments

Step 1 Select Polar Array... from Transform menu.

Step 2 Enter or pick the point to Rotate About.

Step 3 Enter the Angle to Fill. and total Number of
Copies to array.

Step 4 Pick OK to complete the Polar Array
command.

Dialog Box: Polar array selected objects
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Polar Array

Number of objects picked

The number of objects to be polar arrayed is displayed.  If more items need to be
scaled, use the Pick Objects button.

Rotate About

This is defined with a point and a vector.  Pick About Point allows the axis to be
offset from the origin. 

Axis Vector

This is parallel to the axis, and the direction of the vector tells which rotation is a
positive angle.  This is the Right Hand Rule.  For example, an axis of rotation at the
origin ( point is (0,0,0) ) and a vector (0,0,1) has positive angle going counterclockwise
from the top view ( from positive x-axis to positive y-axis).  Alternatively, if the axis
of rotation was at the origin (0,0,0) but went the other way with a vector (0,0,-1) has
positive angle going clockwise (from positive x-axis to negative y-axis).

Angle to Fill

The rotation Angle to Fill measured from the current location.

Number of Copies

The Number of Copies is evenly distributed about the Angle to Fill.

Related Topics
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Transform Ribbon Bar

5.10.14 Along Path ...

All selected objects will be copied along a path curve.  A dialog will appear
where you can input parameters.

Command Prompts

None.

Basic Procedure

Screen Activity Comments

Step 1 Select Along Path... from Transform menu.

Step 2 Select options from the dialog for Method,
Orientation and Move Instances.

Step 3 Pick OK to complete the Polar Array
command.

Dialog Box: Polar array selected objects



The Ribbon Bar 395

© 2025 Mecsoft Corporation

Trabsform Along Path

Number of objects picked

The number of objects to be transformed along the path curve.  If more items need
to be scaled, use the Pick Objects button.

Method

This option allows you to specify the distance between the copied objects.  You
either specify the number of instances or specify the number of objects.

Orientation

This specifies how the object instances should be oriented.  The illustrations below
show the different options.  There can be No Rotation where the objects are fixed in
place.  There can also be a Freeform or a Road like orientation.  Again the
illustrations below provides some guidance on how the transformation will apply.
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Array In Place Road Like Array In Place No Rotation

Array In Place Freeform Array Along Path Roadlike

Aray Along Path No Rotation Array Along Path Freeform

Move Instances

This specifies how the objects are moved.  Select either In Place or Along Curve. 
Refer to the illustrations above for guidance.

Related Topics

Transform Ribbon Bar
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5.10.15 Graphical Manipulator

Dis
pla
ys
th
e
gra
phi
cal

manipulator widget on selected object(s) facilitating move, scale, and rotate transformations
around the graphical manipulator origin.  This can be toggled on and off by selecting Manipulator
on the Status bar.

Manipulator
On

Manipulator
Off

About the Graphical Manipulator

Graphical Manipulator can be used for graphical transform of objects by selecting the 
icon on the Status Toolbar. This feature can be used to move or rotate objects. The
orientation of the graphical manipulator is in the same orientation as the World
Coordinate System (WCS). 

The arrows displayed on the graphical manipulator can be selected and a numerical value
placed to move the geometry in either X, Y or Z direction. Or the arrows can be selected
and simply dragged in either the X, Y or Z direction. 

To rotate the geometry, use the arcs on display of the graphical manipulator. The arcs
displayed on the graphical manipulator can be selected and a numerical value placed to
rotate the geometry in either X, Y or Z direction. Or the arcs can be selected and simply
rotated by dragging with the left hold of mouse. 

Graphical Manipulator can also be enabled by selecting Transform on the Menu bar and
then selecting Manipulator.
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Graphical Manipulator

Command Prompts

Manipulator:: Move/Rotate object(s). Enter when done. Esc/RButton to exit.

Basic Procedure

Screen Activity Comments

Step 1 Select an object to manipulate.

Step 2 Select Manipulator from Transform menu or
from the Status Toolbar. to display the
manipulator widget.

Step 3 Left-click on one of the manipulator widgets.
 There are three for each axis.  They are
Scale, Transform and Rotate.  Refer to the
illustration above.

Step 4 Enter a value in the pop-up window and
press ENTER.  Alternately you can drag the
widget to dynamically transform the object.

Left click on the origin of the Manipulator to
display additional options.  See below.

Optional

Examples
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Original Geometry

Move 1" along the positive Y Axis

Move 1" along the positive Z Axis

Rotate 45 degrees about the positive X Axis
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Scale by 2 about the positive Z Axis

Scale by 2 about the positive Y Axis

Scale by Dragging equal distance about the X Axis

Graphical Manipulator options

Graphical Manipulator options can be invoked by left clicking on the origin of the
manipulator.

This allows for the selection of additional manipulator options such as Set to World CSYS,
Set to CPlane CSYS, Smooth Dragging, Snappy Dragging and Set Drag Strength<100.000%>

The below example shows the options after left click of mouse on origin of the
manipulator.
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Set to World CSYS

Set to World CSYS - In the below example, the Graphical Manipulator is set to the
World Coordinate System (WCS).

Set to C-Plane CSYS

This sets the Graphical Manipulator to the Construction Plane Coordinate System

In the below example, the C-Plane is set to 45 degrees on the X axis coordinate and
the manipulator is also set to that CPlane. 

Smooth Dragging

This allows the Graphical Manipulator to glide freely when being manipulated.
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In the below example, please note that the geometry is gliding freely in between
cells.

Snappy Dragging

This allows the Graphical Manipulator to move in increments by snapping from cell to
cell for each move.

In the below example, please note that the geometry is snapping directly on to the
cells 

Set Drag Strength<100.000%>

This value by default is set to 100%. This sets the percentage of the speed by which
the Graphical Manipulator moves when being dragged or rotated. The lower the
value, the slower the speed.

In the below example the drag strength is set at 100%.
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Related Topics

Transform Ribbon Bar

5.11 Print Preview

The Print Preview Ribbon Bar contains Print, Zoom, and Preview panes and associated functions. 
This Ribbon Bar is only displayed when the Print Preview command is executed.

The Print Preview Ribbon Bar

Print Preview Ribbon Bar

Related Topics

The Ribbon Bar

VisualCAD Menu

Print ...

Print Preview ...

Print Setup ...
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Status Toolbar

Status Tool Bar

Related Topics

Coordinate input

Current Position

Part Units

Object Snap Control

Graphical Manipulator

Visual Aids

Properties

Layer Manager

Options

Background Properties

6.1 Coordinate input

Coordinate input for geometry creation can be set to World coordinates or Construction Plane (C-
Plane coordinates). To toggle between WORLD and C-PLANE, click WORLD on status bar.

 World Coordinates

 Construction Plane Coordinates

Construction Plane coordinates

Construction Plane coordinates can be used for inputting coordinates for geometry
creation. This comes in handy when the C-plane is transformed from the WCS
orientation. User can toggle between C-PLANE and WORLD coordinates by selecting C-
PLANE or WORLD icon located on the Status bar.

Example: Construction Plane coordinates

Example above shows the construction plane transformed from the World origin.
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Example: Construction Plane coordinates

Basic Procedure

To input coordinates in C-Plane, activate the C-Plane from the status bar by toggling this
from WORLD to C-Plane.

Under the Curve pane of the Curve Modeling Ribbon Bar, select the Rectangle icon.

Step 1

Step 2

Screen Pick  Command Input

Step 1 (Optional) Enter X, Y, [Z] coordinates for
the first point.
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Step 2 (Optional) Enter X, Y, [Z] coordinates for
the second point (opposite corner).

Final

Related Topics

Status Tool Bar

6.2 Current Position

Displays information on current settings.  It also has controls for the picking of points.

Current Position (X, Y, Z)

Displays the coordinates of the current cursor position in the view.  The cursor is projected down
into the current view’s construction plane.

Related Topics

Status Tool Bar

6.3 Part Units

Displays the current model units.  If it is picked, it will attempt to change units from
inches to millimeters or from millimeter to inches.  If objects are already in the

model, a dialog will verify if you really want to change units.  The objects keep the same size but
their measured dimensions change.
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Related Topics

Status Tool Bar

6.4 Object Snap Control

The Object Snap controls are located on the Status Tool Bar.  They allow you to select objects by
their snap locations.  The available Object Snaps are listed in the Related Topics section below.

Object Snaps

Related Topics

Status Tool Bar

Grid Snap

Ortho Snap

Origin Point Snap

End Point Snap

Near Point Snap

Mid Point Snap

Center Point Snap

Quad Point Snap

Intersection Point Snap

Vertex Point Snap

Project C-Plane Snap

6.4.1 Grid Snap

Points picked near construction plane grid intersection will be snapped to that grid point.
This can be toggled on and off by selecting Grid Snap on the Status bar.

Grid Snap Grid Snap
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On Off

     

Related Topics

Object Snap Control

6.4.2 Ortho Snap

Switches on and off the display of the construction plane in the currently selected view.  The
default is to show the construction plane (grid). This can be toggled on and off by selecting

Ortho Snap on the Status bar.

Ortho Snap
On

Ortho Snap
Off

Related Topics

Object Snap Control

6.4.3 Origin Point Snap

Points picked near the origin will be snapped to the origin. This can be toggled on and off by
selecting Origin Snap on the Status bar.

Origin Point Snap
On

Origin Point Snap
Off

Related Topics

Object Snap Control

6.4.4 End Point Snap

Points picked near the end points of objects will be snapped to that end point. This can be
toggled on and off by selecting End Point Snap on the Status bar.

End Point
Snap
On

End Point
Snap

Off

   

Related Topics

Object Snap Control
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6.4.5 Near Point Snap

Points picked near objects will be snapped to the nearest point.  The nearest point is the
closest point on the object to the cursor. This can be toggled on and off by selecting Near

Point Snap on the Status bar.

Near Point
Snap On

Near Point Snap Off

Related Topicscs

Object Snap Control

6.4.6 Mid Point Snap

Points picked near the midpoints of a curve will be snapped to that point. This can be
toggled on and off by selecting Mid Point Snap on the Status bar.

Mid Point
Snap
On

Mid Point
Snap

Off

Related Topicsics

Object Snap Control

6.4.7 Center Point Snap

Points picked near the center point of a circle, arc, or closed polygon will be snapped to that
point. This can be toggled on and off by selecting Center Point Snap on the Status bar.

Center Point Snap
On

Center Point Snap
Off

Related Topics

Object Snap Control

6.4.8 Quad Point Snap

Points picked near the quadrant points of circles and arc will be snapped to that point. 
Quadrant points are the points on the circle at 0, 90, 180, and 270 degrees. This can be

toggled on and off by selecting Quad Point Snap on the Status bar.
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Quad Point  Snap
On

Quad Point Snap
Off

Related Topics

Object Snap Control

6.4.9 Intersection Point Snap

Points picked near the intersection of curves will be snapped to that point. This can be
toggled on and off by selecting Intersection Point Snap on the Status bar.

Intersection Point
Snap
On

Intersection Point
Snap

Off

Related Topics

Object Snap Control

6.4.10 Vertex Point Snap

Points picked near the vertex of a mesh will be snapped to that point.

Quad Point  Snap
On

Quad Point Snap
Off

Related Topics

Object Snap Control

6.4.11 Project to C-Plane Snap

All selected points will be projected to the construction plane.

Quad Point  Snap
On

Quad Point Snap
Off

Related Topics

Object Snap Control
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6.5 Visual Aids

This provides tools for the construction of geometry.

Visual Aids Enabled

This can be toggled on and off by selecting Visual Aids on the Status bar.

Visual Aids
On

Visual Aids
Off

This feature can serve as a construction aid or a tool for referencing geometry. With Visual Aids
enabled, it will allow viewing of construction lines as it references geometry. This allows for
easier visual placement of new geometry. Curve creation using Visual Aids can be enabled by
selecting the Visual Aids icon on the Status Toolbar.

The above example shows intersection
reference of 2 curves

The above example shows tangent reference
to 2 circles
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Related Topics

Status Tool Bar

6.6 Properties ...

Information about a selected object will be displayed.  This includes the name, layer that it’s
on, the item's color, number of selected objects, object type, and attributes related to the

selected object. These properties can be modified.

Object Properties Dialog

Object Properties Dialog

The dialog shows the object name, layer that it’s on, the item's color, object type, and
attributes related to the selected object. It also shows the number of selected objects
and the name of active layer.

The object name is automatically generated when the object was created but can be
changed.  Points, lines, arcs, circles, curves default to the geometry-type name (i.e.
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points, lines, …) with a number at the end.  The number has no significance; it is just an
internally generated number.  Surface and poly-surfaces are named as Shells and
polygonal meshes as Mesh.

The layer that the object is on is displayed.

The color of the object defaults to the construction color of the layer; however, it can be
changed.  Uncheck the “Use Layer Color” box and click the color bar underneath it.  A
color-picking dialog will appear. This color change only applies to that object.

This selects which of the existing layers to make the active layer.  If that layer was not
visible before being selected, it and all of the objects on that layer become visible.  Any
objects created after that will be the default color for that layer.

The information displayed in the properties dialog can be grouped or listed in
alphabetical order.

When 2 or more objects are selected, the property manager displays the selected object
count and the active layer information.

Selecting Edit mode allows editing of curve geometry.

Related Topics

Status Tool Bar

Edit Mode

6.6.1 Edit Mode

Edit Mode can be enabled by clicking on the Edit Mode icon in the Properties dialog and can
be toggled on and off by clicking it. With Edit Mode active, the points are visible in the

viewport and coordinates displayed in the properties dialog. They are grayed out in the Properties
tab if Edit Mode is not active. 

You can use the Properties dialog to parametrically edit certain
types of geometry such as the radius of a circle or the length and width
of a rectangle.  This allows you to quickly change geometry dimension
values!

The Properties tab can be located in the Status Toolbar. The X, Y, and Z coordinates of the
geometry can be modified by changing the Point values within the Properties tab under Objects
or graphically by dragging them in the viewport. You can cycle through all the edit points and
modify the X, Y and Z coordinates for each point by using the spinner increment. Cycling through
these points highlights the points on the geometry in the viewport. 

Properties Dialog
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Properties tab

Properties tab - Point Number 1
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Properties tab - Point Number 2

Basic Procedure

 Edit points can also be modified by picking the corner points graphically in the viewport
with drag and drop.

 Screen Pick 

Step 1

Left-click on Edit Point
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Step 2

Drag & Drop the Edit Point to new coordinates

Edit Geometry Parametrically

You can parametrically edit the dimensions of geometry using the Properties dialog.  

Just select the Edit icon  until the dimension values are activated.  When you edit a
dimension vales and close the Properties dialog the geometry to update automatically.

Edit the Length & Width of a Rectangle
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Edit the Radius of a Circle

Editing Line Widths

You can edit the width of a line or curve using the Properties dialog.  

Just select the Edit icon  until the object properties are activated.  Then set the Use
Layer Thickness to False.  This will activate the Thickness field.  Drop down the Thickness
menu and select a line width.  When you edit a dimension vales and close the Properties
dialog the geometry to update automatically.

Edit the Width of a line or curve
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Line Width Property Selector

Related Topics

Properties

6.7 Layer Manager

This button calls up a dialog to manage the layers.

Layer Manager



Status Toolbar 419

© 2025 Mecsoft Corporation

Each layer has a name and color associated with it.  There can be 0 or more geometric objects on
any layer.  A layer and all the geometry on it can be made invisible if you uncheck the Visible
checkbox.  The layer can be turned back on by rechecking the box.  All layers are visible by default.

Related Topics

Status Tool Bar

Layer Visibility

Lock Layer

New Layer

Delete Layer

Duplicate Layer

Duplicate Layer and Objects

6.7.1 Layer Visibility

Visibility of layers is useful in the construction of complicated models.  Create multiple different
layers, one for each subsection of the model.  Then turn off all but the layer for the subsection
currently being modified.  This makes very complicated models much easier to see and work with.
 Otherwise, it can be difficult to see whatever was just created or picking particular items in the
middle of lots of other objects from different subsections.  

Layer Visibility

The visibility of the other layers can be periodically turned on and off to check the positioning of
the current subsection with regards to the rest of the model. Visibility of active layer cannot be
turned off.

Only one layer at a time is active.  Any new objects created will be created on this layer and with
the default layer color.  Selecting objects by layer will select only the objects on the current
layer.  

You can change the active layer through this dialog or through the Status Toolbar drop-down list.
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 Active Layer

The current number of objects on each layer is also displayed.

Related Topics

Layer Manager

6.7.2 Lock Layer

Locks a layer when the Locked check box is selected.

Lock Layer

Locking a layer does not allow selection, editing and snapping to objects. This would be useful
where you would like to have the geometries visible but locked for selection and editing. The
layer that is active cannot be locked.

Related Topics

Layer Manager

6.7.3 New Layer

Creates a new layer. The default name is New Layer, but the name can be changed.

Related Topics

Layer Manager
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6.7.4 Delete Layer

Deletes the selected layer.

Related Topicspics

Layer Manager

6.7.5 Duplicate Layer

Copies the layer selected with its attributes.

Related Topics

Layer Manager

6.7.6 Duplicate Layer and Objects

Copies the layer selected with its attributes and all of the objects on the layer.

Related Topics

Layer Manager

6.7.7 Reorder Layers

From the Layer Manager, select these icons to Reorder Layers within the Layer Manager
list.  First select a layer and then pick the Move Layer Up or Move Layer Down icon from

the Layer Manager toolbar.

Layer Manager - Reorder Layer
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6.8 Background Properties

Performing a Right mouse click in any of the view ports when no geometries are selected and
selecting Properties from the menu display the Background Properties dialog.

Background Properties

Screen Background Color

Allows user to set the viewport background color. This is the color displayed when no
objects are at that position.

Screen Gradient

This is a smooth change of lighting.  The direction specified is the lighter side.  It starts
slightly darker on the opposite side of the screen and gradually gets lighter until it
reaches the specified side.

Related Topics

Layer Manager
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Exercises

7.1 #1: VisualCAD Preferences

In this exercise you will learn about many of the most commonly used system options in
VisualCAD including how to access the online help, set display options, tolerances and units,
system options, viewports and other VisualCAD display functionality.

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Access the online help.

2. Set the Display Style.

3. Set the Units to Inches.

4. Set System Options.

5. Set to Quad Viewports.

6. Viewing the Command Prompts.

7. The Status Bar.

7.1.1 Accessing the Online Help

Accessing the Online Help

At any time you can display the VisualCAD Online Help by selecting this icon or pressing
the <F1> key during any command prompt or by selecting the Help icon shown below.

7.1.2 Set the Display Style

Set the Display Style
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VisualCAD allows you to change the Style of the display.  At the very top right of the
VisualCAD display window, select the Style drop-down menu and select Office 2007
(Blue Style).

7.1.3 Set the Units to Inches

Set the Units to Inches

Open VisualCAD and check to see if the part unit is set to Inch.

Status Toolbar

If Units is set to MM, double-click on it to change to INCH.

7.1.4 Set Systems Options

Set Systems Options

In this exercise you will learn how to set some of the systems options in VisualCAD.

1. Select the Home tab.

2. Now select the Options  icon to display the Options dialog.  This icon is also
located on the Status Bar.

3. Select Tolerance and Units from the left side of the dialog.

4. Under Part Faceting Tolerance set the Chordal Deviation / Chord Height Tolerance to
0.001".

5. Set the Units to Inches.
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System Options Dialog

6. Select System from the left side of the dialog.

7. Under Auto Save, check the box and then set the value to save every 10 minutes. 

8. Check the box to use Auto Backup and then select the ... box to display the Browse
for Folder dialog.

9. Select the folder where you want backup files to be saved and then pick OK.
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10. Set the remaining System Options as shown in the dialog above.

11. Now select Display from the left side of the dialog.

12. Under View Change Animation uncheck the box next to Speed.
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13. Set the remaining Display Options as shown in the dialog above.

14. Select Grid from the left side of the dialog.  In these exercises we use the following
Grid options.
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System Options Dialog

15. Select Dimension from the left side of the dialog.

16. Set the Dimension Preferences to those shown in the dialog below.

17. Pick OK to close the Options dialog.
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7.1.5 Set to Quad Viewports

Set to Quad Viewports

It is much faster to draw and model in VisualCAD if you have multiple Viewports
displayed.

Select the Home tab.

1. Right-click on the Viewport tab located in the upper left side of the window and
select Quad Viewport.
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2. You can also select Display and Viewport commands from the Display tab of the
VisualCAD Ribbon Bar.
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7.1.6 The Quick Access Toolbar

The Quick Access Toolbar

Located at the very top left of the VisualCAD window you will find the Quick Access
Toolbar.  It contains many of the most commonly used commands such as Cut, Copy,
Paste, Save, Undo, Redo, etc.  The cool thing is that you can customize this toolpath to
add commands that YOU use regularly.

1. Pick the drop-down menu to the right of the Quick Access Toolbar.

2. Select More Commands... from the menu to display the Customize dialog.  You can
use this dialog to add or remove commands to the Quick Access Toolbar.
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7.1.7 Viewing the Command Prompts

Viewing the Command Prompts

The Command Input bar  is located just below the ribbon bar.  You
can drag the bar down to see the current and previous command prompts.  This is helpful
while learning how to use VisualCAD. 

1. Move the cursor onto the bottom of the Command Input bar 
 until it changes.

2. Then left-click and drag the Command Input bar  down to reveal
to review the history of commands.



Exercises 433

© 2025 Mecsoft Corporation

7.1.8 The Status Bar

The Status Bar

Located across the very bottom of the VisualCAD display you will find the Status Bar.  It
contains information and quick access to some very helpful commands.  From left to right
on the Status Bar you will find This is where you access the Layer Manager, Properties
dialogs, Graphic Manipulator and more.  Here is the list:
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1. World Coordinates tracker.

2. Units.

3. Grid, Ortho and Object Snaps.

4. Graphic Manipulator.

5. Construction Visual Aids.

6. Properties Manager.

7. Layer Manager.

8. Active Layer Selector.

9. System Options.

7.2 #2: 2D Drawing & Dimensioning

In this exercise you will learn about the Layer Manager and how to create and work with layers. 
You will also learn how to draw quickly in VisualCAD using the menus and command line
shortcuts.  You will also learn how to take advantage of the Visual Aids feature to speed up your
drawing creating tasks including lines, arcs curves, fillets, chamfers, trimming, dimensioning and
more.

2D Drawing & Dimensioning    

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Create Layers.
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2. Curve Drawing.

3. Using Visual Aids.

4. Dimensioning.

7.2.1 Create Layers

Create new Layers

In this step you will use the Layer Manager to create some new layers and then set the
active layer.

1. Display the Layer Manager.  You can pick the Layer Manager icon  located on the
Status Bar.

2. From the Layer Manager select the Add Layer icon  to add a new layer.

3. Now lets rename the new layer to Drawing.  First double-left-click in the Name field
to activate it, and enter Drawing as the new layer name.

4. Repeat the procedure to create a new layer, this time named Dimensions.

5. If the Layer Manager keeps Auto-Hiding to the left side of the display, you can select

the Auto Hide pin icon   at the top of the Layer Manager.  to toggle this feature. 



VisualCAD 2025 Companion436

© 2025 Mecsoft Corporation

The pin down icon means that the dialog will stay displayed.  The pin left icon
means that the dialog will auto-hide.

6. Now let's change the color of these two layers.  In the Color field left-click on the
color box for the layer named Drawing.  Again, this will display the Colors dialog.

7. From the Colors dialog that displays, accept the default color black by pick OK to
close the dialog.

8. Repeat the procedure for the layer named Dimensions.
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9. Now from the Active column, check the box to make the layer named Drawing as
the Active Layer.

7.2.2 Curve Drawing

Curve Drawing

In this step you will learn how to use the keyboard to quickly drawing a polyline and then
create some fillets and chamfers.

1. You only need the Top View  displayed for this exercise so if you have
multiple Viewports displayed, double-left-click on the Top View tab to change the
display to that Viewport.

2. Alternately you can right-click on the Top View tab and select Single Viewport.

3. If you do not see the Top View  tab on any of your Viewports, simply
double-left-click on any viewport tab to set the display to that single Viewport and

then select the Top View  icon from the View Toolbar.

4. For visual purposes, we are displaying the construction Grid and the Grid options are
set to those in the Preferences Exercise.

5. If the Grid is not displayed you can toggle it on by selecting Hide / Show Grid from
the View Toolbar.

6. Scroll the middle mouse button to zoom in/out so that you see the World Origin
WCS triad toward the bottom left of the screen.  If you do not see the X (Red) and Y
(Green) axes displayed, make sure you are in the Top View.
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7. Now we can start curve drawing.  From the Curve Modeling  tab,

select the Polyline  command.

8. The command prompt says:
Polyline:: Pick point or enter coordinates x,y and z
For the start point of the polyline, enter 0,0 in the command window

 and press <Enter>.  

You will see the polyline is starting at the XY origin on the left.

9. For the next point in the Polyline, enter 6,0  and press <Enter>. 
This is in Absolute World Coordinates, 6 units in X and 0 units in Y measured from
the World Origin.
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10. Now if you are drawing and you do not know the exact absolute coordinate values
you can enter Relative Coordinate values in the command window.  

For the next coordinate enter @0,3 in the command window 
 and press <Enter>.  This will place the next point in the polyline 3" from the last
point in the positive Y Axis direction.

Listed below are the absolute and relative coordinate values for the entire polyline.
 Use them to complete the polyline, pressing <Enter> after each coordinate entered.
 If you make a mistake, just Undo and start again.

Polyline Absolute (Relative) coordinate values
0,0
6,0 (@6,0)
6,3 (@0,3)
3,3 (@-3,0)
3,2 (@0,-1)
0,2 (@-3,0)
0,0 (@0,-2)

Your polyline should like this:
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Note: In the future you can also specify a point at an angle and length from the
previous point using the following format: @6<45 where the length of the line
segment is 6 and the direction is 45 degrees from the previous point. 

11. Always Save your work!  Select the Save  or Save As  command from
the Home tab or the VisualCAD Main Menu or press <Ctrl+S>. 

12. Now let's add some fillets.  From the Curve Modeling  tab select the

Fillet  command.

13. For the fillet radius, enter 0.5 in the command window and press <Enter>.

14. For the two lines to fillet, select the lines marked in the illustration below.  For
filleting it is best to select the line on the end furthest from the end you want to
fillet.
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15. Press <Enter> to repeat the Fillet  command.

16. The default fillet radius is now 0.5 so proceed directly to picking the two lines to
fillet and press <Enter>.

17. Next we will chamfer the three remaining outer corners.  From the Curve Modeling

 tab select the Chamfer  command.

18. For the chamfer length, enter 0.5 in the command window  and
press <Enter>.

19. For the lines to chamfer, select lines marked in the illustration below.  For chamfers
it is best to select the line on the end furthest from the end you want to chamfer.
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20. Currently our curves are still are one polyline.  For this next step we need to

explode the polyline.  From the Curve Modeling  tab select the

Explode curves  command.

21. Select the polyline and the right-click the mouse or press <Enter>.  The polyline is
now individual curves.

22. Now from the Curve Modeling  tab select the Extend Curves 
command.

23. Select the change line marked below to extend it to the horizontal line.
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24. Now from the Curve Modeling  tab select the Trim Curves 
command.

25. Pick the line segment to trim.  When using the Trim command, you do not need to
select the trimming curve.  Just select what curve you want trimmed.

26. Next, delete the unneeded line.  Just select it and then press the <Del> key or select

the Cut  command icon from the Quick Access Toolbar. 

7.2.3 Using Visual Aids

Using Visual Aids
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In this step you will learn how to draw with the use of the Visual Aids mode.  With Visual
Aids enabled, construction lines automatically appear as references geometry. This
allows for easier visual placement of new geometry.  Let's see how it works.

1. Curve creation using Visual Aids can be enabled by selecting the Visual Aids 
icon on the Status Toolbar.

While Visual Aids is toggled On, the currently active Object Snaps are referenced
visually depending on where the cursor is located on the drawing.

2. For now, enable the Origin Point Snap , End Point Snap , Mid Point Snap 

, Center Point Snap  and Quad Point Snap .

3. Also disable the Grid Snap .  Your Status Bar should look like this:

4. Now from the Curve Modeling  tab select the Circle on Point 
 command.

5. For the circle center point move the cursor near geometry in your drawing.  You will
see Visual Aids appear (i.e., reference lines). 
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6. We want to locate the center of circle at the center of the fillet located in the upper
left corner of the drawing.  Move the cursor to this area and you will see two Visual
Aids appear when the end points of the fillet are recognized.

7. For the circle diameter enter 0.25  and press <Enter>.

8. Press <Enter> to repeat the command and draw a circle at the center of the lower
left fillet.

7.2.4 More Drawing Tools

More Drawing Tools

In this step you will learn a few additional curve creation and curve editing commands.
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1. Lets draw another circle.  From the Curve Modeling  tab select the

Circle on Point  command.

2. For the center point of the circle use the Visual Aids  to locate and select the

Mid Point  intersection of the upper and right side lines.

3. For the circle diameter enter 2.0 in the command window  and
press <Enter>.

4. Next we will draw a polar array of points around the circle we just drew. 

Why am I drawing Points?  Because when machining Hole Making
operations in CAM such as Drill, Tap, Bore, etc., you can select

points as Control Geometry!  The hole geometry DOES NOT have to be
present in the 2D drawing or 3D model in order to drill at that location.

5. From the Curve Modeling  tab select the Polar Grid of Points 
command.

6. For the total number of points on the circumference, enter 8.

7. For the angle of the first row about the X Axis enter 0.

8. Pick the center point for the polar grid or enter the coordinate values.  We want the
points centered around the 2" circle we just drew, so set you Object Snap to Center

Point  and move the cursor over the circle until the center point is highlighted
and the select it.
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9. For the polar grid radius, enter 1.250 and then press <Enter>.  The polar grid of
points will be created around the circle as shown below.

10. For this exercise we will also add the polar array of circles.  From the Curve

Modeling  tab select the Circle on Point  command.

11. For the center point, make sure the End Point Snap  is on and then select the
end point at the 12 o-clock position.

12. For the circle radius enter 0.25 and then press <Enter>.

13. Now we will duplicate the circle by creating a polar array.  First select the circle you
just created.  
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14. Then from the Modify / Transform  tab.

15. Select the Polar Array  command.  The Polar array selected objects
dialog will display.

16. The Number of Objects field should be 1.  This represents the circle that you have
selected.

17. Under the Axis Vector, the values should be X0, Y0, Z1.
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18. Under the Rotate About section, select the Pick About Point button.  The dialog will
minimize and wait for you to select a point.

19. From the Status Bar activate the Center Point Object Snap .

20. Now move the cursor over the 2" diameter circle until the center point is displayed
and then selected it.

21. The dialog will re-appear with the XYZ coordinated entered for the Rotate About
section.  The value should be X4.5, Y1.5 and Z0.

22. For the Number of Copies field enter 7.

23. The Angle to Fill field should be 360.

24. Now pick OK to close the dialog and the array should be drawn and selected.

25. Press <Enter> to accept the array and your drawing should look like the illustration

below.  If not, select the Undo  command and go back and repeat the previous
steps.
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26. Now we will drawing a slot.  From the Curve Curve Modeling tab 

select the Arc Center, Start, Angle command.

27. In the Status Bar make sure the Grid Snap is On .

28. For the center point select the grid point shown below or enter 1,1 in the command
window and press <Enter>.

29. Following the command prompts.  It says to select the start point of the arc.  Locate
and select the start point shown below or enter 1,0.75 in the command window and
press <Enter>.

30. For the arc end point move the cursor counter-clockwise and pick the end point

shown or enter 1,0.75 in the command window  and press
<Enter>.
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31. Now we want to draw another arc, press <Enter> to repeat the command and select
or enter the center, start and end points shown below.

32. Now we want to draw a line to connect the two arcs across the top.  From the Curve

Modeling tab  select the Line command .

33. For the start point for the line, set the Object Snap to End Point  from the Status
Bar and select the start and end of the top line of the slot.

34. Press <Enter> to repeat the Line command and select the start and end of the
bottom line of the slot.  Your drawing should look like this:
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7.2.5 Dimensioning

Dimensioning

In this step you will learn how to place dimensions on the drawing.

1. Start by using the middle mouse wheel to zoom out to leave yourself plenty of
room to place your dimensions.  If your mouse does not have a middle wheel, select

the Zoom Out  icon from the View Toolbar.  You can also use the Pan  icon
to pan the drawing within the display window.

2. Now change the active layer.  From the Status Toolbar select the Layer Manager 
 icon.

3. From the Layer Manager go to the Active column and check the box next to
Dimensions to make it the Active Layer.

4. From the Dimension  tab, select the Vertical Dimension 
command.

5. Activate the Object Snaps required (End , Center  and Grid )

6. Select the first and second points that you wish to dimension.

7. Then select a point to locate the dimension.  refer to the illustration below:
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8. Press <Enter> to repeat the command.

9. Select the first, second and location point for the dimension as shown below:

10. Repeat the command to create three additional vertical dimensions on the left as
illustrated below:
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11. Repeat the command to create three additional vertical dimensions on the right as
illustrated below:

12. Now we will create the horizontal dimensions.  From the Dimension 

 tab select the Horizontal Dimension  command.

13. Select the first second and location points to create the lower horizontal
dimensions shown below:
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14. Repeat the command to create the upper horizontal dimensions shown below:

15. Now we will create some leader lines.  From the Dimension  tab select

the Leader Line  command.

16. The first command prompts says: "Enter the text string."  We will add the annotation
separately so you can press <Enter> to continue.

17. The next prompt says: " Pick point or enter coordinates x,y, and z" Change the

Object Snap to Near  and select a point on the lower fillet for the first point.  
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18. Then pick additional points to define the leader line and the press <Enter> or right-
click to end the command.  The points to pick are shown in the illustration below:

19. Now repeat the Leader Line command and add the leader lines shown below:

20. Now we will add the annotation text.  From the Dimension  tab select

the Annotation  command.
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21. For the text string, at the command prompt  enter 0.50 in Fillet
(2 PLCS) and press <Enter>

22. Now select the text you just created and left-click-hold to drag it into position to the

left of the leader line as shown below.  If you toggle the Grid Snap  off you can
position the text more precisely. 

23. Repeat the Annotation command to create the additional leader text shown below:

24. Save the file as Drawing_and_Dimensioning_Completed.vcp.
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Congratulations you have completed this exercise!

7.3 #3: Model a Spanner Plate

In this exercise you will model the Spanner Plate shown below using Curve Modeling and Solid
Modeling tools.  The exercise includes the creation of Points, Lines, Fillets, Mirroring, Merging and
Extruding curves.

Model a Spanner Plate

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Set to the Top View.

2. Create Reference Points.

3. Create Inner Cutouts.

4. Trim Curves.

5. Offset, Extend & Trim Curves.
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6. Fillet Curves.

7. Mirror Curves.

8. Merge Curves.

9. Extrude Curves.

7.3.1 Set to the Top View

Set to the Top View

Set the view to Top View. This can be done by selecting the Top View icon from the View
Toolbar or the Orient pane of the Display Ribbon Bar.

View Toolbar

Display Ribbon Bar - Set to the Top View

7.3.2 Create Reference Points

Create Reference Points

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Select the Curve Modeling Ribbon Bar:
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Select the Curve Modeling Ribbon Bar

3. Select Point . 

4. Place the point at the Origin by moving the mouse cursor over to origin and with a

Left Mouse Button Click or by entering 0,0 in the command bar . 

5. As you move the mouse on the viewport, the co-ordinate value at the mouse
location is displayed under the status bar.

Create additional points by repeating the Create Point command at the following
coordinate locations.

2.5,0
5.0,0
7.0,0

The created points are as shown below.

7.3.3 Create Inner Cutouts

Create Inner Cutouts

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Keep the Curve Modeling Ribbon Bar displayed. 
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3. Select the Circle Center, Center, On Pt icon.

The command input bar  would now prompt you to specify the
center for the circle.

Command Prompt:
Center, On Pt:: Pick center point or enter coordinates x,y and z 

4. For the center point, pick last created point or type 7,0

Command Prompt:
Center, On Pt:: Enter point on circle::[D=0.500000] 

5. Specify 1.50 for Diameter in the command bar  and press Enter.

The created circle is as shown below.

6. Repeat the Circle command to create 2 more circles at the center points (2.5,0 and
5,0) enter a Diameter of 1.00 for each circle.
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7. From the Status Bar, toggle Grid Snap off and then toggle Quad Point Snap on.

  

8. Select the Create Single Line icon.

 

9. Create a line between the top quadrants points of the smaller circles.

10. Repeat the line for lower quadrant points.
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7.3.4 Trim Curves

Trim Curves

The circles must be trimmed. 

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Select Trim  

3. Click on the portion of the circle you want to delete.
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4. Repeat for the circle portion on the other side. 

7.3.5 Offset, Extend & Trim Curves

Offset, Extend & Trim Curves

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Keep the Curve Modeling Ribbon Bar displayed and then select the top horizontal
line.
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3. Pick the Offset Curve  icon from the Edit Curves pane.
A preview line will appear, indicating the direction of offset. Point the preview line
to offset the curve outward and then type 0.75 from the keyboard and press Enter.  

For Offset Curve, your cursor points to the offset direction, so do not

move the cursor to the Command Prompt  field. 
Simply type 0.75 and press Enter to input the value.

4. Repeat the offset for the horizontal line at the bottom, making sure to keep the
cursor and directional indicator line pointing downward.
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5. Select the larger circle on the right and then pick the Offset Curve icon again. 

6. With the cursor, point the offset direction outward from the circle, type 0.50 and
press Enter.
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7. To modify the offset lines so that they meet the larger circle, pick the Extend Curve

 icon from Edit Curves pane.  It is located just to the right of the Offset Curve
icon. 

8. Click one of the offset lines towards the right. The line extends to the point where it
meets the circle.
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9. Repeat the extend curve for the line at the bottom.

10. Select Trim  and trim the large circle where it meets the two extended lines.
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7.3.6 Fillet Curves

Fillet Curves

We will now create the left section of the spanner using the filleting and mirroring tools.
 We will start by creating the arc at the end of the spanner.

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. From the Curve Modeling Ribbon Bar, select Center, Start, Angle Pts. 

Command Prompt:
Center,Start,Angle Pts:: Pick center point or enter coordinates x,y and z 

3. For the Center, type 0,0 in the Command Prompt  and then press
Enter. 

4. For Start, type 0,1.25 in the Command Prompt  and then press
Enter. 
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5. For End, type -180 in the Command Prompt  and then press
Enter.
Your drawing should look like the following:

6. Now create a reference point located at 0,2.25 using the Point  command. 
The icon is located on the left side of the Curve Pane of the Curve Modeling Ribbon
Bar.

7.  From the Status Bar, toggle End Point Snap  On.

8. Now, select Rectangle . 

9. For the 1st corner pick the point you just created and for the other corner snap to
the End Point of the horizontal line as shown below.
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10. This rectangle is one object – one multi-segmented curve. In order to be able to edit
or modify this rectangle, it must be broken into individual lines. 

To do this, select the Explode icon.  It is located on the far right side of the Edit
Curves pane of the Curve Modeling Ribbon Bar. 

11. Select the rectangle and then right-click or press Enter.
Now each line of the rectangle is a separate object. 

12. Select Fillet .

Command Prompt:
Fillet:: Enter fillet radius [R=0.500000] 

13. For Radius enter 0.5 and press Enter. 

14. Select the 2 curves as shown below to fillet the curves.
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The filleted curve is as shown below.

15. Let's now create another arc.  Again, from the Curve Modeling Ribbon Bar, select

Center, Start, Angle Pts. 

Command Prompt:
Center,Start,Angle Pts:: Pick center point or enter coordinates x,y and z

16. For Center pick the end point on the upper right corner of the rectangle.

17. For Start pick the lower right corner of rectangle as shown below.
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18. For Angle, type in -90 and then press Enter to create an arc in the top right corner of
the rectangle.

The created Arc is shown below:

19. To clean up the corners we select Trim  again.

20. Select trimming curves to obtain the shape as shown below:
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7.3.7 Mirror Curves

Mirror Curves

We will now select the 4 curves that form the head of the spanner and mirror them.

1. Select the 4 curves as shown below. Hold down the Ctrl key to select multiple
objects.

2. With the 4 curves selected, you will notice that VisualCAD's Modify mode
automatically becomes active and that the Transform Ribbon Bar becomes available.
 Refer to the menu image below:
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The Transform Ribbon Bar is Activated

3. Now there are two methods to activate the Mirror command.  Select the method
that suits you best.
You can select the Transform Ribbon Bar tab and then select the Mirror icon as
shown:

The Mirror icon on the Transform Ribbon Bar

- or -

While the 4 curves are selected, you can simply Right-click and select Mirror from the
pop-up menu as shown below:
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Right-clcik Menu for Editing Objects

4. From the Mirror selected objects dialog box:

Set the Mirror Plane to XZ Plane
Leave Point (P) as Origin since the origin lies on the center line of the part.
Check Create Copy
Pick OK.

The curves are mirrored as shown below.
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7.3.8 Merge Curves

Merge Curves

Now we will merge our curves into three separate closed curves.

1. Select all the curves by using a crossing window selection:
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2. Now, go back to the Curve Modeling Ribbon Bar select the Merge Curves  icon
and then right-click or press Enter.  The curves are merged to 3 closed curves as
shown below.
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7.3.9 Extrude Curves

Extrude Curves

Now to complete the exercise we will extrude our 3 curves to create the final Spanner 3D
model.

1. Select all the curves by using a crossing window selection:

2. Select the 3 closed curves. 

3. Select Iso from the View Toolbar 

4. From the Solid Modeling Ribbon Bar, select Extrude. 
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5. Preview curves will appear to determine the direction of extrusion. 
Set the extrusion to point in the positive Z direction by moving the cursor above the
geometry.
Then type 1.0 in the command input bar and press the <Enter> key.

Command Prompt:
Extrude:: Enter extrusion distance::[L=1.000000]

The curves are now extruded and displayed as shown below.

6. Save the file as Spanner_Completed.vcp.

This completes this exercise. 
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7.4 #4: Model a Base Plate

In this exercise you will model something a bit more complicated, the base plate shown below. 
You will learn how to draw and model basic shapes to create this 3D model.

Model a Base Plate

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Draw the Base Plate Profile.

2. Extrude the Base Plate.

3. Model the Tube.

4. Create a New Layer.

5. Edit Geometry Properties.

7.4.1 Draw the Base Plate Profile

Draw the Base Plate Profile

In this exercise you will learn the following VisualCAD concepts:

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Now select the Rectangle command.

3. For the first corner of the rectangle, select the lower left grid point location shown

below or type -3,-3 in the Command Prompt  and press <Enter>.
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4. For the second corner of the rectangle, select the upper right grid point shown

below or type 3,3 in the Command Prompt  and press <Enter>. 
This will create a rectangle 6" square.

5. To fillet the corners, select the Fillet  command from the Curve Modeling

 tab.

6. For the fillet Radius, enter 0.5 in the command prompt  and
press <Enter>.

7. Now select the first edge to fillet as shown below.  Note: When selecting curves to
fillet, it is best to select furthest away from the corner that you wish to be filleted.
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8. Now select the second edge to fillet and a 0.5 radius fillet is added to the rectangle
as shown below.

9. Now press <Enter> to repeat the Fillet command and fillet the remaining 3 corners
of the rectangle as shown below.  If you make a mistake, you can select the Undo
command located on the Quick Access toolbar and try again.
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10. Now lets add the mounting holes.  From the Curve Modeling  tab,

select the Circle on Pt command. 

11. For the center point of the first hole select the grid point shown below or enter -

2.5,2.5 in the command prompt  and press <Enter>.

12. Now for the circle radius you can select the next grid point to the right of the center
point you just selected or enter 0.5 for the diameter and press <Enter>.



Exercises 485

© 2025 Mecsoft Corporation

13. Repeat the Circle on Pt command and draw the other three circles in the locations
shown below.

7.4.2 Extrude the Base Plate

Extrude the Base Plate

In this step we will extrude our drawing to model the base plate in 3D.

1. First, window select the drawing by picking two points.  Click and hold the left
mouse button to drag a window around the drawing as shown below.  If you drag
from left to right everything completely the window is selected.  If you drag from
right to left everything that cross over the window will be selected.
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2. After your drawing is selected, go to the Mesh Modeling tab  from

the Ribbon Bar and select the Extrude command. 

3. Now move the cursor down to the Front View  and you will see that
you can drag the height of the extrusion.  Select the second grid point in the
positive Z direction or type 0.5 and press <Enter>.

You will see the extrusion display in all four viewports.  The Iso View 1 
view is shown below.

4. Save your work by selecting the Save icon from the Quick Access toolbar.
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7.4.3 Model the Tube

Model the Tube

In this step we will draw two concentric circles and then extrude them to model the
circular tube that sits at the base plate.

1. Select the Top View  to activate it.

2. From the View Toolbar drop down the Display menu  and select Wireframe
Display.  This will allow us to better see our next drawing.

3. Now from the Curve Modeling  tab select the Circle on Point

command again. 

4. For the center point select the grid point at 0,0 center of the drawing.

5. Now for the circle diameter you can select the grid point shown below or type in 3
and press <Enter>.  A circle 3" in diameter is drawn.
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6. Now repeat the command, this time drawing a circle with a diameter of 2.5" in
diameter.

7. Once the two concentric circles are drawn, select them both.  You can window select
them or while holding down the <Ctrl> key, just pick both of them.

8. With the two circles selected, go to the Mesh Modeling  tab and

select the Extrude  command again.

9. Now move the cursor to the Front View  and select the grid point
located at 3" in the positive Z direction as shown below.
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10. The center tube is now created and shown in each window.

11. Save your work by selecting the Save icon from the Quick Access Toolbar.
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12. Activate the Right View  by selecting anywhere on the grid.

13. From the View Toolbar, drop down the Display  menu and select Wireframe
Display.  Again, this will allow us to better see our next drawing.

14. From the Curve Modeling  tab, select the Circle on Pt 
 command again.

15. For the center point of the circle, select the grid point shown below.

16. Now for the circle diameter you can select the grid point shown below or enter 1.0
for the diameter.
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17. Now select the circle you just created, then go to the Mesh Modeling 

 tab and select the Extrude  command again.

18. For the length of the cylinder move the cursor over to the Front View 
 and select the grid point shown below.

19. Now select the cylinder and toggle the display of the Graphic Manipulator  on. 
This toggle icon is located on the Status Bar at bottom of the display.



VisualCAD 2025 Companion492

© 2025 Mecsoft Corporation

20. With the cylinder selected pick on the red X axis of the Graphic Manipulator to

display the input box and enter -2.25  and press <Enter> as
shown below.

The cylinder is translated to the left negative X direction by 2.25 inches so that it
passes complete through the tube on both sides.

21. You can toggle the Graphic Manipulator  off.

22. From the Mesh Modeling  tab, select the Subtract command . 
It's located in the Edit Meshes pane.  We are going to Subtract the cylinder from the
tube.

23. For the first mesh select the tube.

24. For the second mesh select the cylinder.  The hole is created in both sides of the
tube.
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7.4.4 Create a New Layer

Create a New Layer

In this step we will create a new layer, turn it off and the move our curves to it to hide
them from the display.

1. From the Status Toolbar, select the icon to display the Layer Manager .

2. At the top of the Layer Manager select the New Layer icon and a new layer will be
added to the list. 
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3. Now double-left click on the New Layer name and type in the names "Curves" and
press <Enter>.

4. Now to hide the Curves layer first check the box to make the Default layer the
Active layer.

5. Then uncheck the box to make the Curves layer hidden.

6. Now let's Auto Hide the Layer Manager.  Select the Auto Hide pin  icon located at
the top right of the Layer Manager and will see that the dialog disappears to the left
side of the screen.
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7.4.5 Edit Geometry Properties

Edit Properties of Geometry

In this final step we will select all of our reference curves and edit their properties so
that they are moved to a layer whose visibility is currently off.

1. Let's start by selecting the Properties icon  located on the Status Toolbar at the

bottom of the display (just to the left of the Layer Manager  icon).

2. You will see the Properties Manager dialog display om the left side of the display.

3. Now we will automatically select all of our curve geometry.  Go to the Modeling

Aids tab and select pick the Select by Type  icon.  This will display the
Object Selection Filters dialog.
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4. From the dialog check the box for Curves and uncheck all other boxes and then pick
OK to close the dialog.  You will see that all of the curves are highlighted for
selection.
Now go to the Properties Manager and under the Objects section drop down the
menu for Layer and select Curves.

5. Now close the Properties Manager by selecting the Auto Hide pin located at the top
right of the Properties Manager.
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6. This exercise is complete and your part now looks like this:

7. Save the file as Base_Plate_Completed.vcp.

7.5 #5: Model a Mold Insert

In this exercise you will model something a bit more complicated, the mold insert shown below. 
It builds upon the tasks you have learned in the previous exercises.  You will draw curve profiles
and then turn them into part features.  The Graphic Manipulator is used extensively in this
exercise as well as modeling from multiple viewports.  Just go slowly and save your work often
and Undo if needed.
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Model a Mold Insert

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Extrude the Body.

2. Extrude the Flange.

3. Extrude the Upper Pocket.

4. Extrude the Lower Pocket.

5. Revolve the Center Bosses.

6. Extrude the Connection Bar.

7. Extrude the Connection Wall.

8. Extrude Ejector Pin Holes.

9. Change Geometry Layer.

10. Create Section Curves.

7.5.1 Extrude the Body

Extrude the Body

In this step we will model the body by creating an extrusion.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Select the Curve Modeling tab  from the top Ribbon Bar.

3. Now select the Arc Center, Start, Angle command.
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4. In the Status Bar make sure the Grid Snap is On .

5. For the center point select the grid point shown below.  The status bar will track
where your cursor is located in World Coordinates.  Move the cursor until the grid
point at 1.5,0,0 is located and pick it.

6. Following the command prompts .  It says to select the start
point of the arc.  Locate and select the start point shown below.

7. For the arc end point move the cursor clockwise and pick the end point shown.  You
will see that the arc is previewed as you move the cursor.

8. Now we want to draw another arc, press <Enter> to repeat the command and select
the center, start and end points shown below.

9. Now we want to draw a line to connect the two arcs across the top.  From the Curve

Modeling tab  select the Line command .

10. For the start point for the line select the grid point located at the top end of the arc
of the left and then for the end point of the line select the top end of the arc on the
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right.  Optionally, you can set the Object Snap to End Point  from the Status Bar
and select the end points of the arcs to draw the line.

11. Press <Enter> to repeat the Line command  and draw the second line
connection the two arcs across the bottom.  Your drawing should look like the image
below.

12. For modeling its best that you merge your profile geometry into a single curve
entity.

13. Window select the geometry (both arcs and both lines) and from the Curve

Modeling tab  select the Merge Curves  command and then
right-click the mouse to merge them.  If you pick anywhere on the geometry you
will see that one curve is now defined.
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14. Now lets create the body by extruding our profile curve.  With the curve selected,

change to the Mesh Modeling tab  and select the Extrude Mesh

 command.

15. For the extrusion distance, drag the cursor down to the Front View  and
select the grid point shown below.  Its located at 2.0" below the selected curve. 

The Mesh Solid is created and shown below.

7.5.2 Extrude the Flange

Extrude the Flange
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Now we will extrude the flange.

1. Activate the Top View  by selection the profile curve you just created. 
You will notice that a selection list pops up because there is now more than one
entity in the same located.

Note: If the Selections menu shown below does not display, go to the Home tab in
VisualCAD and select Options.  Then under System clear the check box next to Use
Preselection Highlight.

2. From the selection list pick Curve.  The number value to the right of the curve may
change depending on when the entity is created.

3. With the curve selected, from the Curve Modeling tab  select the

Offset Curve  command.

4. If you move the cursor you see that an offset direction is indicated.  Move the cursor
below and on the outside of the curve as shown below.

5. Most of the time in this exercise we are selecting grid points.  The distance between
each grid point is 0.25".  For the offset distance you can select the next grid point
below the curve.  
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Optionally, while the offset direction is displayed you can enter 0.25

 and press <Enter> to create the offset curve shown below.

6. Now select the offset curve you just created, go to the Mesh Modeling tab

 and pick the Extrude Mesh  command again.

7. Drag the cursor to the Front View  and pick the second grid point below
the selected curve.  The cursor indicates that the extrusion length is 0.500".

The flange is created and displayed.
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8. Now lets move the flange to the bottom of the body.  To do this we will use the
Graphic Manipulator.  To toggle the Graphic Manipulator on, go to the Status Bar and

select the icon .

The Graphic Manipulator allows you to easily translate or rotate a selected entity in
or about the X, Y or Z of the World Axis.

9. Now select the flange and you will see that the Graphic Manipulator is displayed on
top of the selected entity.

10. Pick on the blue Z Axis arrow to display the input window.

11. Enter -1.5  and press <Enter>.

The flange is moved 1.5" in the negative Z direction.
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12. Now lets unite the flange with the body.  From the Mesh Modeling tab,

 select the Unite Mesh  command.

13. For the first mesh solid select the body.

14. For the second mesh solid select the flange.  The two will be joined into one mesh
solid.

7.5.3 Extrude the Upper Pocket

Extrude the Upper Pocket

In this step we will create the upper pocket and subtract it from the body.

1. From the Top View  select the profile curve of the body by clicking on it
and selecting Curve from the selection list.
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2. With the curve select, go to the Curve Modeling tab  and select the

Offset Curve  command.

3. Drag the offset direction to the inner side of the curve and then enter 0.05

 and press <Enter>.
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4. Now select the offset curve, go to the Mesh Modeling tab  and select

the Extrude Mesh  command.

5. Drag the cursor down to the Front View  and select the grid point at
0.750" as shown below.

6. Now to see the pocket mesh solid, from the View Toolbar  select the
Wireframe Display item from the display menu.

7. We want to move the pocket mesh solid so make sure the Graphic Manipulator icon

is still toggled on  (it's located on the Status Bar remember?).

8. With the Front View  set to Wireframe display you can see to select the
pocket mesh solid.  Select it now and the Graphic Manipulator will display on it.

9. Select the blue Z Axis arrow and enter 0.25  and press <Enter>. 
The pocket mesh solid will move upward 0.25".
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10. From the View Toolbar  drop down the display menu and select Toggle
Shading + Edges.

11. Now lets subtract the pocket from the body.  From the Mesh Modeling tab

 select the Subtract Mesh  command.

12. For the first mesh solid select the body.  This is the solid that will be subtracted
from.  You can do this from any Viewport.  We will select it from Iso View 1

.
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13. Now for the second mesh solid, select the pocket solid and it will be subtracted
from the body.

7.5.4 Extrude the Lower Pocket

Extrude the Lower Pocket 

In this step we will create the lower pocket mesh solid and subtract it from the body.

1. We will start in the Top View  so select anywhere in that view to activate
it.

2. Now we will create two partial arcs, each 270 degrees.  From the Curve Modeling tab

, select select the Arc Center, Start, Angle command  again.

3. Select the center point first and then select the start point.  Both are shown below.



VisualCAD 2025 Companion510

© 2025 Mecsoft Corporation

4. Now for the end point of the arc, drag the cursor counter clockwise until the arc
preview is at 270 degrees as shown below.

5. Now press the <Enter> key to repeat the command.  This time select the center,
start and end points shown below.

You drawing should now look like this:
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6. Now we will rotate each arc 45 degrees to position them properly.  Toggle the

Graphic Manipulator on , select the first arc.

7. This time we will use the Graphic Manipulator's rotate feature.  Select the blue Z

Axis arc, enter -45  and then press <Enter>.

The arc is rotated negative 45 degrees about the Z axis as shown.

8. Now select the second arc, pick the Z axis arc, enter 45 and press <Enter>.
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The second arc is rotate 45 degrees about the Z axis as shown.

9. To complete the second pocket profile we will fillet the two arcs.  From the Curve

Modeling tab  select the Fillet  command.

10. Enter 1.0 for the fillet radius and press <Enter>.

11. Now pick the first arc near the end shown.

And then pick the second arc near the end shown to create the 1" fillet between the
two arcs.
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12. Press <Enter> to repeat the Fillet  command.

13. Select the two arcs near their ends to create the second fillet as shown.

14. Now select the four arcs.  You can press the <Ctrl> key to select multiple entities.
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15.  Now from the Curve Modeling tab  select the Merge Curves 
command and then right-click or press <Enter> to merge them into one curve.

16. With the curve still selected go the Mesh Modeling tab  and select

the Extrude Mesh  command one again.

17. Drag the cursor down to the Front View  and select the grid point that is
1.50" below the selected curve to create the second pocket mesh solid.

18. Now once again from the Mesh Modeling tab  select the Subtract

Mesh  command and for the first solid, pick the body.

19. Now for the second solid pick the second pocket mesh solid and it will be
subtracted from the body as shown.
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7.5.5 Revolve the Center Bosses

Revolve the Center Bosses

In this step we will create the two center bosses by revolving a profile to create a mesh
solid, mirror it to create the second boss and then add both bosses to the body.

1. From the Front View,  select Wireframe Display from the Display

 menu on the View Toolbar.

2. From the Curve Modeling tab,  select the Polyline  command.

3. Pick the grid point shown below for the first point on in the polyline.

4. Then pick the remaining 9 grid points to complete the closed polyline.  The last grid
point is the same as the first grid point.  This forms a closed polyline.
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5. Now select the polyline, and then go to the Mesh Modeling tab  and

select the Revolve Mesh  command.  You can toggle off the Graphic

Manipulator  as we do not need it here.

6. The command prompt  says to pick the start point of the axis of
rotation.

7. Now pick the second point on the axis of rotation as shown.
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8. The revolved mesh solid is created and can be best viewed from Iso View 1

.

9. Now go to the Front View  and select the boss mesh solid we just
created.
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10. With the boss mesh solid selected you will see the Modify / Transform tab

 appear on the right end of the Ribbon Bar.  It ONLY appears when an
entity is selected.

11. From the Transform tab, select the Mirror  command to display the
Mirror selected objects dialog.

12. In this dialog, set the Mirror Plane to YZ Plane, check the box next to Create Copy,
verify that the Number of objects picked value is 1 and then pick OK. 

The mesh solid you selected:
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Has now been mirrored about the YZ plane creating a second copy as shown.

 

13. Now lets unite the two bosses with the body.  From the Mesh Modeling tab,

 select the Unite Mesh  command and then select the body.

14. Now select the second solid to unite (i.,e. the one of the two bosses we just
created.)
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15. Now press <Enter> to repeat the Unite Mesh  command and select the body
solid one again.

And then select the other boss solid to unite them.

7.5.6 Extrude the Connection Bar

Extrude the Connection Bar
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In this step we will create the square bar that connects the two bosses at the base of the
second pocket.

1. First activate the Right View  and then from the Display menu 
on the View Toolbar, select Wireframe Display.

2. From the Curve Modeling tab,  select the Rectangle 
command.

3. Select the grid points for the 1st and 2nd corners of the rectangle as shown.

4. Now from the Mesh Modeling tab,  select the Extrude Mesh 
command.

5. Pick the rectangle we just created and drag the cursor over to the Front View

 and pick the Grid point located 3.00" to the right as shown below.
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6. Now we want to use the Graphic Manipulator again so go to the Status Bar and make

sure it is toggled On .

7. Select Iso View 1  and right-click the mouse and drag rotate the part
until you get a good view of the Connection Bar and select it.

8. From the Graphic Manipulator pick the red X axis arrow, enter -1.5

 and then press <Enter> to see the Connector Bar move to the
left to line up on center between the two bosses as shown.
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9. Now again we will unite the Connector Bar with the Body.  From the Mesh Modeling

tab,  select the Unite Mesh  command and select the body for
the first mesh solid and the then select the Connector Bar to unite them.

7.5.7 Extrude the Connection Wall

Extrude the Connection Wall

In this step we will create the wall that pass between the two center bosses.
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1. Again, activate the Right View  and then from the Display  menu
on the View Toolbar, select Wireframe Display.

2. From the Curve Modeling tab,  select the Circle on Point 
command.

3. For the center point select the grid point shown below.

4. Enter 0.25  for the diameter and press <Enter>.

5. Press <Enter> again to repeat the command.  For the second circle select the grid

point shown below and then enter 0.10  for the diameter and
pres <Enter>.  We will use these two circles to locate the corners of a polyline that
defines the cross-section of the connection wall.

6. Now from the Curve Modeling tab,  select the Polyline 
command.

7. From the Status Bar toggle on the Quad Point Snap  and toggle off all of the
other object snaps.

8. We will be drawing a 4-sided closed polyline that encompasses the yellow area
shown in the image below.  For the start point of the polyline select the quad point
on the right side of the lower 0.25" diameter circle at the #1 location shown.

9. Then continue, by selecting the Quad point located at the right side of the upper
0.10" diameter circle.

10. For the next point in the polyline select the Quad point on the left side of the upper
0.10" diameter circle at the #3 location.

11. Then continue by selecting the Quad point at the #4 location.
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12. To complete the polyline select the Quad point at the #1 location where the

polyline started.  The Polyline  command will end automatically when the end
point coincides with the start point.

13. Now you can delete the two circles.  Just select them and press the <Del> key.

14. Now we will extrude the 4-sided polyline to create the Connecting Wall.  First select
the polyline we just created.
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15. Now go to the Mesh Modeling tab  and select the Extrude Mesh

 command again.

16. Drag the cursor to the Front View  and drag the length of the extrusion
to the right of the center line where the selected polyline resides.  Refer to the
image below.

17. The point we want is not on a grid point, so with the extrusion previewed (do not

select a point), go to the command prompt  and type in the
distance 2.300 and press <Enter>.  

The Connection Wall is created.
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18. Now from Iso View 1  select the Connection Wall to display the Graphic

Manipulator.  If you do not see it, make sure it is toggled on from the Status Bar 
.

19. Pick the red X Axis arrow and type in -1.15  and press <Enter>. 
The Connection Wall should move into place at the center spanning between the
two bosses as shown in the image below.

20. Now lets unite the Connection Wall with the body.  Go to the Mesh Modeling tab

 and select the Unite Mesh  command.

21. For the first mesh solid, select the body.
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Then select the Connection Wall to unite it with the body.

7.5.8 Extrude Ejector Pin Holes

Extrude the Ejector Pin Holes

In mold design, ejector pins are used to eject the molded part from the cavity side of the
mold.  As the mold press opens, the ejector pins slide and protrude through the cavity
forcing the plastic part out of the mold where it falls into a catch bin.  The ejector pin
holes pass complete through the insert.

1. Activate the Top View  and then go to the Curve Modeling tab

 and select the Circle on Point  command.

2. We will draw a total of 4 holes.  Two will be 0.3125" in diameter (located at #1 and
#2) and two will be 0.3750" diameter (located at #3 and #4).
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3. Select the grid point at the #1 location and then enter 0.3125 in the command

prompt  and then press <Enter>.

4. Press <Enter> to repeat the command.

5. Select the grid point at the #2 location and press <Enter> again to accept the new
default diameter.

6. Now press <Enter> to repeat the command, select the grid point at the #4 location

and then enter 0.375 in the command prompt  and then <Enter>.

7. Now press <Enter> again, select the grid point at the #4 location and press <Enter> to
accept the new default diameter.  The 4 circles are drawn.

8. Now with the <Ctrl> key pressed, select the 4 holes, go to the Mesh Modeling tab

 and select the Extrude Mesh  command.

9. Now move the cursor down to the Front View  and drag the extrude
length down past the bottom of the body and pick the grid pint located at 2.500"
below the part.

The 4 mesh solids are created:
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10. Now let's move the 4 ejector pin holes upward to pass through the body
completely.
Window select right to left so that the cross-hatched window passes through all 4
ejector pin mesh solids.

11. If the Graphic Manipulator does not display, pick the icon on the Status Bar to toggle

it on .

12. Select the Blue Z arrow and in the input window enter 0.25  and
press the <Enter> key twice.  The first accepts the value and the second to move the
mesh solids.

Activate the Right View  and we see the ejector pin mesh solids.
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13. Now to subtract the ejector pin mesh solids from the body to create the ejector pin

holes go to the Mesh Modeling tab  and select the Subtract Mesh

 command.

14. Select the body as the first mesh solid.

15. Then select the 0.3125" ejector pin mesh solid on the right to subtract it from the
body.

16. Press the <Enter> key to repeat the Subtract Mesh  command and select the
body again as the first mesh solid.

17. Then select the 0.3125" ejector pin mesh solid on the left to subtract it from the
body.

18. Press the <Enter> key to repeat the Subtract Mesh  command and this time

to subtract the 0.3750" ejector pins move to the Front View .
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19. Select the body again as the first mesh solid.

20. This time select the 0.3750" ejector pin mesh solid on the right to subtract it from
the body.

21. Press the <Enter> key again to repeat the command and then select the body mesh
solid.

22. Now select the remaining 0.3750" ejector pin mesh solid to subtract it from the
body.

You will now see that the 4 ejector pin hole locations pass completely through the
mold insert as shown in the images below:
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7.5.9 Change Geometry Layer

Change Geometry Layer

We have a lot of curves displaying on the part.  Let's clean them up.

1. Display the Layer Manager.  You can pick the Layer Manager icon  located on the
Status Bar or select the Layers flay-out tab located on the left side of the drawing
window.  If you recall we unpinned the Layer Manager allowing it to collapse to the
side of the screen.

2. From the Layer Manager select the Add Layer icon  to add a new layer.

3. Now lets rename the new layer to Curves.  First double-left-click in the Name field
to activate it, and enter Curves as the new layer name.

4. Next lets make the Default layer the Active Layer by checking the box in the Active
column for the layer Default.  The Default layer is now the active layer.  Let's also
uncheck the box in the visible column for the Curves layer.  Now any geometry
placed on the Curves layer will be hidden from view.  Your Layer Manager should
look like the one shown below.
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5. Now VisualCAD has a quick way of selecting entities by type.  Go to the Modeling

Aids  tab and select the By Type  icon.  This command
displays the Object Selection Filters dialog that allows you to check mark the
entities that you want to select.  That dialog is shown below:

6. Place a check mark in the box for each of the following entity types: Point,
Line,Polyline, Arc, Circle, and Curve.

7. Now pick the OK button.  You will see that all of the reference curves we created in
this exercise are highlighted for selection.
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8. With the entitles selected, select the Properties  icon from the Status Bar.  Its

located just to the left of the Layer Manager  icon.

9. The Properties Manager will display on the left side of the screen similar to the
Layer Manager.

10. At the top of the Properties Manager select the Edit  icon.  This will display
additional fields that you can edit.

11. We want to change the layer of the curves so drop down the layer menu by

selecting the menu indicator  on the right side in the Layer row and select the
new layer named Curves that we recently created and hidden.

12. Now when you click anywhere in the drawing window you will see that all of the
curves have been moved to the Curves layer and are not hidden from view.
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7.5.10 Create Section Curves

Create Section Curves

Congratulations, our part is now nearly complete!  However, we do want to create cross-
section curves that will aid you when it comes time to create a detail drawing of the part.

Section curves are drawn parallel to the active Viewport.  So the first step is to select the
view that you want the section to be parallel to.  We want to create three sections, one
through the center parallel to the Front View and another two through each boss parallel
to the Right View.

1. First lets again create a new layer and make it the active layer so that the section
curves will be assigned to that layer automatically when they are created.

2. Display the Layer Manager  one again.

3. Create a new layer and name it Sections and also make it the active layer.  The Layer
Manager should look like this:

4. Now go to the Curve Modeling tab  and select the Section Curve 
command.  The Create section curves dialog will display.



Exercises 537

© 2025 Mecsoft Corporation

5. First select anywhere in the Front View  to activate it.

6. Now if you move the slider in the dialog you will see the section curves move along
the part.

7. We want the location of the section to be precise so lets pick the Button that says
"Pick point on model".

8. Now from the Top View  pick the grid point location at the center of one
of the two bosses as shown below.  Notice that the Top View IS NOT ACTIVE.  We

want the Front View  to stay active while the section point is picked.

9. When you pick the point at the center of the boss, you will see the section curves
display on the part.  They pass through the center parallel to the Front View just like
we want.

10. Now press the <Enter> key to repeat the section command and then activate the

Right View .

11. From the Create section curves dialog select the button again that says "Pick point
on model".
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12. Now from the Top View  pick the grid point location at the center of the
boss on the right side.  Notice that the Top View IS NOT ACTIVE.  We want the Right

View  to stay active while the section point is picked.

13. When you pick the point at the center of the boss, you will see the section curves
display on the part.  They pass through the center of the boss parallel to the Right
View just like we want.

Congratulations!!  You modeled your Very first mold insert using VisualCAD! 

14. Save the file as Insert_Completed.vcp.

7.6 #6: Model a Connector Block

In this exercise you will model the Connector Block shown below.  It too builds upon the tasks you
have learned in the previous exercises.  You will draw curve profiles and then turn them into part
features.  The Graphic Manipulator is again used extensively in this exercise as well as modeling
from multiple viewports.  Again, just go slowly and save your work often and Undo if needed.
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Model a Connector Block

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Model the Main Body.

2. Model the Front Access.

3. Model the Top Access.

4. Model the Mounting Holes.

5. Modify the Top Access.

6. Create Section Curves.

7.6.1 Model the Body

Model the Main Body

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Now select the Rectangle command.
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3. Turn on Grid snap  and turn off all other object Snaps.  Object Snap toggles are
located on the Status Toolbar at the bottom of the display.

4. For the first corner of the rectangle, select the lower left grid point location shown

below or type -1.5, 0, -1.5 in the Command Prompt  and press
<Enter>.

5. For the second corner of the rectangle, select the upper right grid point shown

above or type 3,3 in the Command Prompt  and press <Enter>. 
This will create a rectangle 3" square.

6. Now select the rectangle you just drew and then from the  tab select

the Extrude Mesh  command.

7. Now drag the cursor over to the  and select the grid point at 4.5 or just

enter 4.5 in the command prompt  and press <Enter>.

Your part should look like this in Iso View 1:
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7.6.2 Model the Front Access

Model the Front Access

1. Activate the .

2. From the tab  select the Rounded Rectangle  command.

3. For the first corner of the rectangle, select the lower left grid point location shown

below or type 1.25,1.25,0 in the Command Prompt  and press
<Enter>.

4. For the second corner of the rectangle, select the lower left grid point location

shown below or type 1.25,1.25,0 in the Command Prompt  and
press <Enter>.

5. Now for the corner radius select the Grid point shown below or enter 0.5 in the

Command Window  and press <Enter>.
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6. Now select the rounded rectangle you just created and from the  tab,

select the Extrude Mesh  command.

7. Move the cursor over to the  and select the Extrude Length at the 1.000

Grid point or enter 1 in the command window  and press
<Enter>.

The extruded profile is shown below.
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8. Now we will move the extrusion so that it intersects the body.  Activate the Graphic

Manipulator  from the Status Bar.

9. Select the extrusion mesh solid to display the Graphic Manipulator .

10. Pick the Green Y axis of the Graphic Manipulator  and enter 0.25 in the input
field and press <Enter>.  The extrusion will move in the Y direction the amount
specified.

11. Press <Enter> again to accept the move.

12. Now activate the  window and from the  tab select the

Subtract Mesh  command.

13. For the first mesh solid select the Body.

14. For the second mesh solid select the extrusion.  The extrusion will be subtracted
from the Body as shown below.
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15. Now activate the Top View.

16. Select the View  menu from the View Toolbar and then select Ghosted
Display. Note: The View Toolbar will only display in the active viewport.

17. Now from the Curve Modeling  tab select the Polyline  command.

18. You will select the grid points shown below to define a closed polyline.  The first
grid point is the same as the last grid point.
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In Iso View 1 the closed curve polyline looks like this:

19. Now select the closed curve polyline you just created and from the 

tab select the Revolve Mesh  command.

20. The command line  prompts you to "Pick start point if axis of
revolution or enter coordinates x,y and z".  Pick the grid points shown below for the
start and end points of the axis of revolution.
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The Revolve mesh solid is created.

21. Now you want to subtract it from the Body.  From the  tab select the

Subtract Mesh  command.

22. For the first mesh solid select the Body.

23. For the second mesh solid select the Revolve. 
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The Body is updated and should look like the image below.

7.6.3 Model the Top Access

Model the Top Access
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1. Activate the .

2. Select the View  menu from the View Toolbar and then select Wireframe
Display. Note: The View Toolbar will only display in the active viewport.

From the  tab select the Rounder Rectangle  command.

3. For the first corner of the rectangle, select the upper right grid point location shown

below or type 1.25,1.25,0 in the Command Prompt  and press
<Enter>.

4. For the second corner of the rectangle, select the lower left grid point location

shown below or type 1.25,1.5,0 in the Command Prompt  and
press <Enter>.

5. Now for the corner radius select the grid point shown below or enter 0.5 in the

Command Window  and press <Enter>.
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6. Now select the rounded rectangle you just created and from the  tab,

select the Extrude Mesh  command.

7. Move the cursor down to the Front View and select the Extrude Length at the 2.000

Grid point or enter 0,0,2 in the command window  and press
<Enter>.

8. Now activate Iso View 1 and from the  tab select the Subtract Mesh

 command.

9. For the first mesh solid select the Body.
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10. For the second mesh solid select the extrusion.  The extrusion will be subtracted
from the Body as shown below.

11. The top access has an additional pocket near the front of the body that needs to be
modeled.

12. Activate the  again.

13. From the  tab select the Rounded Rectangle  command.

14. For the first corner of the rectangle, select the lower left grid point location shown

below or type -1,0.5,0 in the Command Prompt  and press
<Enter>.
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15. For the second corner of the rectangle, select the upper right grid point location

shown above or type 1,2.75,0 in the Command Prompt  and
press <Enter>.

16. Now for the corner radius select the grid point shown below or enter 0.5 in the

Command Window  and press <Enter>.

17. Now select the rounded rectangle you just created and from the  tab,

select the Extrude Mesh  command.

18. Move the cursor down to the  and select the Extrude Length at the

2.000 Grid point or enter 0,0,2 in the command window  and
press <Enter>.
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19. Now from , select the extrusion you just created to display the Graphic

Manipulator .

20. Click on the Blue Z Axis arrow and enter 1.25  to translate the
extrusion upward as shown in the illustration below.
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21. From the  tab select the Subtract Mesh  command.

22. For the first mesh solid select the Body.

23. For the second mesh solid select the extrusion you just created.

7.6.4 Model the Mounting Holes

Model the Mounting Holes

In this step we will model the tap drill mounting holes in the front and top access.  Note:
For machining purposes only a Point is required to perform a hole making operation.  We
are only modeling the holes here for learning purposes.

1. Activate the .

2. To locate the center of the first hole you will draw two lines on the grid.  From the

Curve Modeling  tab select the Line  command.



VisualCAD 2025 Companion554

© 2025 Mecsoft Corporation

3. Draw the two lines shown below.  The first starts at the center and ends at the top
left corner.  The second passes diagonally across two grid points bisection the first
line at 90 degrees.

4. Now from the Curve Modeling  tab select the Circle  command.

5. For the circle center, activate the Intersect Object Snap  from the Status Bar and
then move the cursor over the intersection of the two lines until you see Int display
next to the cursor and then select the intersection point.

6. For the circle diameter enter 0.1959 in the Command Window 
 and press <Enter>.  This is the #7 drill diameter for a 1/4-20 tap.

7. Now you need 4 of these holes.  Let's use the mirror command to create the other
three.  First select the circle you just created, then go to the Modify / Transform

 tab and select the  command.
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Note that the Modify / Transfer tab ONLY appears when an entity is selected!

8. From the Mirror selected objects dialog, the Number of selected objects should be
1, The Mirror Plane should be YZ Plane and box next to Create Copy should be
checked. 

9. Pick OK from the dialog and the circle will be mirrored and both circles should be

selected automatically.  If not, select both of the circles and pick the 
command again.
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10. This time from the Mirror selected objects dialog, the Number of selected objects
should be 2, The Mirror Plane should be XY Plane and box next to Create Copy
should be checked.

Note: You do not have to select the geometry first, as you can see this dialog has a
Pick Objects button.

11. Now with all 4 circles drawn, all 4 should be selected automatically.  If not select
them now.

12. Now go to the  tab and select the Extrude Mesh  command.

13. For the extrude length move the cursor to the  and select the grid point
at 0.500" in the positive Z direction or simple enter 0.5 in the command window

 and press <Enter>.
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14. Now let's subtract the extrusions from the body to create the holes.  Go to

 and from the  tab select the Subtract Mesh 
command.

15. For the first mesh solid select the body.

16. For the second mesh solid select one of the extrusions to subtract it.

17. Press the <Enter> key to repeat the command.  This time select the body and then
the second extrusion.

18. Repeat the command two more time until all 4 extrusions are subtracted from the
body as shown below. 
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19. Now we have 2 additional holes of the same diameter located in the top access. 

Activate the .

20. Let's change the display mode for the Top View.  Select the Display menu from the
View Toolbar in the Top View and select Toggle Shaded + Edges.

21. To locate the first hole, go to the Curve Modeling  tab and select the

Line  command.

22. Pick the two grid points shown below for the start and end points of the line.  The
line should bi-sect the two grid boxes from left to right as shown below.

23. Now from the Curve Modeling  tab select the Circle  command.
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24. From the Stats Bar activate the Mid Point Object Snap  and deactivate all of the
others.

25. For the center point of the circle select the mid point of the line you just created
shown in the illustration above.

26. For the circle diameter enter 0.1959 in the Command Window 
 and press <Enter>.

27. Now select the circle you just created and go to the  tab and select the

Mirror  command.

28. From the Mirror select objects dialog the Number of selected objects should be 1,
the Mirror Plane should be YZ Plane and the Create Copy box should be checked.

29. Now pick OK to mirror the circle.

30. Both circles should now be selected.  If not select them both now.
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31. With the circles select go to the  tab and select the Extrude Mesh

 command.

32. From the Status Bar activate the Grid Object Snap  and deactivate the others.

33. Move the cursor down to the  and select the grid point to set the
extrusion length to 0.500" in the negative Z direction or simply enter 0.5 in the

command window  and press <Enter>.

34. Now select the two extrusions and go to the .  Make sure the Graphic

Manipulator  is toggled On.

35. From the Graphic Manipulator, pick the Blue Z Axis arrow and then enter 0.25 in the
input window and press <Enter>.  The extrusions will translate up in the Z axis 0.25".
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36. Now subtract them from the body.  From the Curve Modeling  tab

select the Subtract Mesh  command.

37. For the first mesh solid select the body.  For the second mesh solid select one of the
extrusions.

38. Press <Enter> to repeat the command and subtract the second extrusion from the
body.
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7.6.5 Modify the Top Access

Modify the Top Access

In this step we need to make a few modifications to the top access.  The first is an
extruded cut at the back of the access.  The second is a revolved cut.

1. Activate the .

2. From the  tab select the Rounded Rectangle  command.

3. For the first and second corners of the rectangle select the grid points shown below.

4. For the corner radius, enter 0.125 in the command window  and
press <Enter>.

5. Now select the rectangle and from the  tab select the Extrude Mesh

  command.

6. Move to the  and drag the extrude length to 1.750".
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7. Now go to the  tab and select the Subtract Mesh  command
again.

8. For the first mesh solid select the body.  For the second mesh solid select the
extrusion.

9. For the second modification, got to the  and from the  tab

select the Rectangle  command.

10. Select the two corner grid points shown below.

11. Now we need to fillet one of the corners.  From the  tab select the

Fillet Curve  command.

12. In the command prompt  enter 0.125 for the fillet radius and
press <Enter>.
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13. Now select the top and left side of the rectangle to fillet the upper left corner as
shown below.

14. We need to revolve this, so select the closed rectangular profile, go to the

 tab and select the Revolve Mesh  command.

15. For the axis of revolution, select the two grid points shown below.

16. Now subtract the revolve from the body.  From the  tab select the

Subtract Mesh  command.

17. For the first mesh solid select the body and for the second select the revolve.
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7.6.6 Create Section Curves

Create Section Curves

Your almost done!!  In this step we want to create some section curves in the Top and
Right side views.  The section will appear on the XY Plane (for the Top view) and on the

ZY Plane for the .

1. First lets move all of our curves onto a separate layer and hide them.  From the

 tab, select the  command.  This icon is located on the

Selection pane of the  tab.

2. From the Object selection filters dialog, check the boxes next to Point, Line,
Polyline, Arc, Circle and Curve and then pick OK.  All of the curve related entities
will now be selected.
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3. From the Status Bar select the Properties icon  to display the Properties
Manager.
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4. This dialogs reports that a total of 17 entitles are selected.  In the Objects section
drop down the menu for Layer and select Curves from the list of layers.  

5. Now from the Status Bar select the Layer Manager icon .

6. From the Layer Manager, under the Active column, check the box to make the layer
named Sections the active layer.

7. You can close the Properties and Layer managers by allowing them to auto-hide or
pick the "X" icon to close them.

8. Now we're ready to create the section curves.  First activate the . 
Sections are generated for the currently active view.

9. Go to the  tab and select the Section Curves  command.  This will
display the Create section curves dialog.
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10. If you move the slider you will see a highlight of the section display in all views.

11. Now from the dialog select the Pick point on model button.  The dialog minimizes
allowing you to select a point.  From the Front View, select the XY origin grid point
to locate the section.

12. The dialog reappears and you can pick OK to close it.

13. Now activate the .

14. Go to the  tab and select the  command again.

15. From the Create section curves dialog, select the Pick button and then select the

same grid point, 0,0,0 origin in the .

16. You will now notice that section curves were created in both the XY Plane and the YZ
 Plane.
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Congratulations!!!  You completed the exercise!!

17. Save the file as Connector_Block_Completed.vcp.
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7.7 #7: Model a Daisy Decor

In this fun exercise you will use solid (or mesh) spheres, non-uniform scaling, polar arrays,
sectioning and offsetting to produce this simplistic decorative design.  The offset curves and
rectangle are used during machining as containment and stock definition.

Model a Daisy Decor    

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Create new Layers.

2. Model & Scale the Body.

3. Model & Scale the Pedal.

4. Ghosted Display Mode.

5. Polar Array the Pedal.

6. Additional Spheres Accents.

7. Create & Trim Section Curves.

8. Create Offset Curves.

9. Create the Stock Boundary.

7.7.1 Create new Layers

Create new Layers

In this step you will use the Layer Manager to create some new layers and then set the
active layer.

1. Display the Layer Manager.  You can pick the Layer Manager icon  located on the
Status Bar.

2. From the Layer Manager select the Add Layer icon  to add a new layer.
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3. Now lets rename the new layer to Curves.  First double-left-click in the Name field
to activate it, and enter Curves as the new layer name.

4. Repeat the procedure to create a new layer, this time named Sections.

5. Now repeat the procedure again, this time named Stock.

6. Now let's change the color of a couple of the new layers.  In the Color field left-click
on the color box for the layer named Curves.  This will display the Colors dialog.

7. Accept the default color Black and then pick OK to close the dialog.
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8. If the Layer Manager keeps Auto-Hiding to the left side of the display, select the
Auto Hide pin icon at the top of the Layer Manager.  You can also see that the layer
named Curves was changed to color black.

9. Now let's change the color of another layer.  In the Color field left-click on the color
box for the layer named Stock.  Again, this will display the Colors dialog.

10. This time select the Blue color and then pick OK to close the dialog.  You can use
different color if you wish.  If you have Auto Hide pinned, the Layer Manager will
stay displayed.
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11. This time let's set the Active Layer.  In the Active column, check the box for the layer
named Default. and then unpin the Layer Manager to close it.

7.7.2 Model & Scale the Body

Model & Scale the Body

In this step you will model the center body using a solid sphere and non-uniform scaling.
 Note: You can replace the Solid commands with Mesh commands if desired.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Select the Solid Modeling  tab  from the top Ribbon Bar.
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3. Now select the Sphere  command.

4. In the Status Bar make sure the Grid Snap is On .

5. For the center point select the grid point at (0,0,0) or just enter the coordinates 0,0,0

in command input bar .

6. For the sphere radius, enter 3,0,0  or select the corresponding
grid point and press <Enter>.

7. Select the solid sphere you just created.

8. You see the Modify / Transform tab  appear on the right end of the
Ribbon Bar.  It ONLY appears when an entity is selected.  Select the Transform tab.
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9. Select the Scale  command.

10. From the Scale Selected Objects dialog, select the Non-Uniform Scaling option.

11. Set the X Length to 6, Y Length to 6 and the Z Length to 2.  

12. Pick OK and the sphere is scaled as shown below.

13. Now press <Enter> to accept the modification.

14. Let's move the scaled sphere up to the origin.  First make sure the Graphic

Manipulator is On.  The icon is located on the Status Bar .

15. Now select the sphere.

16. Select the Blue Z arrow to display the input field, enter 2.0 and press <Enter>.  The
sphere will move up in the positive Z Axis to the 0,0,0 origin as shown below.
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17. Press <Enter> again to accept the move. 

7.7.3 Model & Scale the Pedal

Model & Scale the outer Pedal

In this step you will model and scale one of the outer pedals, again using a solid sphere
and non-uniform scaling.  Note: You can replace the Solid commands with Mesh
commands if desired.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Form the Solid Modeling  tab select the Sphere  command.

3. In the Status Bar make sure the Grid Snap is On .

4. For the center point select the grid point at (0,6,0) or just enter the coordinates 0,6,0

in command input bar  and press <Enter>.
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5. For the sphere radius, enter 4.5 in the command input window 
 and press <Enter> or select the grid point located at 0,1.5,0.

Here is what you part should look like from the Front View:

6. From Iso View 1,  select the solid sphere you just created.
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7. Select the Transform  tab from the ribbon bar.

8. Select the Scale  command.

9. From the Scale Selected Objects dialog, select the Non-Uniform Scaling option.

10. Set the X Length to 2, Y Length to 9 and the Z Length to 2.  

11. Pick OK and the sphere is scaled as shown below.

12. Now press the <Enter> key to accept the modification.

13. Let's move the scaled sphere into position along the Y Axis.  First make sure the

Graphic Manipulator  is On.  The icon is located on the Status Bar.

14. From the Front View , select the Red X arrow to display the input field,
enter 3.5 and press <Enter>.  
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15. Press <Enter> again to confirm the move and the sphere will move up to the Z 0
location as shown below.

16. Now select the sphere again.

17. Select the Blue Z arrow to display the input field, enter 3.5  and
press <Enter>.  

18. Press <Enter> again to confirm the move and the sphere will move to the X 0

location.  If you activate the Right View  your part should look like the
image below.

7.7.4 Ghosted Display Mode

Change the Top View to Ghosted Display

For spheres drawn from the top view, it is best viewed using the ghosted display.

1. Activate the Top View  tab by selecting anywhere in the viewport.
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2. Select the View  menu from the View Toolbar and then select Ghosted
Display. Note: The View Toolbar will only display in the active viewport.

The display should now look like this:

7.7.5 Polar Array the Pedal

Create the Polar Array

In this step you will create a polar array of the pedal sphere we just created.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Select the solid sphere pedal you just created in the previous step.
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3. Select the Transform  tab from the ribbon bar.

4. Select the Polar Array  command.  The Polar array selected objects
dialog will display.
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5. In the Number of Objects field, enter 11.

6. The remaining options in the dialog should use the default values shown in the
dialog above.

7. Pick OK from the dialog to create and preview the polar array.
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8. Press <Enter> to accept the polar array.  Your drawing should look like the images

below.  If not, select the Undo  command and go back and repeat the
previous steps.

7.7.6 Additional Spheres

Create the 4 additional Spheres

In this step you will create the four spheres located in the outer corners of the design. 
Note: You can replace the Solid commands with Mesh commands if desired.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Form the Solid Modeling  tab select the Sphere  command.
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3. In the Status Bar make sure the Grid Snap is On .

4. For the center point select the grid point at (-8,-8,0) or just enter the coordinates -

8,-8,0 in command input bar  and press <Enter>.

5. For the sphere radius, enter 1.0 in the command input bar  and
press <Enter> or select the grid point located at -8,-8,0 shown below.

6. Press <Enter> to repeat the Solid Sphere  command.

7. Create the three additional spheres located at the coordinates shown in the
illustration below.

Your drawing should look like this:
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7.7.7 Create & Trim Section Curves

Create Section Curves

In this step we will create section curves that lie on the XY plane.  Section curves are
useful for creating offset boundaries which in turn can be used for toolpath containment.

1. Open the Layer Manager  and set the Active Layer to Sections.  Refer to the
previous steps for displaying and using the Layer Manager.

2. Section curve are created in the plane of the active layer.  We want the section

curves to be generated on the XY plane so activate the Top View  tab by
selecting anywhere in the viewport.

3. Form the Curve Modeling  tab select the Section Curve 
 command.  The Create section curves dialog will display.
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4. If you move the slider you will see dynamically where the section curves lie.  In this

case, with the Top View  active, moving the slider will display section
curves dynamically in the XY plane and in the Z Axis.

5. We want to precisely locate the section plane so select the Pick point on model
button from the dialog.

6. Then in the Front View  pick the Z 0 grid point or simply enter 0,0,0 in

the command input bar  and press <Enter>.  The section curves
will be created and displayed in all four viewports.
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7. Open the Layer Manager and set the Active Layer to Sections.  Refer to the previous

steps for displaying and using the Layer Manager .

In the following steps we will trim our section curves and merge them.

8. From the Top View , scroll to zoom in on the center where the section
curves from the body and the pedals overlap each other.

9. From the Curve Modeling  tab, select the Trim  command.

10. Pick on the curve where you want it to be trimmed away.
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11. Press the <Enter> to repeat the Trim  command and then pick another
location to trim.

12. Repeat this procedure until all of the curves are trimmed as shown below.

13. Now scroll to zoom out to see all of the curves.
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14. Press <Ctrl+A> to select all of the curves.

15. Now from the Curve Modeling  tab select the Merge Curves 
 command.  This will merge all of the curves into one curve. This makes it easier to
work with.  Only curves that are joined end to end will be merged.  Separate curves
such as those created from the section of the outer spheres will remain separate
curves.

7.7.8 Create Offset Curves

Create Offset Curves

1. In the following steps you will create Offset curves from your Section Curves . 
Creating offset curves will also aid you during machining.  For example, if you do not
want to rough the entire stock, you can use section, offset or any other curve
boundaries to limit/contain your toolpaths.
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2. Open the Layer Manager  and set the Active Layer to Curves and then make all
other layers hidden.  Refer to the previous steps for displaying and using the Layer
Manager.

3. Now, select the main section curve, then go to the Curve Modeling 

 tab and select the Offset  command.

4. From the Top View  move the cursor towards the outside of the curve so
that you see the offset direction indicator point toward the outside.  DO NOT pick a
point!

5. Now with the curve offset direction displayed enter 0.5 in the command input bar

 and press the <Enter> key.  The curve will be offset toward the
outside by 0.5 inches.
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6. Press the <Enter> key to repeat the Offset  command.  This time select the
section curves from one of the outer spheres, drag the cursor to indicate the offset
direction and press <Enter> again.  The offset value will default to the last value
entered.

7. Repeat the  command to create offset curves for the other 3 remaining
section curves.

7.7.9 Create the Stock Boundary

Create the Stock Boundary Rectangle

In this step you will create a 24" x 24" rectangle around the part.  This can be used later
during machining to help define the stock dimensions.
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1. Open the Layer Manager  and set the Active Layer to Stock.  Refer to the
previous steps for displaying and using the Layer Manager.

2. Activate the Top View  tab by selecting anywhere in the viewport.

3. Form the Curve Modeling  tab select the Rectangle 
 command.

4. For the first corner of the rectangle, you can select the grid point shown below or

enter -12,-12,0 in the command input bar  and press <Enter>.

5. For the second corner of the rectangle, you can select the grid point shown below or

enter 12,12,0 in the command input bar  and press <Enter>.

6. Save the file as Daisy_Decor_Completed.vcp.

Congratulations, you have completed this exercise!  
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7.8 #8: Using Construction Planes

In this exercise you will learn how to use Construction Planes (C-Planes) to navigate and add
features and text to your 3D models.  C-Planes are also critical in learning how to orient imported
parts for machining.  Thus learning how to orient C-Planes and how to orient parts with the use of
C-planes is critical knowledge for all VisualCAD users.

Using Construction Planes    

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Orient the C-Plane.

2. Draw on a Face.

3. Other C-Plane Options.

4. Orient the Part.

7.8.1 Orient the C-Plane

Orient the C-Plane

In this step we'll show you how to orient the Construction Plane (C-Plane).

1. First if you have completed and save the part model from Exercise #5 Connector
Block, open that part now.  It is shown below:
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Connector Block

2. Now select the Modeling Aids tab.  On the very right end of the ribbon bar you will
find the C-Plane pane.

3. From the Modeling Aids  tab select the C-Plane to 3D Face 
command.

4. The command prompt says: "Pick a flat area".  Select the right side face of the part
and you will see that the C-Plane snaps to that face.

If the Grid is not visible, select Hid / Show Grid from the View Toolbar.

It is best to have the Construction Plane Grid visible.  This allows
you to better keep track of where the C-Plane is located and

oriented.

5. You can now see that the C-Plane and the Grid is alined with the right side flat face
of the part.  You will notice that the C-Plane origin is position at the point on the flat
face you selected.
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6. You can now draw on the C-Plane (see Text on a Part Face for more information). 

From the Curve Modeling  tab select the  Circle on Point
command.

7. For the center point, toggle on the Grid Object Snap  and select the origin point
or simply enter 0,0 in the command window and press <Enter>.

8. Now select a point on the diameter of the circle.
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9. You can also move the C-Plane origin.  From the Modeling Aids  tab

select the C-Plane Origin  command.

10. The command prompt says: "Pick origin point or enter coordinates x,y and Z"  Enable

the End Point Snap  from the Status Toolbar and then select the bottom right
end point of the face.  

You will see that the C-Plane origin and the Grid is moved to this point.

11. If you need the X Axis of the C-Plane aligned horizontally across the bottom of the

part you can select the Rotate C-Plane about Axis  command.  It is also

located on the Modeling Aids  tab.



Exercises 597

© 2025 Mecsoft Corporation

12. The command prompt says: "Enter axis to rotate about and angle to rotate by (eg:
X,45)"  We want to rotate the Z Axis 90 degrees so enter Z,90 in the command

window  and press <Enter>.

13. Now what if you want the view orientation aligned with the C-Plane?

14. Just right-click anywhere in the view to display the View pop-up menu and select
the Align to C-Plane command.  This menu contains many Viewport related
commands.
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15. With the C-Plane aligned with the active Viewport pay close attention to where the
origin of the C-Plane is:

16. Now you may want to come back to the C-Plane later so let's save it.  From the

Modeling Aids  tab select the Save C-Plane  command.

17. In the C-Plane Name dialog enter a unique name for the active C-Plane and then
pick OK.

18. The active C-Plane is now saved with the part file.

19. Now let's change the C-Plane back to the default top view.  From the Modeling Aids

 tab select the View  menu and select Top View.
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20. Here is an easier way to align the C-Plane to the face AND align the XY Axis of the C-

Plane at the same time.  From the Modeling Aids  tab select the C-

Plane by 3 Points  command.

21. The first point selected will be the origin, so make sure the End Point Snap  is
toggled on.  

22. Then select the bottom left corner end point of the right side face of the part.  Note:
Do Not pick until you see the "End" indicated at the cursor location.

23. For the X Axis point select the end point at the back end of the part on the right side
face.
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24. For the Y Axis point select the end point at the top of the part on the right side face.

7.8.2 Text on a Part Face

Drawing on a Face

In the last step (see Orient the C-Plane) we discussed different ways to orient the C-
Plane.  In this step we'll show you how to draw on a selected part face.  This will come in
handy if you want to identify your 3D parts or for modifying them.

1. First if you have completed and save the part model from Exercise #5 Connector
Block, open that part now.  It is shown below:
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Connector Block

2. Now select the Modeling Aids  tab.  On the very right end of the ribbon
bar you will find the C-Plane pane.

3. From the Modeling Aids  tab select the C-Plane by 3 Points 
command.

4. The first point selected will be the origin, so make sure the End Point Snap  is
toggled on.  

5. Then select the bottom left corner end point of the right side face of the part.  Note:
Do Not pick until you see the "End" indicated at the cursor location.



VisualCAD 2025 Companion602

© 2025 Mecsoft Corporation

6. For the X Axis point select the end point at the back end of the part on the right side
face.

7. For the Y Axis point select the end point at the top of the part on the right side face.
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8. Now right-click anywhere in the view to display the Viewpoint pop-up menu and
select the Align to C-Plane command.  This menu contains the Viewport related
commands.



VisualCAD 2025 Companion604

© 2025 Mecsoft Corporation

9. If you want to simply label your part you can add dimension text that will lie on the
C-Plane.  See Drawing & Dimensioning for that exercise.

10. In this exercise we will create text curves that you can engrave with the 2-1/2

Engraving toolpath strategy, go to the Curve Modeling  tab and select

the Create Text  command.

11. This will display the Text to Create dialog.

12. For engraving text you may want to use a single stroke font.  From the Font drop-
down menu select the text font named MecSoft_Font-1.
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If you do not see the MecSoft Font, close VisualCAD and click here to Download
the single stroke font. Unzip and copy the file  MecSoft_Font_1.ttf to the C:

\Windows\Fonts folder.

13. The text preview will now look like this.

http://www.mecsoft.com/guest/Support%20Documents/MecSoft_Font-1.zip
http://www.mecsoft.com/guest/Support%20Documents/MecSoft_Font-1.zip
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14. Make the following adjustments to the dialog:

Allow Single Line Font: Checked
Text Size: 0.25

15. Now place in the Type in Text to Create window, replace the text VisualCAD with
the following text:

Part Number: 6001257

16. The dialog should look like this:

17. Now pick the Done button.  The dialog will close and command prompt says: Enter
start point of text.  

18. You will see the text as you move the cursor around the Viewport.

19. Enable the Grid Snap  and then select the grid point to position the text, or

0.5,2.5 in the command window  and press <Enter>.  The text
should appear like this:
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The text is actually individual curves that you can select as Control Geometry in your
machining operations.

20. To select the curves, first make sure that the option Use Preselection Highlight is
unchecked.  It is located on the System section of the Options dialog (Home tab >
Options > System).  This was covered in the Set System Options section of Exercise
#1.

21. Now select one of the curves in the text or window select all of the curves in the

text and then pick the Properties  icon from the Status Bar to display the
Properties dialog.

22. You will see that the text is actually 26 individual objects.

7.8.3 Other C-Plane Commands

Other C-Plane Commands

Be sure review the other C-Plane commands listed below.

1. Select the Modeling Aids  tab.

2. The C-Plane command pane is located on the right side of the ribbon bar:
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Icon Command

Immediately sets the orientation of the C-Plane to be parallel to
the plane of the currently active view.  The origin remains the
same.

Moves the origin of the C-Plane to a selected point or entered
coordinates.  The current configuration of the construction plane is
saved whenever the model is saved. 

Moves the elevation of the C-Plane along its normal
(perpendicular to the plane).  Input is a single distance and may be
positive or negative.  A positive number moves the plane towards
the positive end of the coordinate axes even if the viewing
location is along the negative axis.  All input values are treated as
an incremental distance relative to the current location of the
plane.

Rotates the C-Plane about one of the principle axes of the current
C-Plane, X, Y, or Z.  The center of rotation is the center of the plane
and not necessarily the origin. Input is 'axis,degrees'.

Three points are selected (origin, x-axis and y-axis) or entered to
re-orient the C-Plane.  The y-axis point defines the C-Plane and
the general direction of the positive y-axis. 

The C-Plane will be oriented to a selected flat plane of a geometry
object.  The pick point will become the C-Plane origin.

Two points are entered to re-orient the x-axis of the C-Plane:

Resets the C-Plane back to its default orientation relative to the
WCS and the currently active viewport.  The origin will be the WCS
origin.

This option saves the C-Plane orientation from the currently active
view.  A name must be provided for later reference when loading.

This option allows the retrieval of a saved C-Plane into the
currently active view.  A list of previously saved C-Planes is
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presented.  These saved C-Planes may also be deleted in this
option or renamed.

7.8.4 Orient the Part

Orient the Part

There may be times when you need to re-orient the part.  This can happen at times when
a part that you import into VisualCAD has it's WCS position skewed.  In order to work
with the part it has be oriented.

We have deliberately skewed the part from Exercise #5 Connector Block so that it no
longer lies parallel to any view.  Here is what it looks like:

 

1. The first step toward to orienting this part is to define the C-Plane.  For more about
this see the topics Orient the C-Plane and Text on a Part Face in this exercise.

2. First make sure the Grid is visible.  You can toggle the Grid on/off by selecting Hide /
Show Grid from the View Toolbar.

3. Now activate the view that allows you to see the planar face that you want to use to

orient the part by.  In this example it is Iso View 1 .
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4. Go to the Modeling Aids  tab and select the C-Plane by 3 Points

 command.

5. Activate the End Point Snap  from the Status Toolbar and select the end points
in the order shown below:

The C-Plane will orient to the 3 points selected.

6. Now right-click anywhere in the Viewport (do not select any geometry) and select

Align to C-Plane.  This will align Iso View 1  parallel to the C-Plane.
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The C-Plane will align to the Viewport.

7. Now we can orient the part.  Select the part and go to the Modify / Transform

 tab and select the Part Orient ...  command.

8. This will display the Orient entire part dialog.  Pick the option to Set as current view
direction.
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9. Pick OK and the part appears to disappear from the Viewport.

10. Now pick the Fit View  icon from the View Toolbar.  The part will appear with
the WCS oriented in/on the center of the face that we used to align the C-Plane 
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11. Now activate the Top View  and pick the Fit View  icon from the
View Toolbar.

12. Repeat this for the Front View  and the Right View . 
Remember that you have to activate the Viewport before the View Toolbar will
display.  Left-click anywhere within the Viewport to activate it.
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13. Activate Iso View 1  again and this time select the Iso View  icon
from the View Toolbar to orient this Viewport.

Great!  You have the part oriented orthographically (i.e., Top, Front, Right).

14. However, the part is still not oriented like the original part as shown below.  You
see that the length of the part was oriented along the Y Axis and the WCS was
positioned at the center of the front view.  Let's show you some additional
commands to fix that.

15. Activate Iso View 1  and then from the Status Toolbar, toggle the

Graphic Manipulator  On.

16. Now select the part to see the Graphic Manipulator displayed.  
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17. Pick the Z Rotation arc of the Graphic Manipulator  to display the input window,
enter 90 and then press <Enter>.

18. Now you see the part is rotated so press <Enter> to accept the rotation.
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Great where almost there!

To move the WCS to the original location which was centered on the front face of the
part we need to create a point there to move from.

19. Zoom in on the front face of the part.

20. From the Curve Modeling  tab select the command Create mid point

between two points .

21. Activate the End Point Snap  from the Status toolbar.

22. Select the two diagonal end points on the front face of the part as shown.

23. You can now toggle the Graphic Manipulator  off.

24. With the point created, window select the entire part (and point) or simply press
<Ctrl+A>.

25. From the Modify / Transform  tab select the Move by mouse 
command.

26. The command prompt says: Pick from point or enter coordinates x,y and z.  Make

sure the End Point Snap  is active from the Status Toolbar and select the point
you just created.
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27. Now the command prompt says: Pick to point or enter coordinates x,y and z.  In the

command window enter 0,0,0  and then press <Enter>.

You will see that the part moved to the WCS origin.  Now press <Enter> again to
accept the move.

28. Now the part is aligned correctly accept for the C-Plane.  Previously the C-Plane was
aligned to the XY plane of WCS.  

Here is a neat trick to fix that:

29. Activate the Top View .
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30. Now double-left-click on the Top View  tab.  This will change the display
to one Viewport set to the Top View.

31. Now right-click on the Top View  tab and select Quad Viewport.
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You see that Iso View 1  inherited the C-Plane of the Top View because
that was the active View when you selected Quad Viewport.

32. Save the file as Construction_Planes_Completed.vcp.

Congratulations on completing this exercise!
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Find More Resources

Download this PDF Guide for a list of the available VisualCAD Resources.

2025 VisualCAD Resource Guide

The 2025 VisualCAD Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Click Here!

What's New  |  Quick Start Play List

https://www.mecsoft.com/ResourceGuides/2024/VisualCADCAM/VisualCADCAM2024-Resource-Guide.pdf
https://www.mecsoft.com/ResourceGuides/2024/VisualCADCAM/VisualCADCAM2024-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2025.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QKmM1LY2ydDA_vro-WPOo4E


Index 621

© 2025 Mecsoft Corporation

Index
- 3 -
3Dconnexion®     41

- A -
About VisualCAD®     99

Accelerator <Alt> Keys     46

Align    

C-Plane with Axis     178

C-Plane with CSYS     179

All Flat Areas     242

Alt Keys     46

Ambient Lighting     33, 91, 131

Analyze    

Analyze Ribbon Bar Pane     366

Bounding Box     368

Part Center     369

Part Information     366

Surface Normals     369

Analyze Ribbon Bar    

Analyze     366

Measure     360

Angle    

Measure     364

Angular Dimensions    

Dimensions Ribbon Bar Pane     350

Annotations     357

at Point     357

Dimensions Ribbon Bar Pane     354

Dot     359

Edit Font Height     357

Leader Line     354

Appearance    

Themes     55

Application Plug-ins ...     114

Arc    

3 Pts     226

Center, Start, Angle Pts     225

Dia. Dimension     347

Fit Curves     264

Measure Diameter of     364

Rad. Dimension     348

Start, End, On     227

Arcs/Circles    

Select     158

Select Dialog Box     158

Array    

Objects     391

Objects XYZ     391

Polar     392

AutoSave     20, 77, 118

- B -
Back View     140

Set C-Plane to     176

Background Image    

Delete     189

Make Grayscale     186

Menu     180

Move     182

Place     181

Scale     184

Toggle On/Off     185

Transparency     188

Background Properties     422

Boolean Curves     255

Bottom View     140

Set C-Plane to     175

Bounding    

Analyze Box     368

Create Box Mesh     316

Rectangle Curves     245

Bounding Box Mesh     327

Box Mesh     316

Break Curves     270

- C -
Center Point Snap     409

Chain Curves     268

Chamfer Curves     260

Check for Updates ...     98

Circle    

3 Pts     222

Center, On Pt     220

Dia. Dimension     343

Rad. Dimension     345

Start, Diameter Pt     221



VisualCAD 2025 Companion622

© 2025 Mecsoft Corporation

Circle    

Tangent to 3     223

Circular Tube Mesh     324

Clipboard    

Modeling Aids Ribbon Bar Pane     154

Close Curve     260

Color    

Construction Visual Aids     29, 87, 127

C-Plane     29, 87, 127

C-Plane Gris Axis     29, 87, 127

New Layer     29, 87, 127

Options     29, 87, 127

Screen Background     29, 87, 127

Screen Gradient     29, 87, 127

Select by     163

Selection     29, 87, 127

Command Recall     20, 77, 118, 172

Commands    

Modeling Aids Ribbon Bar Pane     169

Cone Mesh     319

Continuous Command Recall     172

Coordinate input     404

Copy    

Layer     421

Layer with Objects     421

Objects     154

C-Plane    

Align with Axis     178

Align with CSYS     179

Load ...     180

Modeling Aids Ribbon Bar Pane     174

Rotate     177

Save ...     179

Set by 3 Pts     177

Set Color of     29, 87, 127

Set Elevation     176

Set Gris Axis Color of     29, 87, 127

Set Origin     176

Set to Back View     176

Set to Bottom View     175

Set to Front View     175

Set to Left View     176

Set to Object     178

Set to Planar Curve     178

Set to Right View     176

Set to Top View     175

Set to View     175

Current Position     406

Curve    

All Flat Areas     242

Arc Fit     264

Auto Fillet     263

Boolean     255

Bounding Rect.     245

Break     270

Chain     268

Chamfer     260

Change Start     255

Close     260

Create Text on     235

Display Style     24, 82, 122

Explode     272

Extend     253

Extend by Dist     262

Extract from Surface Edge     247

Fillet     249

Flat Area     241

from Text     233

Helix     239

Line Width     413

Merge     253

NURBS     232

Offset     251

Point on     198

Project onto Surface     290

Project to CPlane     266

Reduce     272

Reverse     263

Section Curves     246

Silhouette     243

Smooth     265

Spiral     238

Split     269

Split by Curve     258

Surface Boundary     244

Trim     252

Wrap     273

Curve Modeling Ribbon Bar    

Curves Pane     190

Edit Curves Pane     248

Curves    

Curve Modeling Ribbon Bar Pane     190

Select Open     160

Customize    

Add/Remove Cammands to the Quick Access
Toolbar     42



Index 623

© 2025 Mecsoft Corporation

Customize    

Display     42

Display Themes     55

Keyboard     53

Minimize the Ribbon Bar     42, 46

Show Quick Access Toolbar below Ribbon Bar    
42

Show/Hide Quick Access Toolbar     42

Show/Hide Quick Access Toolbar Commands    
42

The Customize Quick Access Toolbar Menu     42

Cut    

Object     154

Cylinder Mesh     318

- D -
Delete    

Hole on Surface     289

Layer     421

Object     154

Viewport     152

Dialog Box    

Application Plug-ins Manager     114

Array Objects     391

Color Options     29, 87, 127

Dimension Options     36, 94, 134

Display Options     24, 82, 122

File Browser     65, 105

File Open     63, 103

Grid Options     30, 88, 128

Lighting Options     33, 91, 131

Load C-Planes     180

Loaded Translator Plug-ins     115

Mecsoft Product Updates Checker     98

Mirror Objects     389

Modeling Aids     20, 77, 118

Move Objects     381

Part Information     366

Part Orient     384

Polar Array Objects     392

Properties     412

Rotate Objects     383

Save As     68, 108

Save C-Planes     179

Scale Objects     387

System     20, 77, 118

System Options     20, 77, 118

Tolerance and Units Options     37, 95, 135

Diffuse Lighting     33, 91, 131

Dimension    

Angle     350

Arc/Circle Diameter     341

Arc/Circle Radius     342

Horizontal     334

Leader Line     354

Oblique     339

Options     36, 94, 134

Pt Angle     352

Pt Arc Diameter     347

Pt Arc Radius     348

Pt Circle Dia     343

Pt Circle Rad     345

Ribbon Bar     333

Select all     160

Vertical     337

Dimensions Ribbon Bar    

Angular Dimensions Pane     350

Annotations Pane     354

Linear Dimensions Pane     334

Radial Dimensions Pane     341

Display    

Construction Visual Aids     24, 82, 122

Curve Style     24, 82, 122

Ghosted     147

Grid     148

Mesh Edges Style     24, 82, 122

Options     24, 82, 122

Rendering Options     24, 82, 122

Shaded     145

Shading Style     24, 82, 122

Togglr Shaded + Edges     145

View Change Animation     24, 82, 122

Wireframe     146

Display Ribbon Bar    

Modes Pane     143

Orient Pane     139

View Modify Pane     137

Viewport Pane     149

Visibility Pane     148

Dot Annotation     359

Duplicate    

Layer     421

Layer with Objects     421

DXF File Format    

Exporting to     69, 109



VisualCAD 2025 Companion624

© 2025 Mecsoft Corporation

Dynamic    

Pan     137

Rotate     138

Zoom     138

- E -
Edit    

Copy     154

Cut     154

Hide     173

Hide Non-Selected     173

Line Width     413

Lock     173

Mode     413

Paste     155

Properties ...     412

Redo     170

Redo Multiple     171

Show     174

Undo     170

Undo Multiple     170

Unlock     173

Edit Curves    

Curve Modeling Ribbon Bar Pane     248

Edit Meshes    

Mesh Modeling Ribbon Bar Pane     329

Edit Solids    

Solid Modeling Ribbon Bar Pane     311

Edit Surfaces    

Surface Modeling Ribbon Bar Pane     287

Elevation    

set C-Plane to     176

Ellipse    

3 Pt Diameter     228

by Focus     231

End Point Snap     408

Exercise #1: VisualCAD Preferences     423

Auto Backup     424

Auto Save     424

Online Help     423

Set Systems Options     424

Set the Display Style     423

Set the Units to Inches     424

Set to Quad Viewports     429

The Quick Access Toolbar     431

The Status Bar     433

Tolerance & Units     424

Use Preselection Highlight     424

Viewing the Command Prompts     432

Exercise #2: 2D Drawing & Dimensioning     434

Active Layer     452

Annotation     452

Arc Center, Start, Angle     445

Auto-Hiding Layer Manager     435

Center Point     445

Chamfer     437

Circle on Point     443, 445

Curve Drawing     437

Cut Object     437

Dimensioning     452

Explode Curves     437

Extend Curves     437

Fillet     437

Grid Snap     445

Hide / Show Grid     437

Horizontal Dimension     452

Layer Manager     435, 452

Leader Line     452

Line     445

Mid Point     445

Modify / Transform Tab     445

More Drawing Tools     445

Object Snaps     452

Object Snaps & Visual Aids     443

Pan     452

Polar Array     445

Polar Grid of Points     445

Polyline     437

Quick Access Toolbar     437

Save     437

Save As     437

Status Bar     445

Status Toolbar     443

Trim Curves     437

Undo     445

Using Visual Aids     443

Vertical Dimension     452

Viewports     437

Visual Aids     443, 445

Zoom Out     452

Exercise #3: Model a Spanner Plate     458

Arcs Center, Start, Angle Pts     469

Circle Center, Center, On Pt     460

Create Inner Cutouts     460

Create Point     459, 469
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Exercise #3: Model a Spanner Plate     458

Create Rectangle     469

Create Reference Points     459

Create Single Line     460

Edit Curves     464

Explode Curve     469

Extend Curve     464

Extrude Curves     479

Fillet Curve     469

Grid Snap     460

Merge Curves     477

Mirror     474

Offset Curves     464, 469

Quad Point Snap     460

Set to the Top View     459

Transform Ribbon Bar     474

Trim Curves     463, 464, 469

View Toolbar     479

Exercise #4: Model a Base Plate     481

Circle on Point     487

Circle on Pt     481

Create a New Layer     493

Curve Modeling     481

Draw the Base Plate Profile     481

Edit Properties of Geometry     495

Extrude Mesh     485, 487

Extrude the Base Plate     485

Fillet     481

Graphic Manipulator     487

Layer Manager     493, 495

Mesh Modeling tab     485

New Layer     493

Object Selection Filters     495

Properties     495

Properties Manager     495

Quick Access toolbar     481

Rectangle     481

Save     485

Select by Type     495

Status Bar     487

Status Toolbar     493, 495

Subtract Mesh     487

Undo     481

View Toolbar     487

Wireframe Display     487

Exercise #5: Model a Mold Insert     497

Arc Center, Start, Angle     498, 509

Change Geometry Layer     533

Circle on Point     523, 528

Create Section Curves     536

Display Menu     515, 520, 523

Extrude Mesh     498, 501, 505, 520, 523, 528

Extrude the Body     498

Extrude the Connection Bar     520

Extrude the Connection Wall     523

Extrude the Ejector Pin Holes     528

Extrude the Flange     501

Extrude the Upper Pocket     505, 509

Fillet Curves     509

Graphic Manipulator     501, 505, 509, 515, 520,
523, 528

Grid Snap     498

Layer Manager     533, 536

Line command     498

Merge Curves     498, 509

Mirror     515

Modify / Transform     515

Offset Curves     501, 505

Polyline     515, 523

Properties     533

Properties Manager     533

Quad Point Snap     523

Rectangle     520

Revolve Mesh     515

Revolve the Center Bosses     515

Section Curve     536

Select By Type     533

Subtract     505

Subtract Mesh     509, 528

Unite Mesh     501, 515, 520, 523

View Toolbar     505

Exercise #6: Model a Connector Block     538

Circle     553

Create Section Curves     565

Extrude Mesh     539, 541, 547, 553, 562

Fillet Curves     562

Graphic Manipulator     541, 547, 553

Grid Object Snap     553

Grid snap     539

Intersect Object Snap     553

Layer Manager     565

Line     553

Mid Point Object Snap     553

Mirror     553

Model the Front Access     541

Model the Main Body     539
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Exercise #6: Model a Connector Block     538

Model the Mounting Holes     553

Model the Top Access     547

Modify / Transform Menu     553

Modify the Top Access     562

Polyline     541

Properties Manager     565

Rectangle     539, 562

Revolve Mesh     541, 562

Rounded Rectangle     541, 562

Rounder Rectangle     547

Section Curves     565

Select by Type     565

Subtract Mesh     541, 547, 553, 562

View Menu     541

Exercise #7: Model a Daisy Decor     570

Active Layer     585

Additional Sphere Accents     583

Create & Trim Section Curves     585

Create new Layers     570

Create Offset Curves     589

Create the Stock Boundary     591

Ghosted Display Mode     579

Graphic Manipulator     573, 576

Layer Manager     570, 585, 589, 591

Merge Curves     585

Model & Scale the Body     573

Model & Scale the Pedal     576

Offset Curve     589

Polar Array     580

Polar Array the Pedal     580

Rectangle     591

Scale     573, 576

Section Curve     585

Sphere Solid     573, 576, 583

Status Bar     583

Transform     573, 576, 580

Trim Curves     585

Undo     580

View Menu     579

Exercise #8: Using Construction Planes     593

Align to C-Plane     609

Align View to C-Plane     600

Align Viewport to C-Plane     593

Circle on Point     593

Construction Planes     593

C-Plane by 3 Points     593, 600, 607, 609

C-Plane by X Axis     607

C-Plane Load     607

C-Plane Origin     593, 607

C-Plane Rotate     607

C-Plane Save     607

C-Plane to 3D Face     593

C-Plane to Face     607

C-Plane to View     593, 607

C-Plane to WCS     607

Create mid point between two points     609

Create Text     600

End Point Snap     609

Fit View     609

Graphic Manipulator     609

Hide / Show Grid     593, 609

Iso View     609

Modify / Transform Tab     609

Move by mouse     609

Orient the C-Plane     593

Orient the Part     609

Other C-Plane Commands     607

Part Orient     609

Properties     600

Rotate C-Plane about Axis     593

Save C-Plane     593

Set System Options     600

Single Line Font     600

Text on a Part Face     600

View Toolbar     609

Exit File     100

Explode    

Curves     272

Surface     312

Export ...    

IGES (igs)     69, 109

Region Files (mrg)     69, 109

Rhino (3dm)     69, 109

SAT Files (*.sat)     69, 109

Selected     111

STEP Files (STP, STEP)     69, 109

Stereo-Lithography ASCII (*.sla)     69, 109

Stereo-Lithography Binary (*.stl)     69, 109

to DXF Format     69, 109

Extend    

Curves     253

Extrude Mesh     325
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- F -
Features Overview     11

File    

Browse ...     65, 105

Exit     100

Export ...     69, 109

Export Selected     111

Home Ribbon Bar Pane     102

Import ...     65, 105

New     63, 102

Open ...     63, 103

Print ...     73, 113

Print Preview     73, 111

Print Setup ...     75

Recovery     20, 77, 118

Save     68, 108

Save As ...     68, 108

Save as Template     69, 109

Types supported     63, 65, 103, 105

Fillet    

2 Curves     249

Curves, Auto     263

Fit View     138

Fit All     138

Fit Selected     138

Flat Area Curves     241

Front View     140

Set C-Plane to     175

- G -
Geometry Ribbon Bar     101

Ghosted Display     147

Graphical Manipulator     397

Graphical Scale     376

Grid     148

# Divisions between     30, 88, 128

On Curve     198

Options     30, 88, 128

Point on     195

Poloar Point on     197

Set XY Extents     30, 88, 128

Snap     407

Spacing between     30, 88, 128

- H -
Helix Curve     239

Help    

About VisualCAD®     99

Check for Updates ...     98

Go To Website     99

Menu     96

Topics ...     98

Hidden Lines     147

Hide    

Grid     148

Non-Selected     173

Objects     173

WCS     148

Hole, Delete on Surface     289

Home Ribbon Bar    

File Pane     102

Options Pane     18, 76, 116

Plugins Pane     114

Horizontal Dimension     334

- I -
Import ...    

3D Studio Files (*.3ds)     65, 105

Adobe Illustrator Files (*.ai)     65, 105

AutoCAD (*.dxf;*.dwg)     65, 105

IGES Files (*.igs;*.iges)     65, 105

LightWave Files (*.lwo)     65, 105

MecSoft Region Files (*.mrg)     65, 105

OBJ Files (*.obj)     65, 105

Parasolid Files (*.x_t;*.x_b)     65, 105

Point Cloud Files (*.cvs;*.txt;*.asc)     65, 105

RAW Triangle Files (*.raw)     65, 105

RHINO 3DM Files (*.3dm)     65, 105

SAT Files (*.sat)     65, 105

SLC Files (*.slc)     65, 105

STEP Files (*.stp;*.step)     65, 105

Stereo-lithography files (*.sla;*.stl)     65, 105

Universal 3D Files (*.u3d)     65, 105

VisualMILL Part Files (*.vmp)     65, 105

VisualTurn Part Files (*.vct)     65, 105

VRML Files (*.wrl)     65, 105

Intersect Mesh     332

Intersection Point Snap     410
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Iso View     141

- K -
Keyboard    

<Shift> to Select Chain     167

Customize     53

Preset <Alt> Keys     46

Shortcuts     16

- L -
Layer    

Delete     421

Duplicate     421

Duplicate with Objects     421

Lock     420

Manager     418

Move Up/Down     421

New     420

Select by     164

Set Color of New     29, 87, 127

Visibility     419

Leader Line     354

Left View     140

Set C-Plane to     176

Lighting    

Options     33, 91, 131

Set Ambient, Diffuse, Specular     33, 91, 131

Set Position of     33, 91, 131

Line    

2 Points     199

at Angle     212

From Mid-Point     213

Normal     214

Normal & Tangent     217

Normal to 2     215

Polyline     208

Rectangle, 2 Points     200, 203

Rectangle, 2 Points, Length     205

Rectangle, Center     202

Rectangle, Vertical     206

Rounded Rect.     210

Select     157

Tangent     218

Tangent to 2     219

Linear Dimensions    

Dimensions Ribbon Bar Pane     334

Load    

C-Plane     180

File     63, 103

Lock     173

- M -
Mask    

Selection     165

Measure    

Analyze Ribbon Bar Pane     360

Angle     364

Arc Diameter     364

Co-ordinates     361

Distance     361

Vertex Diameter     362

Menu    

Select     157

Merge Curves     253

Mesh    

Bounding Box     327

Box     316

Circular Tube     324

Cone     319

Cylinder     318

Extract Curve from Edge     247

Extrude     325

Intersect     332

Rectangular Tube     321

Revolve     326

Sphere     317

Subtract     330

Torus     320

Unite     329

Mesh Edges Display Style     24, 82, 122

Mesh Modeling Ribbon Bar    

Edit Meshes Pane     329

Meshes Pane     316

Meshes    

Mesh Modeling Ribbon Bar Pane     316

Select     160

Mid Point Snap     409

Mirror Objects     389

Modeling Aids     20, 77, 118

Modeling Aids Ribbon Bar    

Clipboard Pane     154

Commands Pane     169



Index 629

© 2025 Mecsoft Corporation

Modeling Aids Ribbon Bar    

C-Plane Pane     174

Objects Pane     172

Selections Pane     155

Modes    

Display Ribbon Bar Pane     143

Mouse    

3Dconnexion®     41

Settings     20, 77, 118

Move     372

by Mouse dialog box     381

Layer     421

Orient by 3 Points     386

Orient Part     384

- N -
Name    

Select by     163

Near Point Snap     409

New    

File     63, 102

Layer     420

NURBS    

Create Curve     232

Nurbs Curves    

Select     159

- O -
Object    

Selection Filter dialog box     163

Snap Control     407

Objects    

Modeling Aids Ribbon Bar Pane     172

Oblique Dimension     339

Offset Curves     251

Online Help     98

Open    

File Dialog Box     63, 103

Options    

AutoSave     20, 77, 118

Color     29, 87, 127

Command Recall     20, 77, 118

Dimension     36, 94, 134

Display     24, 82, 122

File Recovery     20, 77, 118

Grid     30, 88, 128

Home Ribbon Bar Pane     18, 76, 116

Lighting     33, 91, 131

Tolerance and Units     37, 95, 135

Orient    

by 3 Points     386

Display Ribbon Bar Pane     139

Part     386

Origin Point Snap     408

Ortho Snap     408

- P -
Pan     137

Parallel View     144

Part    

Center     369

Orient ...     384

Orient by 3 Points     386

Units     406

Parting Plane     285

Paste    

Objects     155

Perspective View     144

Plugins    

Home Ribbon Bar Pane     114

Plug-ins    

Applications     114

Translator     115

Point    

Center     194

Grid     195

Mid     193

Pick     192

Polar Grid     197

Select     157

Snap near     409

Snap to End     408

Snap to Midpoint     409

Point Clouds     159

Polar Array     392

PolyCurves    

Select     159

Polyline     208

Polylines    

Select     157

Print     73, 113

Menu     71
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Print     73, 113

Preview     73, 111

Preview Ribbon Bar     403

Setup     75

Project    

Curves onto Surface     290

Curves to CPlane     266

Project to C-Plane Snap     410

Properties     413

Edit Mode     413

Line Width     413

Properties Dialog Box     412

- Q -
Quad    

Point Snap     409

- R -
Radial Dimensions    

Arc/Circle Diameter     341

Arc/Circle Radius     342

Dimensions Ribbon Bar Pane     341

Pt Arc Diameter     347

Pt Arc Radius     348

Pt Circle Dia     343

Pt Circle Rad     345

Rectangle    

2 Points     200, 203

2 Points. length     205

Center     202

Rounded     210

Scale by     379

Tube Mesh     321

Vertical     206

Redo    

Multiple     171

Once     170

Reduce Curves     272

Rename Viewport     152

Rendering Options     24, 82, 122

Reverse Curves     263

Revolve Mesh     326

Ribbon Bar     101

Analyze     360

Curve Modeling     190

Dimensions     333

Display     136

Home     101

Mesh Modeling     315

Minimize     42, 46

Modeling Aids     153

Solid Modeling     294

Surface Modeling     276

Transform     370

Right View     141

Set C-Plane to     176

Rotate    

2D Objects     373

3D Objects     375

C-Plane     177

Dynamically     138

Selected Objects dialog box     383

using Graphical Manipulator     397

- S -
Save    

as Template     69, 109

C-Plane     179

File     68, 108

File As     68, 108

Scale    

Objects dialog box     387

Objects Graphically     376

Rectangular     379

Using Graphical Manipulator     397

Screen Layout     14

Section Curves     246

Select    

All     161

All Dimensions     160

Arcs/Circles     158

Arcs/Circles...     158

by Color     163

by Layer     164

by Name     163

by Type     163

Chain using <Shift> key     167

Duplicates     162

Invert     162

Last Created     162

Lines/Polylines     157

Mask     165
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Select    

Menu     157

Meshes     160

Multi-Selection Dialog     168

None     162

Nurbs Curves     159

Open Curves     160

Point Clouds     159

Points     157

PolyCurves     159

Pre-Selection Highlights     167

Previous     162

Set Seleection Color     29, 87, 127

Shells     159

Surface from Solid     169

Selections    

Modeling Aids Ribbon Bar Pane     155

Shading    

Display     145

Style     24, 82, 122

Toggle + Edges     145

Shells    

Select     159

Shortcut Keys     16

Show    

All Objects     174

Grid     148

Surface Normals     369

WCS     148

Silhouette Curves     243

Smooth Curves     265

Snap    

Center Point     409

Controls     407

End Point     408

Grid     407

Intersection Point     410

Mid Point     409

Near Point     409

Origin Point     408

Ortho     408

Project to C-Plane     410

Quad Point     409

Vertex Point     410

Solid    

Bounding Box     309

Box     296

Circular Tube     308

Cone     300

Cylinder     299

Explode     312

Extract Curve from Edge     247

Extruded     304

Rectangular Tube     306

Revolved     305

Sphere     297

Stitch     313

Torus     302

Unify Normals of     311

Solid Modeling    

Solid Modeling Ribbon Bar Pane     295

Solid Modeling Ribbon Bar    

Edit Solids Pane     311

Solid Modeling Pane     295

Specular Lighting     33, 91, 131

Sphere Mesh     317

Spiral Curve     238

Split    

Curves     269

Viewport     151

Split by Curve     258

Status Toolbar    

Visual Aids     411

Stitch Surfaces     313

Subtract Mesh     330

Surface    

Bilinear from 4 Points     284

Boundary Curves     244

by 2 Curves     280

by 4 Curves     279

Delete Holes on     289

Explode     312

Extract Curve from Edge     247

from Curves     278

of Extrusion     281

of Revolution     282

Parting Plane     285

Project Curves onto     290

Rectangular Plane     277

Reverse Normals of     291

Show Normals     369

Stitch     313

Trim     287

Unify Normals of     311

Wrap     292

Surface Modeling Ribbon Bar    
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Surface Modeling Ribbon Bar    

Edit Surfaces Pane     287

Surfaces Pane     276

Surfaces    

Surface Modeling Ribbon Bar Pane     276

System Options     20, 77, 118

- T -
Tangent Line     218

Template, save as     69, 109

Text    

at Point     357

Curves from     233

Dot     359

Edit Font Height     357

on Curve     235

Themes, Set Display of     55

Tolerances    

Curve Hookup     37, 95, 135

Part Facing     37, 95, 135

Toolbar    

Status     404

View Commands     38

Toolbars    

Customize     42

Quick Access Toolbar     42

Tools    

Application Plug-ins ...     114

Translator Plug-ins ...     115

Top View     139, 175

Torus Mesh     320

Transform    

Along Path ...     394

Array ...     391

Graphical Manipulator     397

Graphical Scale     376

Mirror ...     389

Move     372

Move ...     381

Orient by 3 Points     386

Part Orient ...     384

Polar Array ...     392

Rectangular Scale     379

Rotate ...     383

Rotate 2D     373

Rotate 3D     375

Scale ...     387

Translator Plug-ins ...     115

Trim    

Curves     252

Surface     287

Tube    

Circular     324

Rectangular     321

- U -
Undo    

Multiple     170

Once     170

Unite Mesh     329

Units    

Display     406

Set default     37, 95, 135

Unlock     173

User Interface    

Geometry Ribbon Bar     101

Help & Info Menu     96

Status Toolbar     404

Viewport Menu     150

VisualCAD® Screen Layout     14

- V -
Vertex Point Snap     410

Vertical Dimension     337

View    

Change Animation     24, 82, 122

Display Next     38

Display Previous     38

Dynamic Pan     137

Dynamic Rotate     138

Fit     138

Ghosted Display     147

Hide/Show Grid     148

Hide/Show WCS     148

Perspective/Parallel     144

Set C-Plane to     175

Set to Back     140

Set to Bottom     140

Set to Front     140

Set to Iso     141

Set to Left     140

Set to Right     141
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View    

Set to Top     139

Shade     145

Toggle Hidden Lines     147

Toolbar Commands     38

Wireframe Display     146

View Modify    

Display Ribbon Bar Pane     137

Viewport    

Delete     152

Display Ribbon Bar Pane     149

Layouts     149

Rename     152

Split     151

Visibility    

Display Ribbon Bar Pane     148

Visual Aids     411

VisualCAD® Menu     62

- W -
WCS    

Hide/Show     148

Welcome to VisualCAD     11

Wireframe     146

Wrap    

Curves     273

Surface     292

- Z -
Zoom    

Box     139

Dynamic     138

In     139

Out     138
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